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Introduction to this tutorial

The iSeries " server development capabilities of the new integrated development
environment (IDE) provides many compelling reasons for you to upgrade from
Application Development Toolset (ADTS) or CoOperative Development
Environment (CODE).

The IDE reduces the learning curve by providing a consistent interface for
developing server applications and e-business applications. This allows you to
progress to new levels of application development. The IDE delivers on the
promise of tool integration with best-of-breed tools from IBM® and several
partners to support the end-to-end application development life cycle.

The IDE also includes a robust, easy-to-use development environment for creating,
building and maintaining iSeries RPG, COBOL, C, C++ applications, and
Web-enabled applications using the IBM WebFacing Tool.

ADTS has been the traditional method for developing and maintaining server-side
iSeries applications. But now there is a new set of highly integrated and highly
extendible tools for iSeries RPG, COBOL, C, C++, CL and DDS development. These
new tools offer you a development experience that is consistent with the
experience for developing Java' ", Web, Web Services, and XML applications. The
new tools also allow you to leverage the classic CODE tools for extremely rich
editing and DDS design support. These new generation tools offer rich support for
exploring the file system, compiling/building, editing, running, and debugging.
They offer significant productivity and usability gains, support for disconnected
and team development, and a common harness for the tight integration of IBM
and partner-supplied tools for server development.

In this tutorial you will follow the typical iSeries application development life cycle
tasks using a payroll application written in RPG or COBOL. You will work through
a series of exercises that will teach you what the new tools are and how to use
them.

By the end of this tutorial you will be able to realize significant productivity and
usability gains in your iSeries server application development and be on your way
to increasing your skills to make the transition into new programming models such
as Java, Web, Web Services, and XML.

Tutorial purpose:
Before you begin, take a minute to read the learning objectives for the
tutorial.

Length of time:
This tutorial takes approximately 2 hours to complete.

Modules:
Work on the modules in sequence. The pictures in the modules show
similar tasks. Some of the names and icons may be different from the
environment you will be working with when you complete the modules.
Following each module it is recommended that you take the checkpoint
quiz. Taking each quiz will help you to determine if you have mastered the
module content and are ready to move on to the next module. The quiz
answers are included at the end of this tutorial so you can check your
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answers. Following each module checkpoint is an opportunity for more
practice. This gives you the chance to apply what you have learned in the
exercise. Often you will complete different but similar tasks to what you
have just learned in the module. The Development Studio Client for iSeries
online help can assist you in completing the practice tasks.

Prerequisites
You should also learn about the prerequisite knowledge for the tutorial
before beginning. This section describes the type of knowledge you need to
already have to fully benefit from this tutorial.

Learning objectives

vi

In order to successfully edit, compile and debug the sample payroll application,
you will need to understand many concepts. This tutorial is designed to help you
learn about those concepts while working through maintaining a simple payroll
application written in RPG and COBOL. In this tutorial, you will learn how to take
the first step in modernizing your iSeries applications by moving to the next
generation of iSeries application development tools. You will learn about the first
application development tool which is the Remote System Explorer which has its
own tools and views. Remote System Explorer is similar to Programming
Development Manager (PDM) in that it allows you to drill down to the QSYS file
system, or use filters to list specific objects within the QSYS file system. You will
learn that the Remote Systems Explorer goes well beyond PDM however! You will
learn how to explore iSeries jobs and commands, and the IFS file system. Further,
you will learn that it can also be used to explore the file system of remote Linux,
UNIX® and Windows® systems.

This tutorial is broken into eleven modules, each with their own specific learning
objectives. Each module is composed of several exercises. These exercises must be
completed in order to successfully achieve the module’s goals.

The first module, Reviewing the 5250 payroll application, helps you learn about
the 5250 payroll application before you use the new iSeries Development tools to
maintain it. This application is written in ILE RPG and ILE COBOL.

The second module, Introducing Development Studio Client and Remote System
Explorer, introduces you to IBM WebSphere® Development Studio for iSeries
(Development Studio) and describes its relationship to IBM WebSphere
Development Studio Client for iSeries. You learn which product makes up the host
components and which product makes up the workstation components. You learn
about the iSeries application development tools included with Development Studio
Client for iSeries programmers. Finally, you learn about the Remote System
Explorer, the launching point for the iSeries application development tools.

The third module, Starting Development Studio Client helps you learn about the
workbench and workspace. You will then learn how to start Development Studio
Client.

The fourth module, Opening a perspective helps you learn about a perspective,
and specifically the Remote System Explorer perspective. You will then learn how
to open the Remote System Explorer perspective.

The fifth module, Configuring a connection to an iSeries system and connecting to
an iSeries, explains how to create a connection to an iSeries server and select
objects using the Remote System Explorer perspective. You will learn the steps to
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create a connection, how to find a library in the library list and finally how to open
a member in the Remote Systems LPEX Editor. You will also learn about several
view such as the Remote Systems view, iSeries Table view, and the Outline view.

The six module, Editing source, helps learn about some of the language features
available in the Remote Systems LPEX Editor while you edit source.

The seventh module, Verifying source, explains how to verify source in the Remote
Systems LPEX Editor. The program verifying is one of the final steps in compiling
a program or module. When errors are found by verifying, the iSeries Error List
appears. The iSeries Error List is a powerful tool that manages errors found by
verify utility in the Remote Systems LPEX Editor. You will become familiar with
the verify tool, the various capabilities of the iSeries Error List and the program
that you will create.

The eighth module, Compiling source, explains how to compile source in the
Remote Systems LPEX Editor. The program compiling step is one of the final steps
in compiling a program or module. When errors are found by the compile step, the
iSeries Error List appears. The iSeries Error List is a powerful tool that manages
errors found by the compile utility in the Remote Systems LPEX Editor. You will
become familiar with the compile tool, the various capabilities of the iSeries Error
List and the program that you will create.

The ninth module, Designing screens, helps you learn about the various aspects of
the CODE Designer while modifying a display file to add a screen.

The tenth module, Debugging a program, explains the Debug perspective and how
to start the debugger, set breakpoints, monitor variables, run and step into a
program, view the call stack in the Debug view, remove a breakpoint, add a
storage monitor, and set watch breakpoints.

The eleventh module, Exploring Remote System Explorer helps you learn more
about using the Remote System Explorer perspective to work with the iSeries
objects that you used in the previous modules. You will learn how easy it is to
define filters, perform actions and define your own actions. You will learn how
Remote System Explorer can organize and integrate your work and make that
work easier.

Be sure to read about the Prerequisite knowledge for the tutorial before beginning.
This section describes the type of knowledge you need to already have to fully
benefit from this tutorial.

Prerequisite knowledge

In order to complete this tutorial end to end, you should already have working
knowledge of the following:

* Basic Microsoft® Windows operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

It is also useful, but not necessary, for you to have basic knowledge of the
following:

* ILE RPG or ILE COBOL
* DDS

Introduction to this tutorial Vi1



When you are ready to begin, start with the first module.
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Chapter 1. Reviewing the 5250 payroll application

In this module, you are going to explore the application by invoking it from a 5250
session and working with the applications green screens and command keys.

You will learn about the 5250 application, before you start to use the new iSeries
Development tools to maintain it. This will allow you to become familiar with the
5250 screens and the behavior of the application.

Remember: Before beginning this module, you should learn about the Prerequisite
knowledge for the tutorial.

In order to review the 5250 order entry application, there are several steps you will
need to learn about and follow:

e Start the 5250 application
* Know what screens the application provides
* Know how the application works in its 5250 environment

* Know what command keys are supported and what functions they allow

In order to accomplish these learning objectives, there are several steps that are
involved, including:

e Starting the 5250 application
* Maintaining an employee record
* Maintaining a project record

* Maintaining a reason code
The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Starting the 5250 application

To start the order entry application you need a 5250 emulator on your workstation.

On the 5250 emulation screen on your desktop, displaying the sign-on screen:
1. Enter your User ID.
2. Enter your password.

3. On the command line of a 5250 screen, add the library RSELABXX to your
library list.

ADDLIBLE RSELABXX
4. Now, invoke the Payroll application:
CALL PAYROLL

The application starts and shows the first panel. This first screen asks you to
enter an X beside the application you want to maintain.

5. Choose the application that you want to maintain.

© Copyright IBM Corp. 2001, 2004 1



Maintaining an employee record

To maintain an employee record:

1. Type x beside Employee Master Maintenance.

© ® N ook Db
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Press Enter.

Type 123 for the Employee Number.

Type A for the Action Code to add employee 123.
Press Enter.

Type any information you like about the employee.
Press Enter.

Play in the employee records as much as you like.
Press F4 to return to the maintenance selection.

Maintaining a project code

To maintain a project code:
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1.

2,
3.
4.

© © N o u

Type x beside Project Master Maintenance.
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Press Enter.
Type 123 for the Project Code.
Type A for the Action Code to add project 123.

=1 Session A - [24 x 80] Bt
File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] % 2 3 @

(=]

E a
| i :Ccnnected to remote server/host toras07m using port 2 pd101 on psprintl:pd101

Press Enter.

Type any information you like about the project.
Press Enter.

Play in the project records as much as you like.
Press F4 to return to the maintenance selection.

Chapter 1. Reviewing the 5250 payroll application
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Maintaining a reason code

To maintain a reason code:

Type x beside Reason Code Master Maintenance.
Press Enter.

Type 123 for the Reason Code.

Type A for the Action Code to add reason code 123.
Press Enter.

Type any information you like about the reason code.
Press Enter.

Play in the reason codes as much as you like.

Press F3 to end the PAYROLL program.

© o Nk wDdNPRE

Recap
Congratulations! You have completed this module. You should now understand
how to:
* Start the payroll application
* Maintain an employee record
* Maintain a project code
* Maintain a reason code
* Exit the application.

You have reviewed all the panels in the payroll application. Continue to the next
module.
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Chapter 2. Introducing Development Studio Client and iSeries
Development Tools

In this module, you will be introduced to IBM WebSphere Development Studio for
iSeries (Development Studio) product and its relationship to IBM WebSphere
Development Studio Client for iSeries. You learn which product makes up the host
components and which product makes up the workstation components. You
recognize the iSeries application development tools included with Development
Studio Client for iSeries programmers. You then are introduced to Remote System
Explorer the launching point for iSeries application development tools.

In order to gain a introductory understanding of Development Studio Client and
the iSeries development tools, there are several steps you will need to learn about
and follow:

* Describe the Development Studio product
* Describe the Development Studio Client product

* Describe how Development Studio Client fits into the WebSphere Studio family
of products

* Explain the tools available to iSeries programmers for iSeries application
development

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Introducing Development Studio and Development Studio Client
* Introducing iSeries Development Tools

The exercises in this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Introducing Development Studio and Development Studio Client

With Development Studio Client, you can quickly develop and deploy traditional
and e-business applications for your iSeries system. You receive unlimited licenses
of this powerful suite of tools when you use Development Studio for your host
development. The following diagram illustrates the interaction between host and
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client tools:

WebSphere Development Studio

CiC++ COBOL RPG ADTS

WebSphere Development Studio Client

m iSeries Web Tools
Exploror Projects for iSeries
1BM Classic tools
Java Tools
WebFacing (CODE and
for [Series Tool VisualAge RPG)

Development Studio Client is designed to help you:
1. Develop and maintain iSeries applications using the Remote System Explorer

2. Develop Web GUISs for iSeries classic applications using the IBM WebFacing
Tool and other Web Tools

3. Develop client and server applications for iSeries using Java Tools

4. Work with other Integrated Site Developer Tools (XML, Web Services, SQL,
Relational Databases)

Now, You know Development Studio Client makes up the workstation tools while
Development Studio makes up the host tools. But there’s more. WebSphere Studio
is IBM’s solution for application and Web development. Both versions of our
product come with an additional base WebSphere Studio product.

* IBM WebSphere Development Studio Client for iSeries includes WebSphere
Studio Site Developer. Site Developer includes support for Web services, XML
development tools, and core support for Java and Web development tools.

* IBM WebSphere Development Studio Client Advanced Edition for iSeries
includes WebSphere Studio Application Developer. This base product provides
end-to-end support for the creation and maintenance of J2EE applications and
Web services. It also provides extensive support for Enterprise Java Beans, and
for Java Messaging services.

And if you happen to have other WebSphere products installed you can also install
either edition of the product on top of WebSphere Studio Application Developer -
Integration Edition or WebSphere Studio Enterprise Developer. The following
diagram illustrates how this product fits into the WebSphere Studio family of
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products:

WebSphere Development Studio Client for iSeries

Remote iSeries Web Tools
ws’“’w" Projects for ISeries
1BM Classic tools
] WebFacing (CODE and
i) Tool VisualAge RPG)
Advanced Edition : :
WebSphere WebSphere WebSphere Studio WebSphere
Studio Site Studio Application Application Developer Studio Enterprise
Developer Developer Integration Edition Developer

Introducing iSeries Application Development Tools

Now, you know what the two flavors are of Development Studio Client and why
you would want to use each one. Next let’s look at those next generation iSeries

server application development tools mentioned at the beginning of this tutorial.

Just what are they and what do they do.

Remote System Explorer

You can manage your development-cycle tasks in the Remote System Explorer.
This is an enhanced and more flexible workstation version of Program
Development Manager (PDM). You can create and manage development projects
on your iSeries system from your Windows-based workstation with the Remote
System Explorer and iSeries projects. With these tools, you can connect to an
iSeries remote host, view iSeries libraries, files, and members. You can also launch
the host compilers, the workstation editor, a program verifier and various
debuggers all from the Remote System Explorer. This tool also supports other
system types, such as UNIX(R), Linux, and Windows.

LPEX Editor

Your program editing tasks are simplified with the Remote Systems LPEX Editor.
This is a powerful language-sensitive editor that you can customize. Token
highlighting of source makes the various program elements stand out. It has
SEU-like specification prompts for RPG and DDS to help enter column-sensitive
fields. Local syntax checking and semantic verification for your RPG, COBOL and
DDS source makes sure it will compile cleanly on an iSeries system. If there are
verification errors, an Error List lets you locate and resolve problems quickly.
On-line programming guides, language references, and context-sensitive help make
finding the information you need just a keystroke away.

Shells and Commands in the Remote Command view

You can use the Remote Commands view to run and interact with commands and
command shells on universal systems. A universal system includes Windows,
Linux, and UNIX system types. Specifically, use the view to:

¢ Run commands in a command shell

Chapter 2. Introducing Development Studio Client and iSeries Development Tools 7



* Display and interpret the output of a program
* Enter input to a program

* Display and manage different commands and shells from the same view.
Multiple commands can be run in a single shell (one command at a time per
shell), multiple shells may be run on a single system, and multiple systems may
be running shells.

Whenever a command shell is launched or a command is run from the Remote
System Explorer, the Remote Commands view displays the output and provides a
way to work with that output.

Program Verifier

One of the most powerful and unique features of the Remote System Explorer is
the Program Verifier. Before you compile your code on an iSeries system, you can
ensure that there are no errors by invoking the Program Verifier. The verifier
checks for semantic (compile) errors on your workstation so that you can
guarantee a clean compile on the iSeries. Think of the host cycles you'll save. It is
especially handy when you are writing code but you are disconnected from an
iSeries system. You can do this because Remote System Explorer ported the parsing
and checking code from the iSeries host compilers to the workstation. The Error
List window lists the errors that are found and their severity, inserts the error
messages directly into the source and helps you to navigate between the errors.

CODE Designer

Using an editor to create and maintain DDS source for your display and printer
files can be a frustrating and difficult task. What would be great is a graphical
design tool that lets you design your screens and reports visually and then
generate the DDS source for you. Well, that’s exactly what the CODE Designer
does for you.

The CODE Designer interface was designed to help the novice DDS programmer
create screens, reports and databases quickly and easily without worrying about
the details of the DDS language, while at the same time letting the expert DDS
programmer get access to all the features and power of the language. CODE
Designer Is not fully integrated into the workbench yet, but you can launch it as a
separate tool from the workbench.

iSeries Debugger

With the integrated iSeries debugger you can debug an application that is running
on an iSeries system. It provides an interactive graphical interface that makes it
easy to debug and test your iSeries programs. It is fully integrated into the
workbench. You can also set breakpoints before running the debugger, by inserting
breakpoints directly in your source while editing. The integrated iSeries debugger
client user interface also enables you to control program execution. For example,
you can run your program, set line, watch, and service entry point breakpoints,
step through program instructions, examine variables, and examine the call stack.
You can also debug multiple applications, which may be written in different
languages, from a single debug window. Each session you debug is listed
separately in the Debug view.
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Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.

1. WebSphere Development Studio for iSeries:

a.
b.

d.
2. WebSphere Development Studio Client for iSeries Version 5 includes:

o

® a0

Includes all four host compilers and all traditional tools (ADTS)

Includes all four host compilers, all traditional tools (ADTS) and unlimited
licenses of the workstation-based tools named Development Studio Client

Includes only the workstation-based tools named Development Studio
Client

Includes only the four host compilers

WebSphere Studio Site Developer Version 5 for e-business development
Cooperative development environment (CODE)

VisualAge® RPG

Java tools

Web tools

f. WebFacing tool
g. All of the above

3. WebSphere Development Studio Client for iSeries Advanced Version 5
includes:

a.

® oo o

WebSphere Studio Application Developer Version 5 for e-business
development

Cooperative development environment (CODE)
VisualAge RPG

Java tools

Web Tools

f. WebFacing Tool
g. All of the above
4. WebSphere Studio Application Developer includes support for:

® oo o w

Creation and maintenance of J2EE applications
Creation and maintenance of Web services
Enterprise Java Beans

Java Messaging Services

All of the above

5. WebSphere Studio Site Developer includes support for:

® 2 0 T o

Web services

XML development tools
Java tools

Web tools

All of the above

6. You can manage your development-cycle tasks in:
a.

The Remote System Explorer

b. iSeries Projects
C.
d. All of the above

The IBM WebFacing tool

Chapter 2. Introducing Development Studio Client and iSeries Development Tools 9



10.

11.

12.

13.

14.

10 Remote System Explorer

With the Remote System Explorer and iSeries Projects you can view iSeries
libraries, files and members. You can also launch the host compilers, the
workstation editor, and various debuggers. (T, F)

Your program editing tasks are simplified with the:
a. The Remote System Explorer

b. iSeries Projects

c. The IBM WebFacing tool

d. The LPEX Editor

e. All of the above

The editor can access source files on your workstation or on your iSeries
system directly. When a compilation results in errors, you can jump from the
compiler messages to an editor containing the source. The editor opens with
the cursor positioned at the offending source statements so that you can
correct them. (T, F)

You can debug your program running on the iSeries system from your
workstation using:

The Remote System Explorer
iSeries Projects

The IBM WebFacing tool

The LPEX Editor

e. The Integrated iSeries Debugger
f. All of the above

The graphical design tool that lets you design your screens and reports
visually and then generates DDS source for you is:

oo o w

The Remote System Explorer
CODE Designer

The IBM WebFacing tool

The LPEX Editor

The Integrated iSeries Debugger

® 2 0 T o

Before you compile your code on an iSeries system, you can ensure that there
are no errors by invoking the:

The Remote System Explorer
CODE Designer

The IBM WebFacing tool

The LPEX Editor

The Integrated iSeries Debugger

® 2 0 T o

f. Program Verifier

You can use the Remote Commands view to:

Run commands in a command shell

Display and interpret the output of a program

Enter input to a program

Display and manage different commands and shells from the same view
All of the above

The integrated iSeries Debugger enables you to run your program, set line,
watch, and service entry point breakpoints, step through program instructions,
examine variables, and examine the call stack. (T, F)

® 20 T



15. The iSeries Projects perspective is designed more specifically to support
structured programming, offline development, and team collaboration. (T, F)

16. If the Advanced Version of the product is not installed on your workstation
then you will not see the word Advanced in the Start menu. (T, F)

Recap

Congratulations! You have completed this module. You should now understand:
* What components make up Development Studio and Development Studio Client

* What components are included in the advanced edition of Development Studio
Client

* What components are included in Application Developer

¢ What components are included in Site Developer

* What tool you use to manage your development cycle tasks
* What the benefits are of Remote System Explorer

* What tool is used to edit source members

* What tool is used to debug programs

¢ What tool is used to design screens

* What tool you used to save compile time

* The purpose of the Remote Commands view

* The capabilities of each iSeries development tool

Now that you have this introductory knowledge of Development Studio Client,
you can continue with the next module.

Chapter 2. Introducing Development Studio Client and iSeries Development Tools 11



12 Remote System Explorer



Chapter 3. Starting Development Studio Client

In this module you are introduced to workbench and the workspace. You then
learn how to start Development Studio Client..

In order to get started with Development Studio Client and the Remote System
Explorer, there are several steps you will need to learn about and follow:

* Explain workspace and workbench
* Start Development Studio Client

In order to accomplish these learning objectives, you are going to complete the
step: Starting Development Studio Client.

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Starting Development Studio Client

To start Development Studio Client:
1. Click Start on the task bar of your desktop

2. Select Programs > IBM WebSphere Studio > Development Studio Client
Advanced Edition for iSeries 5.1

@ Development Studio Client Advanced Edition for iSeries 5.1 »

&P Development Studio Client Advanced Edition For iSeries 5.

Note: If the Advanced Edition Version of the product is not installed on your
workstation then you will not see the words "Advanced Edition” in the
Start menu

3. A dialog may appear. Here you specify the name of the workspace where your
projects and other resources such as folders, subfolders and files that you are
developing in the workbench will reside.

WebSphere Studio il

WwiebSphere Studio stores wour work in a directory called a workspace. You can change the workspace each time
pou start WebSphere Studio. Specify the directomny to use for this session:
P —

|D:\D|:nmmer|t3 and SettingshchnglmeiMy DocumentshBM \wds(\HS Elakbie J Browse... |

[ Use this workspace as the default and do not show this dislog box again

4. (Optional) Change the field in this dialog and use a unique directory name, for
example, RSElabXX (where XX is a unique number).

© Copyright IBM Corp. 2001, 2004 13



5. Click OK to open the workbench.

cﬁ: Remote System Explorer - Welcome - WebSphere Develop ] - |E'I|_>_<_|
Fil= Edit Mavigate Search Project Run  Window Help
I-HE &8s -%-&%-|| || AAB||% -~
g Remot,..tems w» X x l Qutline X
ol N
X ¢ o o o |Development St...

& 4| An outline is
= = IThis page tells you what you should know before you= not available.
=N New C h Development Studio Client Advanced Edition for iSerie

T e tomnection and dlick on the related links.
CESAY Windows...
[+ £y Linuw, .. e
a ] @ Get started
[#]-Unix Unix, ., -
To know what ta do first, consult the Product Ov
#-B Local.. the information map in the online help ko decide F
] & iSeries. ., start using the product.
#-B Local
& Develop iSeries applications
‘fou can create and maintain RPG and COBOL apf
Learn more about the Remate System Explorer a _
< | LlJ
1) Remate System Details +E6d | & 2 & v x
K IR—— L |
Remote Systems | Team |
Properties * X
| E = B
Property I Value
1| | » | | Remote System Details |Tasks |iSeries Table View (iSeries Commands Log

The workbench refers to the desktop development environment. The workbench
aims to achieve seamless tool integration and controlled openness by providing a
common paradigm for the creation, management, and navigation of workbench
resources. Each workbench window contains one or more perspectives.

Checkpoint

Complete this checkpoint to determine if you are ready to move on to the next
module.

1. A workspace:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.
Refers to the desktop development environment.

d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside

2. A workbench:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.

Refers to the desktop development environment.

14 Remote System Explorer



d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside.

e. Aand C

Recap

Congratulations! You have completed this module. You should now understand:
* The concepts of the workbench and the workspace
* How to start Development Studio Client

Now that you have started Development Studio Client, you can move on to
opening a perspective. Continue to the next module.

Chapter 3. Starting Development Studio Client 15
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Chapter 4. Opening a perspective

In this module you are introduced to a perspective. You then learn how to open a
perspective.

In order to open a perspective there are several steps you will need to learn about
and follow:

* Explain perspectives
* Describe the Remote System Explorer perspective
* Open the Remote System Explorer perspective

In order to accomplish these learning objectives, you are going to complete the
following steps:

* Introducing perspectives
* Opening the Remote System Explorer perspective

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 5 minutes to complete.

Introducing a perspective

A perspective defines the initial set and layout of views in the Workbench window.
Within the window, each perspective shares the same set of editors. Each
perspective provides a set of capabilities aimed at accomplishing a specific type of
task or working with specific types of resources. For example, the Java perspective
combines views that you would commonly use while editing Java source files,
while the Debug perspective contains views that you would use while debugging
Java programs. Perspectives contain views and editors and control what appears in
certain menus and tool bars.

Opening the Remote System Explorer perspective

When you develop and maintain iSeries application you will typically work in the
Remote System Explorer perspective. This perspective is for an iSeries programmer
to display the connections that you have already configured, create a new
connection, connect to and disconnect from the connections that you have defined,
work with iSeries files, commands, jobs, and integrated file system files.

This perspective will be active when you start Development Studio Client with a
new workspace. If you had used the workspace before then, the workbench would
come up with the perspective that you last opened. You will learn more about the
Remote System Explorer perspective in the coming exercises as this is where you
launch the iSeries programmer tools and views from the workbench.

To open the Remote System Explorer perspective:

© Copyright IBM Corp. 2001, 2004 17



1.

Check for the name of the perspective.

- Welcome - WebSphere Developme

-én Remote System Explorer
File EG igate—Search  Project Run Window Help

[ERe[B]F-k- K- ]| MM
EH,&QRemwﬁyst&ms - xl xl

If you see a different perspective, not the Remote System Explorer open in the
workbench or no perspective:

Click Window > Open Perspective > Remote System Explorer from the
workbench menu.

Project Rl@ﬂ

D Hide Editors

The Remote System Explorer perspective opens.

Checkpoint

Complete this checkpoint to determine if you are ready to move on to the next
module.

1.

2.

18 Remote System Explorer

A perspective:

a. Aims to achieve seamless tool integration and controlled openness by
providing a common paradigm for the creation, management, and
navigation of workbench resources.

Defines the initial set and layout of views in the Workbench window.
Refers to the desktop development environment.

d. Specifies where your projects and other resources such as folders, subfolders
and files that you are developing in the workbench will reside.

Match the perspective with its correct definition:

a. Combines views that you would commonly use while editing Java source
files

Contains views that you would use while debugging Java programs
Contains views that you would use while developing Web applications
Contains views that you would use while maintaining iSeries applications.
Java perspective

Web perspective

Remote System Explorer perspective

oo opaoaooT

Debug perspective

In the Remote System Explorer perspective you can:
a. Display configured connections

Create a new connection

Connect and disconnect defined connections
Work with iSeries files, commands, jobs, IFS files
All of the above

® oo o



More practice

Want more practice? Try this!

Given your experience in opening the a perspective, open the Web perspective. See
a list of tools and views available to the Web developer. Next open the Java
perspective. See a list of tools and views available to the Java developer. Now since
you are supposedly in the Java perspective, open the Web perspective. Be careful
not to open another Web perspective.

Tip: Look in the workbench left-frame for the Web perspective icon. Now close
both the Java perspective and the Web perspective.

Recap

Congratulations! You have completed this module. You should know understand:
¢ The concept of a perspective
* The concept of the Remote System Explorer perspective

¢ How to open the Remote System Explorer perspective

Now that you have opened a perspective, you can move on to getting connected to
an iSeries system. Continue to the next module.

Chapter 4. Opening a perspective 19
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Chapter 5. Configuring a connection to an iSeries system and
connecting to an iSeries

In this module, you will create a connection to an iSeries server and select objects.
You will learn the steps to create a connection.

You will then learn how to find a library in your library list. Finally you open a
member in the Remote Systems LPEX Editor. You also learn about several views
such as the Remote Systems view, iSeries Table view, and the Outline view.

In order to configure and then connect, there are several steps you will need to
learn about and follow:

* Explain the Remote Systems view

* Configure a connection to an iSeries system

* Connect to an iSeries system

* Describe what you need to set up a connection

¢ Describe a profile

 Find an object in the Remote Systems view

¢ Explain subsystems

* View and access objects

* Explain the Outline view

* Explain the iSeries Table View

* Explain the difference between the iSeries Table View and the Remote Systems
view

* Show source physical file members in an iSeries Table view

* Lock and unlock the iSeries Table view

* Open a second source member

¢ View the outline of a file

In order to accomplish these learning objectives, there are several steps involved,
including:

* Configuring a connection to an iSeries system

* Connecting to an iSeries system

* Viewing and accessing objects in the Remote Systems view

* Opening a second source member

* Displaying an outline of a structured file

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.
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Configuring a connection to an iSeries system

When you first start the workbench and open a perspective, you are not connected
to any system except your local hard drive on your workstation. To connect to a
remote iSeries system, you need to define a connection. When you define a
connection, you specify the name or IP address of the remote system and you give
your connection a unique name that acts as a label in your workspace so that you
can easily connect and disconnect. When you connect to the iSeries system, the
workbench prompts you for your user ID and password on that host.

The first time you connect to an iSeries system, you need to define a profile.

All connections, filters, and filter pools belong to profiles. We will describe filters
in a later exercise. We will discuss profiles when you create your first connection.

Ok, let’s get started.

Remember you have already opened the Remote System Explorer perspective in
the previous module.

To configure a connection:

1. In the Remote Systems view, New Connection is automatically expanded to
show the various remote systems types you can connect to through the Remote
Systems view.

EZ Remote: ;}'- v X

-4 Wwindaws...
m& Linx...
[#]-Unix Unix,..

-

Remote Systems | Team

Expand iSeries to configure a connection to an iSeries system.
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The Name personal profile page opens:

Mame personal profile

Uriquely name user profile !

‘Welcome to Remote Systems. Connections can be sharable by the team or private to
you, Enter a profile name to uniquely identify you From your beam members., You will
decide for each new connection whether it is owned by the team profile or vour
profile.

Profile: | FURICH

= Back Mext > Firrish I Cancel I

On this page of the New connection wizard and since it is the first time you
connect to an iSeries system, you need to define a profile. All connections,
filters, and filter pools belong to profiles. Profiles offer a way to group
connections, share connections, or keep them private, and they help you
partition data if you have a lot of connections or filter pools.

Your first profile will be for your local workstation. This is your personal
profile. You use this profile as you want to keep your connection private. You
do not want to share resources and information with other people.

Leave the Profile information default value. Click Next.

The Remote iSeries System Connection page opens:

Remote iSeries System Connection

Define connection information !

Parent profile: | VURICH =]

Connection name: | 54002

Host name: 54003 __D j

Description:

¥ Vetify host name

<Back | Next> [[ Finih | cancel [

On this second page you specify the information for your connection. The
cursor on this page is positioned in the Host Name field.
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In the Host name field, type the name of your host system.

The Connection name is automatically filled with the host name. Leave it this
way. This name displays in your Remote Systems view and must be unique to
the profile.

Leave the Parent profile default value. You don’t need to change it. As the files
will be kept private the parent profile defaults to the default profile shown on
the previous page of the wizard. If you were sharing resources you would
select a team profile that you would have created earlier.

Leave the Verify host name check box selected.

Click Finish to define your system.

Connecting to an iSeries system

After you configure a connection to an iSeries system, you can easily connect and
expand your new connection to reveal your subsystems. Subsystems are a function
grouping of the various types of remote resources that can be explored in the
remote system. There are four subsystems:

iSeries Objects is a PDM-like group, allowing access to libraries, objects and
members

iSeries Commands allow you to predefine command sets each of which contain
one or more often used commands. When run, all commands in a command set
are sent to the remote system and executed, and the results are logged in the
Commands view

iSeries Jobs allow you to see various jobs, subset by job attributes, and to
perform a limited number of operations on those jobs.

IFS Files allow you to explore folders and files in the Integrated File System of
the remote iSeries system

&

®

1] |

- Mew Connection
[+ Windows...
F-0y Linux...
|_i_|-um= Unix...
=B Local...
B--ﬁ iSeries...
] Connection created successFully, |

B Local

ks
[+-5 Whaork with libraries. ..
[+ :%:b Waork with objects. ..
| = Work with members. ..

KT
. [#-gip User lbraries

#-@k iSeries Commands
g iSeries Jobs
- T IFSFiles

2|

Remote Systems | Team

To connect to an iSeries system:
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1. In the Remote Systems view, your new connection is expanded to reveal your

N o gk

subsystems. The iSeries Objects subsystem is the subsystem you will use most
often! It is very similar to PDM, in that it allows you to access objects in the
QSYS file system, and perform actions on those objects.

Notice the first three entries under the iSeries Objects subsystem are named
after the PDM options, because they have similar capabilities:

* Work with libraries (similar to WRKLIBPDM)
* Work with objects (similar to WRKOBJPDM)
* Work with members (similar to WRKMBRPDM)
In addition there are entries for working with library lists and user libraries:

— Library list (to simulate PDMs WRKLIBPDM LIB(*LIBL) you can start
with the pre-defined Library list filter, that when expanded lists all
libraries in your library list.)

— User libraries

You also have more entries to work with under the connection itself and you
can see from these entries that Remote System Explorer goes well beyond
PDM! It allows you to explore iSeries jobs and commands and the IFS file
system.

Now let’s work with a library in our library list.

Expand the Library list folder.

Now the connection will be activated and you will be prompted for a user ID
and password.

b Enter Password ..’5.'

System type: I iSeries

Hostname: | TORASO7M

User1D: | wdsclabol

Password: | i

I Permanently change user 1D

Enter your user ID and password.

Select the Permanently change user ID check box.
Select the Save password check box.
Click OK.

Note: Make sure that your user ID has been setup, so that your library has
been added to the library list automatically. You can use the properties
for iSeries Objects dialog to set connection information such as adding a
library to a library list and changing the current library. You can
right-click on iSeries Objects then click Properties to see this dialog. You
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will need this setup to run jobs interactively from your workstation.

&P Properties for iSeries Objects =] |
Command Execution Initial Library List |
~ Environment Variables
ary Ljsh ~Library list
- Subsystem
,, oo
Libra Library Position
RSELAB (*FIRST )
Remove
Mave Up |
Mawe Dewn |
Current library: |"‘U5RPRF j
Initisl command:
( ICHGCLRLIB RSELABEY )

E& Mew Connection =
- ol iSeries...
i) Connection created successfully

ﬁ iSeries Objects
i EI % ‘Work with libraries. ..
o= Work with objects. .

2% Work with members. ..

= ﬁ) Library list

-, Qsvs b, prod-sys
Ei?a Q552 *ib.prod-sys
El"\g QHLPSYS. *ib.prod-svs
-l QUSRSYS. Hlib prod-sys
ib.prod-cur
+- B}, RSELABXS.*lib.prod-usr
=i, QGPL.*ib.prod-usr
-, WFLABKR, ¥lib, prod-usr
# i=:€> User libraries

ﬁk iSeries Commands

=) &8 iSeries Jobs hd
4| | »

Notice that the s400a node now has a small green arrow in the icon to indicate
it is an active connection.

Also your RSELABXX library should have a small green star that indicates it is
the current library.



Note: If you do not see RSELABXX in your library list you can right-click on
the Library list and use the Add Library List Entry window to add
RSELABXX to your library list. If you also don’t see RSELABXX as the
current library you can right-click Library list and use the Change
Current Library window to change the current library to RSELABXX.

For each library, you can right-click and select from a number of actions. For
example, there is an action to create a new source file within the selected
library, to refresh the contents of the library if it is expanded, to rename the
library, copy the library or delete the library.

Viewing and accessing objects in the Remote Systems view

Now you are ready to view and access objects in your current library RSELABXX.

To view and access an object:
1. Expand library RSELABXX.

You will see all objects in this library appear in the Remote Systems view. For
each object you can right-click and select from a number of actions. The list of
actions depends on the object selected and whether you selected one or
multiple objects.

For a source file the pop-up menu has an action to create a new member within
the selected file, to refresh the contents of a file if it is expanded, to rename the

file, copy the file and delete the file. These actions remotely run the appropriate
iSeries command and you will see it logged in the Commands view.

2. Drill-down through the files in the Remote Systems view until you find
QDDSSRC source file and then expand it.

3. Drill-down through the files in the Remote Systems view until you find
QRPGLESRC source file if you want to work with RPG source or QCBLLESRC
source file if you want to work with COBOL source and expand it as well.

Ded oo | HF
. @O MSTDSP.MiedspF 4|
=) 86 MSTDSP2, *file. dspf
- PRIMST *file pf-dta
-y QCBLLESRC *file, pf-src
7 3] QCLSRC "fie pf st

i [D F'.F\YROLLG rpale
- 33 QRPGLESRCP. *file. pf -sr
-5 REFMST.*file.pf-dta
- [ RSNMST, *file.pf-dta
" MYCOMPILE . *cmd
- @il RSELABXK. ¥ib.prod-usr
@i QGPL.*ib.prod-usr
o il WRLABKK *ib.prod-usr
! L }K/ User libraries
-k iSeries Commands

2 iseries Jobs hd
1| | »
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:A'; @§3 SR
- G’F MSTDSP. *file.dspf~ «|
l Eﬁ MSTDSP2. *file. dspf

_ [a PAYROLLCZ.cble
-y PAYROLLD.cblle
&-Eh QCLSRC *file. pf-src
E RC. M

|h MSTOSP, dspf
-y PRIMST.pf
B REFMST.pf
By RSNMST.pf

Now you can see and access the members in these two source files. For each
member you can right-click and select from a number of actions. The exact list
of actions depends on whether the member is a data file or source file and
whether you select one or multiple members. For a member, the pop-up menu
actions are edit, rename, copy, move, delete, and compile.

Before you go ahead and work with these members, let’s see the members in
the iSeries Table view as well because that is more similar to the view you are
used to from PDM. You use this view to display a list of items, for example,
members or objects, in a table format similar to PDM. You can also perform
actions against these items such as editing and compiling.

4. Right-click the QDDSSRC file and then click Show in Table on the pop-up

menu.
'S w x || E]welome X
2P o Developme
; MSTDSP2 . *file.dspf
i) G'F‘ [ P il This page tel
=[] PRIMST. *file pf-dta e
2t Ely QUBLLESRC *fil pf-st and clickon t
- Ely QCLSRC *file. pF-src
& ) &
g% CMDSRC He pfsn: ® Get sta
ol EmMPMST New 3
-y mMsTDSP,  GoTo »
-y PRIMST,
IIj REFMsT. &7 Refresh
.0y RSNMST Expantd
3-3; QRPGLESRC  Collapse
- PAYROLL

By pavroLL G Rename

: 5{. QRPGLESRCI [ Copy
4« I ®pee
Remote Systems  Team ++ Move
[ Properties |E 2 8 Delete
Property I Yalue Show in Table

The iSeries Table view takes the selected object in the Remote Systems view as
input, and displays the contents in the table. For source physical files, this step
displays the members inside, their names, types, attributes, text descriptions,
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and status.

p— a— |
=EE - L4, File RSELABXX/QDDSSRC (S Members) v X
ooy EMPMST.pf : :
LBy MSTDSF'.gspf PE ¢ 2 @
@y PRIMST.pf Name | Type [ ateri... | Text | status | |
[y REFMST.pf _Ij [y EMPMST PF 3RC oK
D L4 B msTDSP DSPF  SRC oK
Remate Systems |Tearn [ prRIMST FF SRC oK
: [ REFMST PF SRC oK
[£] Properties B3¢ 5 v X | ®rsuvsT PF SRC oK
Properky | Yalue | = 1P | Ll

The top of the iSeries Table view contains a lock icon #& that controls the
correlation between the Remote Systems view and the iSeries Table view.

If the lock is disabled (the lock icon’s appearance is raised) then whenever you
click an object or library in the Remote Systems view, the associated contents of
that item automatically populate the iSeries Table view.

If the lock is enabled (the lock icon’s appearance is depressed) then when you
click on various items in the Remote Systems view, this view does not change
the input to the iSeries Table view.

To enable or disable the lock, you can click it once to change its state. You can
click on the columns heading to sort the view by column.

In the iSeries Table view toolbar make sure the lock/unlock button & is in the
unlock position.

This means now the table will automatically be updated when a different object
is selected in the Remote Systems view. This is a shortcut to open a pop-up
menu for an object in the Remote Systems view and then clicking Show in
Table.

In the Remote Systems view, select QRPGLESRC for RPG source or
QCBLLESRC for COBOL source, right-click and click Show in Table on the
pop-up menu.

The table shows the members in QRPGLESRC or the members in QCBLLESRC.

e
* % "ji. File RSELABXX/QRPGLESRC (2 Members) v x
i+ 5 QRPGLE #filepF-src — s o o
-] REFMST. *ile.pf-dea I"_h@»"" « e ®
[ RSHMST *file.pf-dta Name [ Type [ Attri... [ Text [ status ||
"B MYCOMPILE.*cmd ~||| & pavroLL RPGLE  SRC oK

L_I_ _ L4 lb FAYROLLG RPGLE SRC (o] 4
%) 86 MSTDSP2. *file. dspf (3, File RSELABX%JQCBLLESRC (3 Members) v x
a0 N
ﬂ@ = B @ 2 @
). Ey QCLSRC. *file.pf-src _hame | Type | attri... | Text [ status ||
- Ely QCMDSRC.*file.pf-src ||| ® pavroLLC CBLLE SRC  withsyntax&.. OK

Kl ’ By PAYROLLCZ  CBLLE  SRC  withverfyer... OK

Remote Systems |Team B pAYROLLD CELLE  SRC no errors OF

Now you are ready to use the Remote Systems LPEX Editor to edit the member
MSTDSP found in QDDSSRC.

From the Remote Systems view double-click member MSTDSP in the
QDDSSRC source file.

You can do this in the Remote Systems view or in the iSeries Table view.

The Remote Systems LPEX Editor opens. It is built right into the workbench,
with rich editing functions and is iSeries aware! It is a superset of SEU! The
syntax checker is ported down from SEU, the compilers embedded for
verifying errors and the reference manuals are built-in and F1 cursor sensitive.
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The Outline view will show the program hierarchy. There is explicit and rich
iSeries support for verify, compile, run and debug of RPG, COBOL, C, C++,
and CL from the Remote Systems LPEX Editor. Many of the editing features
offered in the CODE Editor for RPG, COBOL, CL, and DDS source, such as
syntax checking, automatic uppercasing, program verification, and so on, are

now available in the Remote Systems LPEX Editor.
Double-click the MSTDSP tab to maximize the Editor window.

lﬁ: Remote System Explorer - MSTDSP - WebSphere Development Studio Client Advanced 3

File Edit Source Compile MNavigate Search Project Run  Window Help

| -EHR&|| 6% & -%-

| ¢l - -

o6 mm»[A§ 5

ﬁ‘ ,&. Remote Systems - x || ]Welcome | ‘ Outlire X
’E -H\- 5§3 G D @ | o _§= Row 1 +A’Cu J;.me 1.+ zRepls:—ce
H 5---|:QPRYROLLC.th||e :" . TrorrnrEanr st t AN cutline is
B PAYROLLCZ.chlle 000001 A*55TS DD 19990303 | hot avaiable.
: 000002 AF B89/04/10 16:28:41
E &%CLZEYCR*OFJ;'LD.:hlb uuuuus A*Rﬁ'*ﬂ'#*‘k!*ﬂﬁ"t‘kﬂ‘*ﬁﬁ'*ﬂ'ﬁ
3 . &.pr=src
5 B gcunsnc *rilz of src 000004 A* THIS DISPLAY FILE
e, . ~
[:]E] QDDSSRC *file pf-sre ggggg\z i* TIME REPORTING MAZ
' ' 000007 A%
-
B TPRIMST pf N | ﬂ—l
-0y REFMST.pf
iy RSHMST pf
EEh QRPGLESRC. *file.pf-src |
-2} QRPGLESRCP *file. pf-src
File RSELABRXIQCBLLESRC (3 Members, v X
. @ [E REFMST.*file.pf-dta ) ¢ )
; RSNMST . *file. pf-dta [% 2EEH ¢ D @
-~ MYCOMPLLE *cmd Name [Type [ attri... [ Text [ status [ |
a2 RE‘E“"B“*"J'F"’”?'W L'LI () PAYROLLC CBLLE SRC  withsyntaxg.. OK
[ PAYROLLC2 CELLE  SRC  withverifyerr... OK
Remote Systems | Team [y PAYROLLD CBLLE SRC  noerrors oK
[ Properties ’E 2 E v x
Property | value | I K| B
Attribute  SRC Command INurma1 j I ]
Mame MSTDSP | |
Mumber ... 0 Messages | ;l Detafls, .. | Show Log... I
Source RSELAEXX/QDDSS...
S + | | Tasks |iseries Table ... |iSeries Comm... |Remote Syst... |iSeries Field ...

9. Double-click the MSTDSP tab again to return the window to its original size.
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Opening a second source member

Next let’s open a second member in the editor.

To open a second source member:

1. In the Remote Systems view, double-click member PAYROLL in the
QRPGLESRC source file to open an RPG source member or PAYROLLC in
QCBLLESRC to open a COBOL source member.

This member will be loaded into the editor as well.
Your Editor window will look something like:

Replace
B....... T SRR SRR TR E T TE T TS T T - P
Uuoioo F‘-‘F?l-‘\‘??ﬁ“-‘??lﬁﬂﬁﬁﬁﬁtﬁﬁﬁﬁtﬁﬁﬁﬁrﬁﬁﬁﬂﬁ-‘\‘??ﬁ“-‘??lﬁrﬁﬁﬁﬁﬂﬁﬁﬁﬁﬂﬁﬁﬁﬁtﬁ'ﬂ
ooozoo F= M NAME - Pavroll
000300 F* : PTION - Time reporting master file maintena
000400 F* externally d ribed workstation pr
000500 J OB i e i i e Ol il e i e e e el e o
00000 F= INDICATORSE USED
Q00700 F= - No record found on CHAIN operation
aoosoo F= 50 - General error condition
000200 F* 0 - Protect display on delete reguest
001000 F* EKEC - requested
001100 F* ED - urn to application selection
o01zoo0 F* KE - Return to employes selection
v
«| 3
|
or this:
swsose [ x|
Eow 1 Column 1 Eeplace
B-——+-*TA-1-B-—4--m—2mmm—4ommFom o ——g : 5 : -
000001 PROCESS ALPOST. il
00000z
000003 IDENTIFICATICN DIVISICH.
000004
000005 PROGRAN-ID. PAYROLL.
000006 AUTHOR. Programmer Name.
000007 INSTLLLATICN. IEM Toronto Lab.
ooooos DATE-WRITTEN. Octoker 12, 1999,
ooooog DATE-COMPILED.
oooo1o
000011 e e e e e e e e e e e e e e e e e e e e e e e e e e e
000012 * PROGRAM DESCRIPTICIN

Notice the two tabs in the editor pane.

2. Click on each tab to switch from one edit session to another edit session. Notice

the outline view which you will see in the next exercise.

Displaying an outline of a structured file

Next let’s look at the Outline view. This view displays an outline of a structured
file that is currently open in the editor area, and lists structural elements. The
contents of the Outline view and toolbar are editor-specific.

To see an Outline view of your source:
1. Click Refresh on the Outline view toolbar for RPG source.
When you open COBOL source the outline view will open.
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The Outline view contains your source program in a tree view without the lines
containing logic.

QE Outling

B.

|»

=3 @ MSTDSP : WORKSTN (Externally Described )
=-ET sELECT
0 EMPAPL : Character (1)
-3 PRIAPL : Character (1)
- RSNAPL ; Character (1)
-1 EMESS : Character (S0}
T EMPSEL
Zr EMPMNT
Er PRISEL
ZT PRIMNWT
1 RSMSEL
Er RSHMAT
& @ EMPMST : DISK (Externally Described )
28 @ PRIMST : DISK (Externally Described )
[+l <) RSNMST ; DISK {Externally Described )
-3 Indicators
- m-f— Fields i
=] @ Main Procedure
.k Subeoutine

éﬁ Outline

B [DENTIFICATION DI ;
[=) ENVIRONMENT DIVISION,
[=- COMFIGURATICHN SECTION,
SOURCE-COMPUTER.
. OBJECT-COMPUTER,
L INPUT-OUTPUT SECTION,
= DATA DIVISION,
[=)-FILE SECTION,
: FOr MSTDSP-FILE.
01 MSTDSP-REC.
COPY DD5-ALL-FORMATS
FOr EMPMST-FILE.
01 EMPMST-REC,
COPY DDS-ALL-FORMATS
FD PRIMST-FILE.
01 PRIMST-REC.
COPY DD5-ALL-FORMATS
~FDr RSNMST-FILE,
01 RENMST-REC,
i COPY DDS-ALL-FORMATS
[#1- WORKING-STORAGE SECTION,
[ PROCEDURE DIVISION.

Now you want to see more details of your source member.

Expand Files then MSTDSP workstation file and then the SELECT record
format for RPG source.

Expand ENVIRONMENT DIVISION then CONFIGURATION SECTION, then
DATA DIVISION and then the FILE SECTION for COBOL source.

Double-click on any of the entries in the Outline view.
This will position the source editor accordingly.

Now if you want to switch to a different member loaded in the source editor
just click on its tab and the Source Editor window with the corresponding



member comes into focus.

Zro> WG | 32 ouine  x

+ ] Welcome @r MSTDSFD \@ | A= Outline €9 x

Row & Column & Replace =-L& Global Definition |
....... B-i...+ozocben3e ke adn || 20y Fles
000100 1?'1\'?-‘1\'?\'31\'?-‘wﬁﬁ1\'tﬁﬁtwtrﬁtwtﬁﬁﬁwﬁﬁﬁﬁr#ﬁ'ﬂ i i E@ MSTDSP
aoozo0 F* PROGRLM NAME - Payroll EESELE
aoos o0 F* DESCRIPTICHN - Time reporting me i -:I:“
000400 F* externally descr: '-I:||
000500 AR AT AR TR T AR TR TR AT AR TR ARNTRTT A" T ; -ﬁl
000600 F* INDICATORS USED I =)
000700 F* 50 - No record found on CHAIN ¢ - BHETEMP
000800 F* 60 - General error condition I
0003S00 F* 90 - Protect display on delete L0 EHET PR
001000 F* EKC - End of job requested - EErerI_
001100 F* KD - Return to application sels o = ET RSN
oo1zo0 F* EKE - Return to employee seleciill - mErRrsn
4| | N )< EMPMST

<3 PRIMST
Pl e AR mesmae

Fow 3 Column 1 Eeplace

[P TN [P [P = U - U S S —— 4 q

B--—+-h-1-B-—4--—--2 4-—--3 + 4 IDENTIFICE 4]
000003 IDENTIFICATION DIVISION. i’ =) ENVIRONME
000004 - CONFIG
000005 FROGRAN-ID. PAYROLL. LT sol
00000s AUTHOR. Frogrammer N oL OB:
000007 INSTALLATION. IBM Toronto | L INPUT-
0oooos DATE-WRITTEN. October 12, ! =1 DATA DIVIS

000009 DATE-COMPILED.  SFnEsE
000010 £ |
4 | L’J e
S ol
Y-
| A ;I_I

5. Click the PAYROLL tab or PAYROLLC tab to give focus to the edit session.

Now you want to switch back to the DDS source member.
6. Click the MSTDSP tab.

7. Click the PAYROLL tab or PAYROLLC to get the PAYROLL or PAYROLLC
Editor window in focus for the next module.

Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the

next module.

1. When you first start the workbench and open a perspective, you are not
connected to any system except your local workstation. To connect to a remote
iSeries system, you need to:

a. Start Remote System Explorer communication server
b. Start a 5250 session
C. Define a connection. Specify the name or IP address of a remote system
d. Define a profile
2. The first time you connect to an iSeries system, you need to define a:
a. Profile
b. Filter
c. Filter pool
d. Connection
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e. All of the above
3. Profiles:
Help partition data when you have a lot of connections or filter pools
Include all connections, filters, and filter pools

Group connections

a0 oy

Share connections
e. Keep connections private
f. All of the above
4. There are several types of profiles:
a. Team
b. Personal
c. Both
5. A team profile is used to share resources and information with other people. (T,
F)
6. Subsystems include:
iSeries Objects
iSeries Jobs
IFS Files
iSeries Commands
All of the above
7. iSeries objects include:
a. Work with libraries
b. Work with objects
c. Work with members
d. Library list
e. All of the above
8. The iSeries Table view is used to:

® 2 0 T o

a. Display a list of items, for example, members or objects in a table format
similar to PDM

b. Perform actions against a list of items, such as editing and compiling
c. Both

9. The lock icon controls the correlation between the Remote Systems view and
the iSeries Table view. (T, F)

10. A disabled lock means when you click on an object or library in the Remote
Systems view

a. The associated contents of that item automatically populate the iSeries
Table view

b. Only the Remote Systems view is updated
C. Only the iSeries Table view is updated
d. None of the above

11. An enabled lock means when you click on an various items in the Remote
Systems view

a. The associated contents of that item automatically populate the iSeries
Table view

b. The iSeries Table view input does not change
C. Only the Remote Systems view is updated
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d. Only the iSeries Table view is updated
e. None of the above

12. You can maximize the Editor window by double clicking on its window
heading. You can get back to its original size, by double-clicking on the
heading again (T, F).

13. The outline view:
a. Displays an outline of a structured file currently open in the editor.
b. Lists structural elements.
c. Contents and toolbar are editor specific
d. All of the above

More practice

Want more practice? Try this!

Given that you have access to your own iSeries systems, configure a new
connection and connect to this iSeries system. Now rename the connection, move
the connection up or change the attributes of the connection. Then use the iSeries
objects subsystem to list the libraries in your library list.

Use the iSeries Tables view to see the objects in your library. Subset objects in the
iSeries Table view. Open the Remote Systems LPEX Editor from the iSeries Table
view.

Use the Development Studio Client for iSeries online help to assist you in these
tasks.

Recap

Congratulations! You have completed this module. You should now understand:

¢ The concepts of profiles, subsystems, iSeries objects

* The concept of the iSeries Tables view

* How to define connection information for an iSeries server

* How to select the iSeries Objects subsystem and view the libraries in the library
list

* How to expand the current library and look at the iSeries Table view of
QDDSSRC

* How to lock and unlock the iSeries Table view

* How to open several source members in the Remote System LPEX Editor

¢ How to maximize the Editor window

* How to open an Outline view and switch from the Outline view to a member
ready for edit

Now that you have opened a member for edit, you can move on to simplifying
your editing tasks with the Remote Systems LPEX Editor. Remember you are
editing right from the Remote Systems view! And keep in mind you can use SEU
like format line rules, SEU specification prompting and SEU style commands in the
Remote Systems LPEX Editor.

Continue with the next module.
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Chapter 6. Editing Source

In this module, you will edit ILE RPG source member PAYROLL or ILE COBOL
source member PAYROLLC and learn about some of the Remote Systems LPEX
Editor’s language features.

In order to edit source, there are several steps you will need to learn about and
follow:

* Describe the features of the Remote Systems LPEX Editor
* Edit columns in RPG source

* Invoke SEU commands in the prefix area

* Undo and redo edit changes

* Invoke RPG programming language specific help

* Prompt for language specific information

* Indent RPG source

* Find and replace

* Filter source

* Find a string in multiple files with the search utility
¢ Compare two files with the compare utility

* Identify lines with syntax errors

* Correct syntax errors

In order to accomplish these learning objectives there are several steps involved,
including:

¢ Introducing the Editor

* Editing columns in RPG source

* Entering SEU commands

* Requesting Undo and Redo operations

* Invoking Language-Sensitive help

* Displaying COBOL line types

* Prompting RPG Language Specifications

* Indenting RPG source

 Finding and replacing text

* Filtering lines by string

* Searching multiple files

* Comparing file differences from the Remote Systems view
* Optional. Comparing file changes from the CODE editor

* Checking syntax

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin. You might want to maximize the Editor
window during this module.

Length of time:
This module will take approximately 20 minutes to complete.
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Introducing the editor

Your program editing tasks are simplified with the Remote Systems LPEX Editor.
The editor can access source files on your workstation or your iSeries system
directly. When a compilation results in errors, you can jump from the compiler
messages to an editor containing the source. The editor opens with the cursor
positioned at the offending source statements so that you can correct them.

Here is a list of the some of the basic editor features that you would expect in a
workstation editor:

* Cut, copy, and paste

* Block marking of lines, characters, or rectangles with copy, move, and delete
operations

* Powerful find and replace function
* Unlimited undo and redo

In addition there are a few more functions that you may not have seen in a
workstation editor:

* Token highlighting where different language constructs are highlighted using
different colors and fonts to help identify them in a program

* SEU-like format-line rulers to show the purpose of each column for
column-sensitive languages like RPG and DDS. These rulers can automatically
update themselves to reflect the current specification.

» SEU-like specification prompting for RPG and DDS

* Sequence numbers, which allow SEU-style commands in the prefix area

* Intelligent tabbing between columns for column-sensitive languages

* Automatic uppercasing for languages that expect uppercase

* Settings for column-sensitive languages simplify text insertions and deletions

* On-line language reference

LPEX provides special support for insertion and deletion in column-sensitive
languages. When column sensitive editing is selected, each column is considered as
a separate entry space. For example, in an RPG source member, if you are inserting
or deleting characters into a string that is in the Factor 2 entry, the Result field
entry does not move. The default editor preference is that column sensitive editing
is off. You can switch this support on by going to the workbench preferences
window. The LPEX Editor has predefined settings, but also has an associated
preference page containing settings that you can define. The name of the category
is LPEX Editor and it appears in the tree view of the Preferences window.

Now let’s try some of these features.

Editing columns in RPG source

To edit columns:
1. Click Window > Preferences from the workbench menu.
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10.

The Preferences window opens.

&b preferences o = ]

[+ Plug-In Development | | LPEX Editor Parsers
[+ Profiling and Logging
#-RAD [~ Show date area

- Readme Example @orumn sensitive editing
[=- Remote Systems
; - Communications
Files Signature |
[=1-{Series
- Cache Resequence start at {1-9999): | 100
) Ezzx:j Ez:::‘:; Resequence increment by (1-9999); | 100
- Job Subsystems [~ Resequence lines at save
+]- LPEX Editor P 2
D_ ;hE] e isd bt Frreon ®-|ighl'mht current line
[+ Program Verifiers Background -:dor
- Templates N —
Logging
- Passwords
[+ Server
- Spell Check
- Symptom Database
[+ Team
[+ UML Visualization —
Yalidation
[+ WAS Debug
[+ Web and XML Files -

1 | | » Restore Defaults | Apply I

I~ Add signature to changed lines

Irnpott... | Expart... | 0K | Cancel I

In the left pane of the Preferences window, expand Remote Systems.
Expand iSeries under Remote Systems.

Click LPEX Editor Parsers under iSeries.

The right pane allows you to set preferences for this feature.

In the right pane of the Preferences window, select the Column sensitive
editing check box.

When selected, each column is considered as a separate entry space.

In the right pane of the Preferences window, select the Highlight current line
check box.

This option highlights the line that the cursor is currently on. The option
applies to all source files opened in the editor area.

In the right pane of the Preferences window, click Background color.
The Color palette opens.

Select light yellow from the Color palette.

Click OK.

The Preferences window shows.

Other interesting preference settings are located under LPEX Editor Parsers.
When you expand this entry you see preference settings for the individual
language environments.

Click OK again on the Preferences window.
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Now let’s see what this does.

wekone | 71
(e 22)

..... en+LElen+AIDlevice+. Eeywords+++++++-
oozzoo F* used are - MITDSP - maintenance display file _:J
ooz300 F* - EMPMST - enployee master file 4
o0z 400 F* - PRIJMST - project master file
ooz 500 F* - RZINMST - reason code master file
002600 ) e oo e ol e il o e e e o ol e ol e e o o o o ol
o0z700 Fl‘IS'IiDSP CF E WORESTN
oozsoo0 FEMPMST UF AL E K DISK
oo0zs00 FFRIMST UF &4 E K DISE
003000 FRENMST UF & E E DISE
003100 D=
003200 D* Compile time array containing error descriptions
003300 I ERR 5 50 DIM(10) CTDATI
003400 D EMES3 35 50
003500 E®
DD3EUU C-x?:w:rx-xxwwx-xxw:x-xxr-.vxr.vx-xxrxxwxrxxwxrxxwﬁrx:wﬁr::wﬁ:v
«| | L|J
I

Return to the Editor window.

11. Move the cursor to line 27, column 10.

12. Make sure the editor is in Insert mode. If the status area shows Replace press
the Insert key.

13. Press the spacebar 3 times.

Notice that only the filename is shifted but none of the other columns to the
right are effected.

Owekone | Zmsose R x|
Row 27 Columrn 13 Inserc
..... FFilenaﬂe++1PEASFRlen+LKlen+AIDevice+.Keyuords+++++++—
o0zzoo F* used are - M3TDSF - mwaintenance display file _:J
ooz300 F* - EMPMST - enployes master file i
002400 F* - PRIJMST - project master file
0oz s00 F* - RINMST -~ reason code master file

00z 600 F AT S e LT Y LT LR L LY
002700 w CF E VORESTH

oozgo00 F UF L E E DISE

oo0zs00 FFRIMST UF &4 E E DISE

003000 FRENMST UF & E E DISE

003100 D=

003200 D* Compile time array containing error descriptions
003300 I ERR ] 50 DIM(10) CTDATI
003400 I EME3S a5 50

003500 E®

003600

R AR A AR EE AT R AR R AR R A A i A A i i A i i
v
4

|

14. Press the Backspace 3 times.

Once again the filename is shifted but no other columns are effected.
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Entering SEU commands

You can configure the LPEX Editor to adopt the keyboard and command
personalities of many popular editors. Most editor profiles differ only in the keys
and commands used to perform various editor tasks. Some base editor profiles,
listed below, also add prefix information and command area at the start of each
line:

* ispf

* seu

* xedit

The editor recognizes prefix commands used by these editor profiles. Depending
on which profile you are using, you can enter SEU, XEDIT, or ISPF commands
when the prefix area is active.

If you are an SEU expert you will appreciate the ability to use SEU commands.

To enter SEU commands:

1. Move the cursor into the gray sequence number area to the left of the edit area
for PAYROLL or PAYROLLC.

Owekcome x| Zmsose [ x|
Fow 31 Column 1 Inserc 1 change.

B....... S T ST SR TR SR SN T DR T
oozzoo F* used are - MITDSP - maintenance display file :l
ooz300 F* - EMPHNST - employee master Lfile s

. F* - PRINST - project master file
F* - RSNM3T - reason code master file
) el ol el ol e il i el Ol i o ol e o o o ol
FHSTDSP CF E WORKESTN
FEMPMST UF L E E DISE
FFRJMST UF & E E DISE
FRENMST UF L E E DISE
D‘%‘
D* Compile time array containing error descriptions
I ERR S 50 DIM(10) CTDATI
003400 D EMESS 3 a0
003500 E*
UDaEuU C-xxw:rx-xxw:rx-xxw:x-xxr:vxr:vxwxrwxwxrxxwxrx:wxrx:wﬁrx:wﬁ:'
«| | L|J
I

2. On any sequence number type dd.

3. Go down a few lines and type dd again and press Enter.
Notice that the lines have been deleted.

4. Now type 15 in the sequence number area.

o

Make sure the cursor is within the sequence number area.
6. Press Enter.

Five new lines are inserted.

Requesting undo and redo operations

The editor records each set of changes you make to a file in the Editor window.
The number of changes made since the last file save is displayed on the status line.
If you want to undo a set of changes made to a file you use the Undo operation.
You can also cancel the effects of an Undo operation by using the Redo operation.

Chapter 6. Editing Source 41



Now you are going to undo some of the changes you just made to the file. Then
you will cancel the changes by using the Redo operation. Finally you will reload
the source so that it is back to its original form.

To undo and redo edit changes:

1. Select Edit > Undo from the workbench menu.
Notice that the 5 new lines disappear.

2. Press Ctrl+Z to undo the first change.
Notice that the deleted lines reappear.

3. Select Edit > Redo from the workbench menu.
Notice that the lines are deleted again.

At this point you will reload the source from the iSeries to make sure that it is
back in its original form.

4. Select File > Close option on the workbench menu.
A Save Resource dialog opens asking if you want to save the latest changes.

-ﬁa Save Resource ll

@ 'PAYROLL' has been modified. Save changes?

Yes Mo Cancel

5. Click No.

6. Go back to the workbench to the Remote System Explorer perspective and open
the PAYROLL member in the QRPGLESRC file or the PAYROLLC member in
the QCBLLESRC file.

Invoking language-sensitive help

Inside the editor, there is cursor-sensitive language-reference help available. This
help is invaluable if you cannot remember the order of fields in an RPG
specification or the possible values for a variable field. This help is available from
the LPEX Editor window.

To receive language sensitive help, press F1 in an Edit window. If the cursor is on
an operation code, you receive help for that operation code; otherwise, you receive
help for the current specification.

To access language sensitive help:

1. Position the cursor over the word MOVE in line 112 of the ILE RPG source or
231 in the ILE COBOL source.

2. Press F1.

Language-sensitive help for the MOVE operation code appears in a Help
window.
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Text marked in blue in the Help window contains the link to detailed
information about the topic in blue.

B LEAVE (Leave
B LEAVESR (Lear
B LOOKUP (Look
B MHHZO (Move
Bl MHLZO (Move
Bl MLHZO (Move
B mLLzo (Move
Bl MONITOR (B
B MOVE (Move)
(2 MovEA (Move
B MOVEL (Mave
B MULT (Multiply

B mMyR (Move Re

Bl WEXT (Next)

Bl 0CCUR (Setjc
B ON-ERROR (O
B OPEM (OpenF
B orxx (O

B OTHER (Other
B ouT (Write a [
Er parM (Identif-
B pLIsT (Identlﬁ -

l|'~9|ﬁ|ﬂﬂ

code, or built-in functions such as %
DATE, %TIME, %TIMESTAMP | %CHAR,
%UCS2, or %GRAPH)

Syntax

Result
Code | Factor1 Factor 2 Field |Indicators

MOVE |Data Source field [ Target
P} Attributes field

The MOWE operation transfers characters from factor 2 to
the result field. Moving starts with the rightmost character
of factor 2.

When moving Date, Time or Timestamp data, factor 1
must be blank unless either the source or the target is a
character or numeric field.

Otherwise, factor 1 contains the date or time format
compatible with the character or nurmeric ﬂeld that is the
source or target of the operg#th, For inform

formats that can be used ske Date Data Type,
Tune and Timastaran Nata
4

4b Help - WebSphere Development Studio Client Advanced Edition for - |D|ﬁ
Szarch: | |m Search scope: All kopics
Contents 6’(9 iSeries programming information & o 1:% I &
B IN(Retrieve a»—':-l =l
) ITER (terate) MOVE (Move) [
B KFLD (Define F
E) KLIST (Define Free-Form |(not allowed - use the EVALR operation
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4P Help - WebSphere Development Studio Client Advanced Edition foriSeries

Szarch: | |m Search scope: All kopics
Contents @ || iSeries programminginformat = o ¥ | &
-
& Cp
=Bnzrecrsaer=! Dayelopment Studio:
£ MERGE Statemel
- mrrrem | ILE COBOL Reference
[% B MOVE Stater
B MOVE Stater
B MOVE Stater
B Elementary | MOVE Statement
B Group Move
B WHEN-COMI The MOWE statement transfers data between
® L3 MULTIPLY Stater areas of storage.
(3 opeN Statement The MOWE statement has two formats:
L2 PERFORM Stater -
£ ReAD Statement .
B RELEASE Staton o Format 2 - MOVE CORRESPONDING
@ L) RETURMN Statem: Related Information:
L) REWRITE Stater
B ROLLBACK State o MOWE Staternent Rules
% 00 SEARCH Statem e Elementary Moves
Q o Group Moves
SET Statement o WHEN-COMPILED Special Register
(3 soRT statement
3 sTART Statemer_|
L5 SToP Statement [ Top of Page | Previous Page | Next Page |
5 U8 STRING Stateme Table of Contents ]
QZI SUBTRACT State Copyright 1B Corporation 1992, 2003, All Rights
5 UnSTRING State || Meserved.
L2 wRITE Statemer
® L3 1ntrinsic Functions ¥
4« | »
| v & | W

3. Click the link Date Data Type for the RPG help or Format 1-MOVE for
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db Help - webSphere Development Studio Client Advanced Editi

4. Click the Show in Table of Contents icon on the Help window toolbar.

=10/ x]

Search: | |m Search scope: Al bopics —_
Contents @ || iSeries programming information & 2 ( E%J I &
) <l Date Data Type = Al

quage Reference

Conkents

RPG IV Concepts

Definitions

h Defining Data and Pro

b3 Using &rrays and Tabl

= Types and Data

(5 1rternal and Exter

(3 character Data T:

L2 numeric Data Typ

B8 Date Data Type
B separators
B Initiglization

# 3 Time Data Type b

18] Timestamp Data T

1] Object Data Type

1=} Basing Poinker Dal

B procedure Painter

(8 patabase Mull val
[ Error Handling for

1 2 Editing Numeric Fields _

Date fields have a predetermined size and format. They
can be defined on the definition specification. Leading and
trailing zeros are required for all date data.

Date constants or variables used in comparisons or
assignments do not have to be in the same format or use
the same separators. Also, dates used for I/O operations
such as input fields, output fields or key fields are also
converted (if required) to the necessary format for the
aperation.

The default internal format for date variables is *1S0, This
default internal format can be overridden globally by the
contral specification keyword DATFMT and individually by
the definition specification keyword DATFMT.

The hierarchy used when determining the internal date
format and separator for a date field is

1. From the DATFMT keyword specified on the
definition specification

2. From the DATFMT keyword specified on the
control specification

3. %S0

There are three kinds of date data formats, depending on
the range of years that can be represented. This leads to

4 »
B - thae naccihility of a data avadlowe ar nndadflaswe canditinn hal
= I L 4 »
2 | & W L]
4P Help - WebSphere Development Studio Client Advanced Edition =]
Szarch: | |m Search scope: All topics
Contents @3 || iSeries programming informa 2 o ( E%‘j I &
Sﬁ ;\n:\rghst £ n:I At
=] arene| - ==
oy | Development Studio:
amoesas | |LE COBOL Reference
[l MOVE State
B Elementary
B Group Move MOVE Statement - Format 1
B WHEN-COM
+ m MULTIPLY Stabe HOVE Statement — Format 1
® L2 opEN Statemen ]
 H2 PERFORM State v
# U3 READ Statemen 2 r=MOVE——+— s el frar—ttp——TO————
_ —fitmrai-t—r
[ RELEASE Staten—
® L2 RETURN Statem
w 2 REWRITE Stater
B ROLLBACK State
& 03 sEaRCH Statem [Top of Page | Previous Page | Next Page
@ [ g7 seatement |l | 12ble of Contents | |
J | 5 . T
“opyright IEM Corporation 1932, 2003, All Rights -
g8 | v #Z @ |4 | l%;lJ

This will synchronize the topics in the Contents pane on the left to the help
topic you are viewing in the main help pane.

Minimize the Help window.

Play around in the Help window to see what else is available.

Select Help > Help Contents on the workbench menu to see a list of all help
that is available in the product.
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4P Help - WebSphere Development Studio Client Advanced Editi

Here you will find the table of contents and you can select a topic of interest.

Search: | |m Search scope: All kopics
Contents (<o)
Q iSerj

L iSeries programming information
mmmm
@ Support information

Q Tool developer information

©: J2EE SDK 1.3.1 APIs

@ Remote System Explorer User Guic
@ 125E SDK 1.3.1 APIs

@ websphere Application Server Net
Q Application developer information
@ Rational ClearCase

< I 2|

g | v, # @

Using Eclipse help system

Browse topics in the Contents frame () on th
Click on topics to display them. Use the Back :
Forward buttons to navigate within history of vi
topics.

Searching

To quickly locate topics on particular subject in
entire docurnentation set, enter a query in the S

field. Click (%) icon to display Search view. Yo
narrow scope of the search by selecting only s
that you are interested in.

Synchronizing

After you run a search and find a topic you were
for, click the Synchronize button (E] to matct
navigation tree up with the current topic. You m

find it useful to synchronize after following in-tog

4 | »

In the left pane of the Help window, click iSeries programming information.

Expand High level languages.

Expand ILE RPG or ILE COBOL.

Expand Programming Guide.

Expand Contents.




13. Click About This Guide.

db Help - webSphere Development Studio Client Advanced Editi

Search: | |m Search scope: Al bopics
Contents @ || iSeries programming informa <= o 1 | &
-

@ iSeries application developer i
!| iSeries programming informatii
:EI)Q High-level languages
B POF versions of the books
= 2 CiC++
® L3 cosol 400
= [3 1Le coBoL
B Java
= 2 rrGj400

G ueres

e Language Reference

Programming Guide
Contents

8 sbout This Guide
# L2 1LE RPG Introduction
= @ Creating and Running
o) 18] Debugaing and Excep
 E2 vworking with Files anc
@ A Appendixes
= L2 pata Definition documentation
& 3 control languaage information
Q Remote System Explorer Devel
Qs Support information

< . |

WebSphere
Development Studio:
ILE RPG Programmer's
Guide

About This Guide

This guide provides information that shows
how to use the ILE RPG compiler (ILE RPG)
in the Integrated Language Environment. ILE
RPG is an implementation of the RPG IV
language on the iSeries senver with the
Operating System/400 (0S/400) operating
systern. Use this guide to create and run ILE
applications from RPG IV source.

This guide shows how to:

Enter RPG IV source statements
Create modules

Bind maodules

Run an ILE program

Call other objects

Debug an ILE program

Handle exceptions

4P Help - WebSphere Development Studio Client Advanced Edition

Szarch: | |m Search scope: All topics
Contents @ || iSeries programming informatii & féz l

K

Q iSeries application developer in—
‘J iSeries programming informatic
@E High-level languages
B PDF versions of the books

= 2 CiC++

® L3 cosovy400
(B8 1e cosoL

= @ Language Reference
Programming Guide —

3 what's New
B8 sbout This Guide
18] Compiling, Running, &
= E2 1L coBOL Programmi
® L2 1LE CoBOL Input-Cuty
= 8 Appendixes

- -
4« | »

@ Conkents R‘

g = #

Development Studio:
ILE COBOL

Programmer's Guide

About This Guide

This guide describes how to write, compile,
bind, run, debug, and maintain Integrated
Language Emdronment (ILE) COBOL compiler
programs on the Operating System/400
(0S/400). It provides programrning information
on how to call other ILE COBOL and non-ILE
COBOL programs, share data with other
programs, use pointers, and handle exceptions.
It also describes how to perform input/output
operations on externally attached devices,

datahase files disnlaw files _and IGF files

;I

Having the latest version of the manuals at your fingertips will make it easier
to find programming information. There is also the option to search the help
by specifying a search string. By default, the complete help will be searched.

To limit the search to specific documents:

1. Click Search scope.
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The Select Search Scope dialog opens.

2. Click the Search only the following topics radio button.

3.

48 Remote System Explorer

Click New.
nt i [=]p|
Search: | | m@arch scogaﬂl topics
Contents o) [ =Y
1
-

@ iseries program

@ Support informe
Q Tool developer i
@ J2EE SDK 1.3.1 A
@ Remote System
@ 125ESDK 1.3.1 2
@ websphere App
Q Application dew
@ Rational ClearC:

@ iseries applicati 7} Select Search Scope - M

@ remote System &arch all topics
o

arch only the Following topics:

M| Eelite Remay

—— U are interesteq

the left. Click
Forward
nics.

in the entire
ch field. Click

ow scope of

(1]

O l Cancel |

2|

After you run a search and find a topic you were looking for,
click the Synchronize button () 1o match the navigation
tree up with the current topic. You might also find it useful tc
synchronize after following in-topic links.

More information x
4| | B




The New Search List dialog opens:

2 New Search List - Microsoft =l P

{ ii‘ieries programming )
Topics aren:

iSeties application developer information
ties pragramming information

Remoke System Explorer Developer Guide

™ Support information

™ Tool developer information

[” J2EESDK 1.3.1 APIs

™ Remoate System Explorer User Guide

[ J25E5DK 1.3.1 APIs

™ websphere application Server Network
Deployment

r Application developer information

I Rational ClearCase

ok |) cancel

In the List name field, type iSeries programming for example.
Select the iSeries programming information check box.

Click OK.

Click OK in the Select Search Scope dialog.

Now, if you wanted to do another search, you would only search in the iSeries
programming information topics.

N o g s

8. Minimize the Help window.

Prompting RPG language specifications

Instead of entering or changing code directly in the Editor window, you can use
prompts. When you request a prompt for a specification line, a window appears
where you can enter or change that line using entry fields.

To access prompts:

1. Return to the workbench. In the Editor window move your cursor to the
D-spec on line 33.

2. Click Source from the workbench menu.
3. Click Prompt (or press F4).

The Editor window will reduce in size and allow you to see the iSeries Source
Prompter at the bottom of the workbench. The iSeries Source Prompter shows
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To display context sensitive help for any field in the iSeries Source Prompter:

1.
2.

the specification line broken down into its individual fields.

elcome | ZmsTDSP | FPRROLL X B2 Qutline 6 x
Row 33 Column 10 Replace E-f@ Global Definitions
..... DNa:rE+++++++++++ETDSFrDm+++TD/L1 i EEI:‘l Files
00zz00 F* used are - MSTDSP - maintal| B-C3 Indicators
002300 F - EMPNST - enplc_g| @ ®-f= Fields
002400 F* ~ PRINST - proje || = (g MainProcedure
002500 F* - RSNNST - reasc ®-C& subroutines
002600 ) e el ol i el i e ol ol ol e o
002700 FMSTDSP CF  E
002800 FEMPMST UF & E K
002500 FPRIMST UF & E K
003000 FRSNNST UF & E K
003100 D*
003z00 D* Compile time array contait
003300 D ERR S -
i| | o
@ iSeries Source Pram BP P % x
Line bype: |D: Definition |
-
Externally Data structure Definition Interna™ |
MName described bype type  From TojLength daka byp—

| ERR | = | = Is A | so | -
« « « « « DName+++++++++++ETDsFrom+++To/ L+++IDc . Keywords+++++++++++++ »

«| | »

Remiote System Details |Tasl-<s |iSeties Table View iSeries Commands Log |iSer1&s Source Prompter |

On the iSeries Source Prompter toolbar you can use the three push buttons to:
Disable source prompt view, Disable syntax checking, and Change to insert

mode.

Tab to the Keywords field.
Press F1 to see help for this field.

The Help window with help for the D spec keywords opens. If it doesn’t
appear automatically, you might have to bring it to the foreground by clicking

on its icon on the Windows task bar.

You will see words in the help that appear in a different color than the regular
text. These are help links, and they show that there is additional help available

on that word or phrase.
Click on any link to see specific help for that item.
Minimize the Help window.

To get to the iSeries Source Prompter from the maximized Editor window
without bringing the size of the Editor window down, position the iSeries

Source Prompter on the left task bar as a Fast view.

To create a fast view:

1.
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2. Click Fast view on the pop-up menu.

Restare

Line by

»

Externally Data structure Definition Interna™ |
described type type  From TofLength data byp—

| = | = Is =l | so | -
« « « « « DHame+++++++++++ETDsFrom+++To/ L+++IDc. Eeywords+++++++++++++ »
«| | 3

Remate System Details | Tasks iSeries Table Yiew |iSeries Commands Log | iSeties Source Prompter |

You will see the iSeries Source Prompter icon on the task bar on the left hand
side of the workbench

3. Double-click the PAYROLL tab to maximize the Editor window.
4. Select a line in the Editor window and press F4 to prompt for a line.

The iSeries Source Prompter will be placed on top of the Editor window.

1< ,@ P _ x #MSTDSF [ FPaTROLL x|
% ﬁb %l) 'J"EI Coluwmm 3 Replace
B - pWarte +++++++++++ETDSFEOW+++To/ L
=7)| Line type: F* used are - HSTDSF - wainta|
F* - EMPMST - emplc_g
Exterrd F* - PRJMST - proje
Narme ey F= - RSNMST - reasc
Ftﬁ.‘.—*.‘.—tﬁ.‘;*.‘;tﬂ'.‘;*.‘;*ﬁ'#*.‘;*ﬁ'#*.‘;*ﬁ'#ﬁ
I ERR I i FHSTDSP CF E
DName +++++++++++E FEMPHST vr oA E R
“““ e FPRINST UF & E i
FRSNMST UF L E K
D?}
D* Cowmpile time array contair
D ERR S v
[ »
immands Log
-
_|_|‘ Ll \m Details | Tasks | iSeries Table View |iSeries Commands Log]

5. Click the iSeries Source Prompter icon on the task bar to minimize the iSeries
Source Prompter.

6. Double-click the PAYROLL tab to return the Editor window to its original size.

Indenting RPG source

When editing ILE RPG source, it can be difficult to determine the beginning and
ending of constructs. The indent option allows you to view your source with
constructs in an indented mode. By default, the indent option will split the screen
horizontally and show the indented view in the bottom pane.
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To indent source:
1. Click Source > Show Indentation from the workbench menu.
The iSeries Indent view opens at the bottom of the workbench.

1 Welcome |/MSTDSP ] /PA‘(ROLL xl :E Qutline S§3 x
Row 33 Column 3 Replace B-% Global Definitions
... .DName+++++++++++ETDSFromt++To/L4| By Fies

00zzoo F* wused are - M3ITDSP - ma:i_nt_:l

002300 F - EMPMST - emplc_{ F-B— Fields
002400 e - PRIMST - proje | =0 Main Frocedure
aozso0 F* - RENM3T - reasc f% Subroutines
a0z 600 Froa s st a A S s A A ARSI RFAS RN AAEEERS

ooz7oo0 FUSTDSP CF E

o0zso00 FEMPHNST UF & E K

oozoao FPRJMST UF L E K

03000 FRSHMST UF 4L E K

003100 D*

003z00 D* Compile time array contair

oozzoo | o ERm ] -
4| | »

x
Browse
4 + 5 + 6 +
D ERR s 50 DIM{10) CTDATA PERRCD(:_I
D EMESS 3 50 —
E‘a‘
ct#*txtﬁHﬂ‘#%‘ﬁ?ﬂ‘H%‘H?ﬂ‘#%‘H?EH%H*H?EH%H?EH%H?EH?H?EH%HHEH*H =
4| | 3
Remote System Details ]Tasks |i5eries Table View |iSeries Commands Log [iSeﬂes Indent I
You can display the iSeries Indent view as a full view.
2. Double-click the iSeries Indent view title bar.
= x
|% 1 change. Browse
e 3 - 4 - 5 - £—-
= =
C* Determine update mode and perform record add or upc
cw
| ¢ | IF not *inkc
[
C | | Zelect
C | | WHEN ACODE = 'A' and *I
[ | | | HOVE ‘a AC
c | | | WRITE RBCRSN
CH
[od | | WHEN ACODE = 'A' and not
C | | | HOVE 'a A
[ | | | TUPDLTE RCRSM
C'K
[ | | When ACODE = 'D'
C | | | MNOVE ‘D! A
C | | | TUPDATE RCRSH <
4] | » |

3. Scroll down to line 150.

In this area you see some nested conditions with indented lines. As you will
notice this helps to recognize the beginning and ending of these conditions.

You can move this view as a Fast view to the left task bar as well.
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Note: The Indented view is Browse mode only and cannot be edited.

4. Click the X in the top right corner of the view to close the iSeries Indent view.
5. This returns you to the Editor window with the PAYROLL program.

Finding and replacing text

The LPEX Editor also has a powerful find and replace text feature. You use the

Find and Replace window to search for an item. You can search for a word, a
partial word, or a sequence of such. You can also enter a pattern you want to

match, provided that the pattern follows the rules of regular expression. You can
replace the found search item. If the entered text or pattern is found, the cursor
moves to either the next or previous occurrence of the search item, according to

your chosen search direction, and replaces the found text according to your

selections.

To find and replace text:
1. Press Ctrl+Home to go to the top of the PAYROLL file or the PAYROLLC file.

Tip: When you press Ctrl+Home to get to the top or Ctrl+End to get to the
bottom, a quick mark is set at your cursor position. This allows you to get

back to that line by pressing Alt+Q. Ctrl+Q will set a quick mark.

2. Double-click the PAYROLL tab or PAYROLLC tab to maximize the Editor

window.

3. Click Edit > Find/Replace from the workbench menu or press Ctrl+F.

The Find/Replace window opens at the bottom of the Editor window.

Awsose [ X |

Row 57 Column 36 Replace

..... CLONO1Factorl+++++++0pcode (E) -I-Extendtd—fastor2+++++++
005700 c EVAL PRIAPL = *BLANK 2]
Qaosso0 C EVAL RSMAPL = *BLANK
aossoon c=
a0e000 C* TWrite the SELECT format to display. If end of —
008100 c*
006200 c*
006300 Cc nom not *INeD
a06400 C ]: EEFMT SELECT
006500 C *INEC IFEQ ‘1!
006600 [ LEAVESE
008700 o ELSE
00s300 [ EXSR EDITSL
a0s6500 C END
aovooo c*
007100 C* IF the general error indicator ¥INEO is on [(equ
007200 C* program continues to loop
007300 c*
aov400 C ENDdo -
4| | ’|
) e | reveus |
Renlac@ Replace Replace all
I~ Casesensitive | Regular expression W ‘Wrap [ Select found text |~ Restrict search to select
I Restrict search ko columns Start column ll_ End column W |

At the bottom of this window, you will notice that you have some options to
select from, for example, search only in certain columns, etc. You want to find
the first occurrence of PRJAPL and replace it by the word PROJAPL.

4. In the Find field, type PRJAPL.
5. Press the tab key to move to the Replace field and type PROJAPL.

Chapter 6. Editing Source

53



The Editor moves the active line to line 57 in the RPG source or 194 in the
COBOL source, which contains the first PRJAPL in the file.

Click Replace to replace PRJAPL with PROJAPL.
Click Next to go to the next location of PRJAPL in the file.
Click Replace all to replace all occurrences of PRJAPL with PROJAPL.

Double-click member PAYROLL tab or PAYROLLC tab in the Editor window
to return the PAYROLL or PAYROLLC Editor window to its original size.

10. Close the PAYROLL or PAYROLLC window.
A window will appear asking you to save the latest changes.
11. Click No.

12. From the Remote Systems view, double-click PAYROLL to reload the RPG
original source or PAYROLLC to reload the COBOL original source.

© o N o

Filtering lines by string

The editor allows you to filter or subset your source so that you see only lines
containing a given string. Filtering lines makes it quick and easy to find lines
without having to scroll through your source.

| o11o00 c RSNTAG BEGSR
0oooz9 * oare: P - maintenance diaplay file
000o30 * PHST - employee master file

To filter source by string:

1. Double-click the BEGSR in PAYROLL or MSTDSP in PAYROLLC in the Edit
window to select it.

2. Select Edit > Selected > Filter Selection from the workbench menu.

Owekome | Zmsose (DL X |
Row 347 Column 1 Replace
I. «+ « CLONO1Factor 1+++++++0Opcode (E) +Factori +++++++Result+d
005200 C MAIN EEGSE
011000 C RENTAG EEGSR
018300 C ENPTAG EEGER
0z 6400 C FRJITAG begsr
034700 C EDITSL EEGER
040400 C LCDESE EEGSE
043100 C ADDCDE EEGSER
044400 c CHGCDE EEGER
046100 BEGSR DELCDE:
047600 BEGER INWCDE};
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Awstose AL X |
Row Z9 Columm 14 Replace
————+—*A—1—B—I+————2————+————3————+————4————+————5————+—
I
H ooo0z9 * are: MSTDSP - mwaintenance display file
000037 SELECT M3TDSP-FILE
B 000038 LAS3IGH TO WORKSTATICN-MSTDIFP-3
000068 FD MSTDSP-FILE.
000069 01 M3TDSP-REC.
(u]u]uluirin] COPY DDS<ALL-FORMATS OF M3TDSP.
ooo132 o1 HSTDS&rIND—USkGE.
000154 OPEN I-0O MSTD3FP-FILE
000160 INITIALIZE MSTD3P-REC.
000167 CLOSE MSTDSFP-FILE
000179 WRITE MSTDSP-REC FORMAT IS 'SELECT!'
000183 READ MSTDSP-FILE FORMAT IS 'SELECT!'
ooozzo INITIALIZE MSTDSP-REC
ono0z94 WRITE M3STDSP-REC FORMAT IS 'EMPSEL'
oo0z98 REALD MSTDSP-FILE FORMAT IS 'EMPSEL'
000343 WRITE MSTDSP-REC FORMAT IS 'EMPMNT'
000347 READ MSTDSP-FILE FORMAT IS 'EMPMNT'
000394 WRITE M3TDSP-REC FORMAT IS 'PRJSEL'
000398 READ MSTDSP-FILE FORMAT IS 'PRJSEL' —
000443 WRITE MSTDSP-REC FORMAT IS5 'PRJIMNT'
000447 READ MSTDSP-FILE FORMAT IS 'PRJMNT'
000494 WRITE MSTDZIP-REC FORMAT IS 'RSNSEL' hd
«| y|

3. Move the cursor down a few lines to line 347.

4. Click the plus sign beside line 347 to expand this section.

welome | ZMSTDSP x |

Row 347 Column 1 Replace

I....CLGNG1Factor1+++++++0pcode(E]+Fact0r2+++++++Result+1
:

005200 C MAII BEGER

011000 C ITALG EEGER

015300 C EMPTAG EEGER

0z 6400 C FRJITAG begsr

0z4700 ] c EDITSL BEGSR

034300 cF

034900 C* Housekeeping, clear display fields and reset i

035000 c*

035100 C MCVE *BLANES EMESS

035200 C EVAL *INE0D = *OFF

035300 c*

035400 C* The following IF AND OR combination checks the

035500 C* selection fields to ensure that only one appli

035600 C* szelected.

035700 cF

035800 C IFEQ "X

035900 C ANDEQ '

036000 C OREQ >'d

036100 C R3T ANDEQ e

036200 cF THE BUG IS5 HERE ‘:J

|
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_#MSTDSP / Paxi X |
Row 347 Colunn 1 Replace
P S S— P— : 4 F— :

0oo180 INITIALIZE MSTDSP-REC. N
000167 CLOSE  MSTDSP-FILE
000179 WRITE MSTDSP-REC FORMAT IS 'SELECT'
000183 READ MSTDSP-FILE FORMAT IS '3IELECT'
ooozzo INITIALIZE MSTDSP-REC
000294 VRITE BSTDSP-REC FORNMAT IS 'EMPSEL'
000298 READ MSTDSP-FILE FORNAT IS 'EMPSEL’
0003 43 WRITE MSTDSP-REC FORMAT IS 'EMPMNT'
IJDDS‘!'? READ HMSTDSP-FILE FORMAT IS 'EMPHNT'
000348 INDICATORS ARE IND-TAELE
000349 ¢ END-READ. —
000350
000351 INITIALIZE RCEMP.
ooo3sz MNOVE CORR EMFMWNT-I TO RCEMNP.
000353 MOVE WS-EMPMO TO EMFMNO OF RCEMP.
000354 HOVE US-ACREC TO ACREC OF RCEMNP.
000355
000356 IF IND-OFF (IND-MAINT) AND IND-OFF {IND-EQJ)
000357 AND IND-OFF [IND-EMPS
000358 EVALUATE W3-ACODE
000359 WHEN 1
000350 MOVE 'L' TO ACREC OF RCENP
000361 IF WS-ACREC = 'D' -

4| | »

Now you want to show the entire source again.
5. Click Edit > Show all from the workbench menu or press Ctrl+W.

Your cursor is still positioned on the same line that you moved the cursor to,
even though all lines are now showing.
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Filtering lines by type

To help you navigate quickly through your ILE RPG or ILE COBOL source the
Editor allows you to filter lines based on the line type. Imagine you want to see
where all the subroutines are defined in your RPG source or where all the
divisions are defined in your COBOL source.

File Edt Sowce Comple Mavigate Search Project Run  Window Help

IF-0R2 48| 8]

(s |AAA][ @~ -

|as | @me|A

- k- -

[ x || Jweome [ 7msrose B x| x
% E Row 52 Column 1 Replace @
— e +++ - CLOND1FACTOL L+++++++Opeode (E) +Factorz+++{ -]
= &’ ooszooll  pew y BEGSR |
- 010200 — - endsr :
= 011000 Conktext BEGSR i
017600 Prompt ENDsr &
= 018300 Syntax Check Line BEGSR
o 025700 Select Format Line.. ENDSE
026400 begsr
& 033500 Cut endsr |
=] 034700 Copy BEGSR
L_b_ 039800 Paste ENDSR
] 040400 ) BEGSE
X 042700 Select fine ENDSR
[E Select character LI
Select rectangle
:: li Selected 3
o —— Deselect JJ
._: P iseties Indent By Date *
Row 1 Show all Code Browse
A1 Comments B t
- — S Control
- .
(| [Remcte Syt Dt o gt |t nert
# M5TDSP m X |
Row 150 Column 1 Replace
=———+—*A—1—B 2 3 t r 5 :
000145 01 WS-ACODE PIC A. N
000146 01 WS-ACREC PIC X.
000147 01 WS-EMESS FIC X(50).
000148 Syntax Check Line
000149 —
DOD150 PROCEL |
000151 GOy
00015z oooo-p  Paste
e Select line
ggg 1:: < Select character iti
000156 Selectrectangle |,
000157 Selected PhLE.
000158 Desele
000159 By Date
000160 Comments
000161 .
gggi:g * Displ Outiing of job r
000164 PERFORM 0100-pRO¢ LMbedded SQUICICS -EXIT
000165 UNTIL IND-OM{Ir_ Cfrs
000166
DUIUIET" CLOZE H3TDSP-FILE _ILI
1 »
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To filter lines by type:

1. Right-click in the Editor window with the PAYROLL program or PAYROLLC
program.

2. Click Filter view > Subroutines on the pop-up menu for PAYROLL or click
Filter view > Divisions on the pop-up menu for PAYROLLC.

For PAYROLL all subroutines specifications are displayed allowing you to
move quickly and easily to the area in your file where the desired subroutine
is.

For PAYROLLC all divisions are displayed allowing you to move quickly and
easily to the area in your file where the desired division is.

\Wekome | /' msTDSP W X ‘

Row 176 Column 39 Replace
..... CLONO1Factor 1+++++++0Opcade (E) +Fal::|:n:2+++++1

00sz00 C MAIN BEGSR
010200 C endsr
011000 C RINTAG BEGSR
017600 C ENDsr
013300 C EMPTAG BEEGSR
025700 C ENDSR
02 6400 C PRITAG begsc
033500 C endsr
034700 C EDITSL BEGSE
039800 C ENDSR
040400 C LCDESR BEGSER
042700 C ENDSR
043100 C ADDCDE BEGSR
044000 C ENDSE
044400 C CHGCDE EEGSR
045400 C ENDSR
046100 BEGSR DELCDE:
047200 ENDSR;
047600 BEGSR INVCDE:
047900 ENDSR:

prve R x|
Eow 150 Column 1 Replace

H———+—*P.—l—B——-i—————Z————+————3————+————‘l————+————5————+—

000003 IDENTIFICATICN DIVISION.
0o0o0s PROGRAN-ID. PAYROLL.
000018 ENVIRCNMENT DIVISICH.
000064 DATA DIVISICN.
IJDDISD PROCEDURE DIVISICH.

3. Move your cursor to the line with the subroutine declaration CHGCDE (line
444) in PAYROLL or the procedure division (line 150) in PAYROLLC.

4. Expand the declaration to show all lines in this subroutine or division.
Now you could work with the source inside this subroutine or division.
5. Right-click in the Editor window and click Show All on the pop-up menu.

Searching multiple files

If you would like to search through the members in a source physical file or
through the files in a local directory, you can use the Search tool. The Multi-File
Search utility allows you to search for a particular string of text in many members
on the host. This function can also be used on local files.

To search multiple files:
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1. Click Search > iSeries from the workbench menu.

4P Remote System Explorer - PAYROLL - WebSphere Development Studio Client Advanced

File Edit Source Compile Mavigate | Search Project Runm  ‘Window Help

S -EHEA[| T[4~ Iseach. chn M| e -0 -
g Mﬂﬁeml i | Welcome
’% X @l Row 176

J— m

+Opcode (E) +Facforz+4

The Search window opens.
2. In the Search string field, type ENHRS.

B iseries Search I =Y File Search | 22 Help Search I [L¥ Java Search I 2 Plug-in Search |

Search string:iENHRS ) j I Case sensitive
Connection: |s400a ~| Naw...l

LIJ Browse... |

ﬂj Browse... |
;u Browse. .. |

¥ source members I” Data members

~ Columns
& all columns

" Between |'. andla:

" Between(G) I 1 and end of line

Customize... | (search )| concel |

[——

The Connection field should contain your iSeries server name, otherwise enter
it there.

3. Under Target in the Library field, type RSELABXX.

4. Under Target in the File field, type QDDSSRC to search all members in this
source physical file.

5. Under Target in the Member field, select *ALL.
6. Click Search.

The Multi-File Search window lists all the lines in all the files that reference
ENHRS.

¥ Remote Search ("ENHRS" - 3 Ocel
=@ RSELABXX{QDDSSRC(EMPIMST) (1 match)

S ENHRS R (line 18)
=B RSELABXXIQDDSSRC(MSTDSP) (1 match)
Pl A ENHRS R B 11 37REFFLD{RCEMF/ENHRS *LIBLJEMPMST) (ine 99)

=0y RSELABXXJQDDSS chl
ENHRS 31 TEXT(EMPLOYEE NORMAL WEEK HOURS') (ing 223>

7. Double-click the last line in the list.
A ENHRS 3 1 TEXT('EMPLOYEE NORMAL WEEK HOURS')
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The member REFMST is automatically loaded into the editor and the cursor is
placed on the correct line.

&P Remote System Explorer - REFMST - WebSphere Developnent St -10] x|
File Edit Source Comple Mavigate Search Project Run  ‘Window Help
|I-E8a[[0]3% - & -%- | 2]l - -
@6 | mmp» | A E
| x| Zmstose | Zeavroll | FREFMST X ¢ x
’E =6\= Row 27 Column 1 Replace
& I P Name++++++RLen++TDpB...... Functi F\n—
A 000025 1 EUSRI 8 TEX1 | outline
= o000z 6 A COLE Is not
- || oooozz7 iy ENHRS gl TEX] |pval
|| oooozs i I coLi_|
|| oooozs A EPHRC 5 1 TEX]
o 000030 A COLE
000031 A EPHRY 71 TEX]
=§?¢ ooonsz2 A COLE
- 000033 A EPHRP 7T 1 TEX]
f— -
= « | ;l_l
X "" Remote Search ("ENHRS" - _eﬁ\:= ® ~ x
I B || 21y RSELABXX/QDDSSRCREFMST) (1 match) a
2 .
] |i5eries Field Ta, .. | Remote Search

8. Close REFMST.

Comparing file differences from the Remote Systems view

If your product undergoes many changes, you will find the Compare utility useful.
It allows you to compare different versions of a program and find the differences.
There are two ways to do a compare: use the Compare utility in the workbench or
use the Compare utility in the CODE tool. The compare in the CODE tool is more
intuitive but requires you to start the CODE Editor outside of the workbench.

Using the compare utility in the workbench you can view the differences between
two files by comparing them. You can compare different files, and you can
compare versions in the Workbench with versions in the repository or with the
local edit history. In some cases you can compare three files (when a common
ancestor exists).

After a comparison is carried out, the Compare Editor opens in the editor area. In
the compare Editor, you can browse through all the differences and copy
highlighted differences between the compared resources. You can save changes to
resources that are made in the comparison editor.

Using the compare utility in CODE you can also view the differences between two
files by comparing them. You enter a name of a file to compare against the file in
the CODE Editor view. You can type the name of a file, or you can select one from
the list of files already open in the editor. If you type the name of the file that is
not already open in the editor, it is loaded into the editor. If no file is specified, the
current file is compared against a new, untitled file. The current file appears on the
left side of the Compare view, and the specified file on the right. You use the
Compare menu to view the next and previous mismatch and to select options such
as ignore case, font, protect view and show mismatches only.
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Note: Make sure all lines show in the source before starting the Compare tool. You

can do this by right-clicking in the Editor window and clicking Show All on
the pop-up menu.

To compare files in the workbench:

1.

2.

10.

Click Window > Preferences from the workbench menu.
The Preferences window opens.
In the left pane of the Preferences window, expand LPEX Editor.

&b preferences . ~18] x|

[+ Java ;I Compare

- Logging

[~ Ignore case

- Appearance gnore leading blanks
- Black

( i
gnore traling blanks

:... Controls grore 3l blanks
Find Text I” Ignore comments
| E-Parsers
- Print
- Save
- Tabs
-User Actions
-User Cormmands
- User Key Actions
- User Mouse Actions
- User Prafile
| @ Di\WorkSpace_wDSCy
| E:-D:\WorkSpace_WDSCv_
[+ Plug-In Development
[+ Profiling and Logging
#-RAD
i Readme Example
[#-Remote Systems
[+ Server

- Spell Check ¥
1 | | L|_I Reset | Restore Defaults | Apply I

Irnport... | Expart... | | oK I Cancel I

Click Compare under LPEX Editor.

In the right pane of the Preferences window make sure that the Ignore blanks
check boxes are selected.

Click OK in the Preferences window.

Back in the Edit window of the PAYROLL member or PAYROLLC member
double-click the PAYROLL tab or PAYROLLC tab.

Click Edit > Compare > Compare from the workbench menu.
The Compare window opens.

Expand your connection.

Expand *LIBL.

Expand RSELABXX.

Expand QRPGLESRC or QCBLLESRC.
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11. Select member PAYROLLG or PAYROLLC2.

X
Select a member
[PavroLLG
B =l

H}:, Q5SS Mib.prod-sys

-k Qsv52.*ib.prod-sys
E-Ih QHLPSYS. *lib.prod-sys

S H}:, QUSRSYS Mib,prod-sys
@ W RSELABXX. *lib. prod-cur

- {2y COMPARE. *file.pf-src
T EMPMST *File.pF-dta
’1 EVFEVENT. *file.pf-dta
ﬁ PRIMST  *file, pf-dta
[Ely QeBLLESRC Hile.pf-sic
- Sy QCLSRC.*file.pf-src [
& Ey QCMDSRC.*File. pf-src
- @[y QDDSSRC Hile pf-sre
@E] QRPGLESRC. *file pf-src =
oy PAYRO i

cengans

i i. q.
E-E] QRF =B e.pf-srl: LI

m 5 nockcT #Eia oF ke

[ o« | cancel [

O ' RSELABK: Hib.prod-cur
#-Ely COMPARE. *file pf-src
® - EMPMST *file.pf-dta
-5 EVFEVENT.*file.pf-dta
#-[F PRIMST *file.pf-dta
(O =h QCBLLESRC *file.pf-src

- [y PAYROLLC.chlle

12. Click OK.

The editor now will show the differences of these two members PAYROLL
and PAYROLLG or PAYROLLC and PAYROLLC2.

You can move from mismatch to mismatch by going back to the Compare
menu under the Edit menu.

Mismatches in PAYROLL and PAYROLLG or PAYROLLC and PAYROLLC?2 are
highlighted in different colors so that you know where the mismatched lines
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are in each file.

Next, end the compare session.

Owekome | Zmsose 2T x | 7/ REFMST
Row 52 Column 1 Replace
I....CLDNDlFactDr1+++++++0pcude(E)+Factnr2+++++++Result+++1
Uusaoo [ e e e i T O el e o
003900 c* T mainline routine controls the display file pr
004000 C* editting. Uzing the function keys described on es
004100 C* format, you can transfer from one maintenance appl
004z00 C* another. The = on code you sSelect on the select
004300 C* determines if the program will add a new record tc
004400 C* update an ex ny record in the file.
Duqsuu Cﬂ‘%‘ﬂ‘ﬂ*ﬂ?}ﬂ‘ﬂ*ﬂ?}ﬂ‘ﬂ*ﬂ?}ﬂ‘ A R A A A AR AR AR R AR LR AR AR R RS E SRS S S
004600 C* Housekeeping, clear display fields and reset indic
004700 Cc*
004800 C EXSR MATIN
004900 C* If MAIN is done program ends
aosooo0 C eval *INLR = *on
005100 L RO T IIE
o0s5z00 (a8 HATIN BEGSR
C dou *TNKC
Q05300 C dou *inke
005400 Cc EVAL k3
005500 C EVAL EMESS = *BLANK
005600 c EVAL EMPAPL = *BLANK
005700 c EVAL PRJAPL = *BLANK
I
swsose | Zrermst R X |
Row 87 Column 1 Replace
*h-1-B + 2 + 3 % + ] 5 +
000085 -]
0000s8 01 ERROR-MESSAGES.
00oos7? 05 M3SG-TAELE. 1
10 MSG-1 PIC X(50) VALUE
000088 10 HM3G-1 PIC X50) VALUE
00o0s9 ! MAINTENAMNCE SELECTION CODE MNOT EQUAL
000050 10 MSG-2 PIC X(50) WVALUE
000091 'MORE THAN COMNE APPLICATION SELECTED FOR

13. Click Edit > Compare > Clear from the workbench menu.

14. Double-click the PAYROLL tab or the PAYROLLC tab to return the Editor

window to its original size.

Checking syntax

One of the powerful features that the LPEX Editor shares with SEU is its ability to

syntax check your source. Syntax checking can be done either when the cursor
leaves each line of source or all at once on either the currently selected source or

on the entire file.

Now you will create a syntax error and watch for the prompt to correct it.

To syntax check the RPG file:

1. In the PAYROLL Editor window move the cursor to line 211 which contains

EXSR ACDESR.

You might already be on that line but if not, type the line number in the

sequence number column, or scroll down.
2. Append an X to the EXSR op-code to make it EXSRX.
3. Move the cursor off of the line.
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An error message appears to draw attention to the error.

Owekome X | Zwsose | Zrerwst 2 x
Row 211 Column 13 Replace 1 change.
s T . e T T A e
DzZ0300 C IF *INKD
0Dz0400 Cc leavesr
0z0500 C END
DzZ0s00 Cc*
0z0700 C* jpoess ewmployee master to validate action code reg
020800 c*
0z0s00 C IF NOT *INEKC
0z1000 C EMPNO HATY EMPMST
021100 C ACDESR
ENF5014E COperation code i3 not valid; specification is igno
Dz1z00 C ELSE
021300 C LEAVESE

4] |

4. Move the cursor onto the pink error message.
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Q Application developer
©: Rational ClearCase

2 | ]

|_«?|ﬁim

5. Press F1.
db Help - webSphere Development Studio Client Advanced Editi -10] x|
Search: | |m Search scope: Al bopics
Contents o) o B S
Q iSer?es applil:atiun_ de’ R PG M ess ag es
@ iSeries programming
@ Remote System Explc
@ Support information
Q Tool developer inform M
© 326€ 5K 1.3.1 APIs Operation code is not valid; specification is ignored.
Qs Remote System Explc
@ 1266 50K 1.3.1 APIs || 30
© websphere applicatic|| Cause ... .. : The Operation code is not valid. Mo further

checking is done on the specification. The operation must
start with a valid Operation Code and can be followed by
an optional Operation Extender. If specified the Operation
Extender must be one or more of A, D, E, H, M, N, F, R,
T, or Z, and enclosed within parentheses.

Recovery . . . : Specify a valid operation, or omit the
specification. Compile again.

[ Top of Page | Previous Page | Next Page | Table of
Contents |

Copyright IBM Corporation 1992, 2003, All Rights Reserved.

This opens a window with second level help for the error.

Minimize the Help window.
Change "EXSRX’ to "EXSR’ to correct the error.
Move the cursor off the line you just fixed.

The error message is automatically removed from the editor.

To syntax check the COBOL file:




1. Click the PAYROLLC Editor window, click Source and then click Source >
Syntax Check All on the workbench menu.

4P Remote System Explorer - PAYROLLC - WebSphere Development Studio Clie Ad -3l x|
File Edit | Source Compile Mavigate Search FProject Run Window Help

|5 - TR - - 9% e- -
| @ 6§ Verify
| Verify With Prompt... —
T | Reme ose | Zrerst BT x| <
E 3‘; p z‘;uw Fields — Colum 1 Replace —
= CopyBook ¢ B--—+-*a-1-B--+ 2 ' 3 -4
- Resequence AllLines 001 PROCESS AFOST. i‘ o
ﬁ Refresh ooz - E
QCBLLESRC. *File, pF-stc ooo003 IDENTIFICATICHN DIVIZION. 5
-y PAYROLLC chlle 000004
-0y PAYROLLCZ.chlle 00000s PROGEAM-TID. PALYROLL.
-y PAYROLLD.cblle [ | oooooe AUTHOR. Prograte
QCLSRC. *file. pf-src 000007 INSTALLATION. IEM Toron!
QCMDSRC.*HE.Q‘-S[C 000008 DATE-WRITTEMN. October 10
QDDERC}HE@Fsm ooooog DATE-COMPILED. =
ﬁ EMPMST . pf X -| « [ _*I—’

Error messages appear to draw attention to the errors.

AVsTDSP | #REFMST X ]

Fow 91 Coluwn 35 Eeplace

i e s 5 ;
000085 | N
000086 01 ERROR-MESSAGES.
000087 05 MSG-TABLE.

=
000088 10 MSG-1 pxc VALUE
LNCZS530E Unmatched right parenthesis. Hight parenthesis

LNC1245E PICTURE string 'XS0)' does not describe wvalid d

000089 ' MAINTENANCE SELECTION CODE NOT EQUAL
(n{u]uluf=Iu} 10 M3G-2 PIC X(50) VALLTE
000091 'MORE THAN ONE APPLICATICN SELECTED FOR
000092 10 MSG-3 PIC X(50) VALUE
000093 ' MO AFPLICATION SELECTED FOR MAINTE
000094 10 M3G-4 PIC X(50) VALTUE
00o09s ! LCTICN CODE MNOT EQUAL TO faAr™, M™Cr O
000096 10 MSG-5 PIC X(50) VALUE
-
4| | »

2. Move the cursor onto a pink error message.
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3. Press F1.

4P Help - WebSphere Development Studio Client Advanced Edition =]
Szarch: | |m Search scope: All topics
Contents &2 G Bl 5

® iseries application dev CO BO L M essag es

© iseries programming i
@ Remote System Exploi
@ Websphere Applicatiol
@ 32sespk1.3.1 ap1s | LNC2530
Q Application developer
Qs Tool developer inform
€ 12EE SDK 1.3.1 APIs

© Remote SystemExplo| | Cause.....: There is a right parenthesis in the picture
€ support information string without a matching left parenthesis.

h@matched right parenthesis. Right parenthesis ignored.
30

Recovery . . . : Remove extra right parenthesis or supply its
matching left parenthesis.

[ Top of Page | Previous Page | Next Page | Tahle of
Contents |

‘I I X Copyright IBM Corporation 1992, 2003, All Rights Reserved,

|?'~‘?[sé9'|m

This opens a window with second level help for the error.
4. Minimize the Help window.

o

Add the required left parenthesis to correct the error.
6. Move the cursor off the line you just fixed.

The error message is automatically removed from the editor.
7. Close the file and save the changes.

Tip: You can toggle automatic syntax checking. Click Window > Preferences from

the workbench menu and then expand Remote Systems, iSeries, LPEX Editor
Parsers, ILE RPG or COBOL in the left pane of the Preferences window, select the
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Automatic syntax checking check box, then click OK.

&P preferences

- Command Executio ¥ Repeat previous specification type

- +| NERPG
{-!- Remote Systems
T TTommunications ¥ Automatic syntax checking
- - Files [~ Automatic uppercasing
T Cache Enter key behavior

Ej’“ma"d Subsyste [~ Repeat previous operation code (I on C-Specification)
: [ Set C-Speification cursor position

Position |=;,c:T0R1 v[

I™ Set free form C-Specification cursor position

Pasition I =

[~ Set D-Speification cursor position

Objects
#]- Program Verifiers Position I FROM - l
Templates
- Logging I™ User defined tabs
-~ Passwords |H: Control j
[+~ Server
-Spell Check | ..... HEeywords+t++++t++++t+++4t+4++dbb+444444H
- Symptom Database: - —
[#- Team I
- UML Visualization sdevery: [0

4P Preferences

User Profile :l COBOL
[+ C:\Documents and Sett
[+ C:\Documents and Sett
[+ C:\Documents and Sett - I::?er defined tabs
[#- Plug-In Development
[+ Profiling and Logging
% RAD -

@ Remote Systems I
Communications

. - Files and every: [I:l
: @ iSeties
0 beCache

- Command Executio

~-Command Subsyste
; - Job Subsystems
I @ LPEX Editor Parsers

-€CoBAl

[Indicates that the parser should use the tabs defined here rather than the parser defaults. |

Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.

1. When column sensitive editing is selected:
a. Each column is considered a separate entry space

b. If you are inserting or deleting characters into a string that is in the Factor
2 entry, the result field entry does not move

C. The default editor preference is that column sensitive editing is off
d. All of the above

2. The LPEX Editor has predefined settings, but also has an associated preference
page containing settings that you can define. (T, F)

3. LPEX Editor preferences are set in the:
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10.

11.
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Preferences window
Editor window

New wizard

a0 o

Remote Systems view

You can configure the LPEX Editor to adopt the keyboard and command
personalities of many popular editors. (T, F)

If you want to undo a set of changes made to a file you must use the
operation. Name the operation.

a. Insert
b. Replace
c. Redo

d. Undo

You can also cancel the effects of an undo operation by using the
operation. Name the operation.

a. Insert
b. Replace
c. Redo

d. Undo

This help is invaluable if you cannot remember the order of fields in an RPG
specification or the possible values for a variable field. Name the help. Choose
the best answer.

a. Context sensitive help
b. Language sensitive help
c. Display help

d. Field help

To receive language sensitive help, press ____ key in an Edit window. Name
the key:

a. F2

b. F3

c. F1

d. F4

If the cursor is a field, you receive help for that field.
a. Before

b. After

c. On

d. Off

Instead of entering or changing code directly in the Editor window, you can
use

a. Prompts

b. Filters

c. SEU commands
d. Format line

e. All of the above

views are hidden views, which can be quickly made visible. They work
identical to normal views, the only difference being that when hidden they do
not take up screen space on your workbench window.

a. Remote Systems



12.

13.
14.

15.

16.

17.

18.

19.

b. Navigator

c. Outline

d. Fast

The option allows you to view your source with constructs in an
indented mode. By default, the option will split the screen
horizontally and how show the indented view in the bottom pane.

a. Fast view

b. Outdent

c. Indent

d. Edit

The indented view is browse mode only and cannot be edited. (T, F)

You use the window to search for an item. Choose the best answer.
a. Search

b. Find

c. Edit

d. Find and Replace

You can search for:

a. Aword

b. A partial word

C. A sequence of words

d. A pattern if it follows the rules of regular expression

e. All of the above

The LPEX Editor allows you to ____ or subset your source so that you see
only lines containing a given string.

a. Search

b. Find

c. Sort

d. Filter

To help you navigate quickly through your ILE RPG source the editor allows
you to filter lines based onthe _ . Choose the best answer.

a. String

b. Line type

c. Line number

d. All of the above

If you would like to search through the members in a source physical file or

through the files in a local directory, you can use the tool. Choose the
best answer.

a. Compare

b. Search

c. Find

d. Edit

The tool allows you to compare different versions of a program and
find the differences. Choose the best answer.

a. Convert

b. Migrate

c. Compare
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d. Search

20. There are two ways to compare files. They are Compare tool in the workbench
and the Compare tool in the CODE Editor. (T, F)

21. Syntax checking can be done either when the cursor leaves each line of source
or all at once on either the currently selected source or on the entire file. (T, F)

More practice

Want more practice? Try this!

Given your experience in this exercise using the Remote Systems LPEX Editor, try
these new tasks: Check out how token highlighting works in your ILE RPG source.
Display a format line and use it to enter your source. Filter source by comments.
Set auto-uppercase on. Use the Development Studio Client for iSeries online help
to assist you in these tasks.

Recap

Congratulations! You have completed this module. You should now understand:
* The benefits of each language editing feature

* How to do column sensitive editing

* How to enter SEU commands

* How to undo and redo editing

* How to access help for language elements

* How to prompt on language elements

* How to indent source

* How to find and replace language elements

* How to filter the source by string and by line type
* How to search files

* How to compare files

* How to syntax check files

Now that you have mastered editing source, you can move on to verifying your

source to ensure you have a clean compile on the iSeries system. This approach
saves you iSeries cycles! Continue to the next module.
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Chapter 7. Verifying source

In this module, you will learn how to verify source in the Remote Systems LPEX
Editor. The program verifying and program compiling are the final steps in
compiling a program or module. When errors are found by either, the iSeries Error
List appears. The iSeries Error List is a powerful tool that manages errors found by
verify and compile utilities in the Remote Systems LPEX Editor. You will become
familiar with these tools, the various capabilities of the iSeries Error List and the
program that you have created.

In order to verify source, there are several steps you will need to learn about and
follow:

* Describe the purpose of the Program Verifier
* Invoke the Program Verifier
* Insert messages and checking that errors were fixed using the iSeries Error list

¢ Submit iSeries commands using the iSeries Table view

In order to accomplish these learning objectives, there are several steps that are
involved, including:

¢ Invoking the Program Verifier
* Reviewing the iSeries Error List

* Fixing Errors
The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Verifying RPG or COBOL source

Now you get to play with one of the most powerful and unique features of the
Remote System Explorer — the Program Verifier.

Now you get to play with one of the most powerful and unique features of the
Development Studio Client — the Program Verifier.

Before you compile your code on an iSeries, you can make certain that there are no
errors by invoking the Program Verifier. The verifier checks for semantic (compile)
errors on your workstation so that you can guarantee a clean compile on the
iSeries. Think of the host cycles you'll save. It is especially handy when you are
writing code but you are disconnected from an iSeries. You can do this because
Development Studio Client ported the parsing and checking code from the iSeries
system compilers to the workstation. The iSeries Error List window lists the errors
that are found and their severity, inserts the error messages directly into the source
and helps you to navigate between the errors.

Note: Make sure that your user ID has been setup, so that your library has been
added to the library list automatically. You can use the properties for iSeries
Objects dialog to set connection information such as adding a library to a
library list and changing the current library. From the Remote Systems view,
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you can right-click on iSeries Objects then click Properties to see this dialog.
You will need this setup to run jobs interactively from your workstation.

4P Properties for iSeries Dbjects

Command Execution
Environment Yariables

Subsystem

_ (o] x|
Initial Library List
—Library list
Library: |
Librar Library Position
RSELABX (CFIRST )

Move Lip

Remove I
T

Move Daowr

Current library: | "USRPRF |
Initial command:
c ICHGCURLIB RSELABKK D
Restore Defaults | Apply I

.

To invoke the verifier:

1. Click the PAYROLL tab to verify RPG source or PAYROLLC2 tab (you will
need to open the PAYROLLC?2 file for edit first) to verify COBOL source.

Click Source > Verify from the workbench menu.

2.
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After a moment the verifier will display an iSeries Error List below the Editor
window.

X3 iSeries Error List - <TOR

=R O

Message

| 5. L..] Location

<MD= A< 3> )

RMNF...
RNF...
RNF...
RNF...
RNF...
RNF...
RNF...

EMDSR operation is missin.. .

The name or indicator EME. ..
The name or indicator RSH. ..
The operand RSNTAX of E...

Factor 2 must be '0' or '1' ..,

Move operands ERR andE. ..
RPG provides Separate-In...

3.

QW wwww

1

M@ W w oW

RSELABXX/QRPGL.,
.. RSELABXX/QRPGL..,
.. RSELABXX/QRPGL..,
.. RSELABXH/QRPGL..,
.. RSELABXX/QRPGL. .,
.. RSELABXX/QRPGL. .,
.. RSELABXX/QRPGL..,

s400a
s400a
s400a
s400a
s400a
s400a
54003




:LNC1904 Pr:ograrn PAYROLL syntax checked, Errors ...

1 RSELAEXK/QCELL, .. 54002
302 RSELABAXMQCELL... s400a
402 RSELABXX/QCBLL... s400a
606  RSELABXXMQCBLL.,.. s400a
184  RSELAEXX/QCBLL... s400a
299 RSELABAXMQCELL... s400a
348 RSELABXX/QCBLL... s400a
399  RSELABXXMQCBLL... s400a
443  RSELAEWXMQCBLL... s400a
499  RSELABXX/QCBLL,.. 5400a
548 RSELABAX/QCELL... s400a

LNC1463 'EMPHNOC" is not unique in this contesxt, Use ..,
LMC1326 'PRCD OF PRJSEL-I' not defined name. Sta...
LNC1329 Subscript value '14' exceeds maximum occ..,
LMNCO407 AT EMD phrase missing from sequential RE...
LNC0407 AT END phrase missing from sequertial RE. ..
LNCO407 AT EMD phrase missing from sequential RE. ..
LNC0407 AT END phrase missing from sequential RE. ..
LMCO407 AT EMD phrase missing from sequential RE...
LNC0407 AT END phrase missing from sequential RE. .,
LNC0407 AT END phrase missing from sequertial RE. ..

U QRO 0 R0 JO< <]
BEEEEEBEE8E88)Y

The error list shows you:

The error message itself
The severity

The line number

The source location

The connection name

Fixing RPG errors

Next you fix the errors in your source.

To fix an error in your source go the error list:

1.

Double-click the error RNF7030.

You are automatically brought back into the Editor window to the line where
the error occurred. The error on line 365 is a typo. The variable EMES is really

EMESS. One good way of finding the correct name is the content assist.

] Welcome - x l
Row 365 Column 50 Replace
..... CLONO1iFactor 1+++++++0pcode (E) +Factors ++++++ sult++++
036500 G MOVE ERE (2) E|
RNF7515: Mc{EMESS [ Eemess
RHF7030: Th ]
f char{50) IEMPHO
036600 [ T IEMPAPL
036700 [ FIEMCAT
036800 i
oass00  cr il
037000 C* Th i
037100 cT  ap ENAME
037200 c* Prenrrs
037300 C IFEQ vt
037400 i AMDEQ vt
037500 C ANDEQ ro
037600 [o MOVE r1e *IHAEO
037700 [o MOVE ERR (3] g
1 |
Verify program action completed with errors.

Refresh the Outline view.
Select the misspelled variable and press CRTL+spacebar.

If the variable starts correctly the selection presented contains the correct
name.

Double-click the variable EMESS in the list to correct the variable name.
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Another way is find the variable name is to use the Outline view and see
what variables are declared.

8= outline 69 x
=} Fields A
{21 ACODE : Character (1)
: L:D ACREC ; Character (1)
-([1 EDEPT : Character (S)
-0 ELOCN & Character (30)

K s haatr G013

RIE o o e
(1 EMPNG : Packed Decimal (6,0)
- ENAME : Character (30)
-0 ENHRS : Packed Decimal (3,1) —
{21 EPHRC ; Packed Decimal (5,1)
-1 EPHRP : Packed Decimal (7,1}
-] EPHRY : Packed Decimal (7,1}
) EPNRC : Packed Decimal (5,1)
- EPNRP : Packed Decimal (7,1}
{1 EPNRY : Packed Decimal (7,1)
- ERR : Character (S0) DIM{10)
- EUSRI : Character (8)

1 eRNF « Fharacker (23

- - Iﬂ
The next error is a RNF7030 as well.
Double-click RNF7030. Fix it in the editor.
RSNTAX should really be RSNTAG.

Make the appropriate change.

Go to the next error RNF5184.

The next error is actually RNF7018 but it is related to the first one and can be
ignored. It shows the same line number, which an indication that both errors
are related.

Double-click RNF5184.

Certainly somebody didn’t know their RPG and tried to assign a value 2 to an
indicator.

Fix this by replacing the 2 with a 1.

Error RNF7515 is related to the first error you fixed. It has the same line
number. You can ignore it. The only serious remaining error is RFN5178. This
error is caused by a missing ENDSR.

Note: The verifier could not determine where the ENDSR is missing so the
line number reported is 1, for this reason you can’t just double click on
the error message. You need to investigate where the missing statement
belongs.



10. Move to line 398 in the editor.

* ] Welcome /7 pal x
Row 398 Column 1 Replace
B....... ToveeFeeeaZuoneatenaBeeeateneateeatan . Buusot

038600 c HOVE ERR(1) EMESS 4|
038700 C END

038800 C FRJAPL IFNE v

038900 C PRJAPL ANDNE vE!

033000 C HMOVE 1 T INGC
039100 c HOVE ERR(1) EMESS
039200 C END

039300 C RSMAFPL IFNE v

039400 c RSMNAPL ANDNE B q

039500 C HOVE ' *INsC
039600 C MOVE EER(1) EMESES
039700 END [
bassoo @ ENDSE

039900 L

quaoo (_‘ﬂ"xS'TT'X'-‘."K3".‘73"-‘7'!3".‘7*'-’.13".‘73"-‘7'!3".‘73"-‘7'!3".‘7*'-‘71S‘TT'X?TT*?T*?TT*'KT'.‘TTR'

< | 2
|

11. Remove the asterisk (*) from the C-spec.
You can use the Tab key to quickly move to the appropriate column.

All the non-informational errors are now fixed. You can filter out different
severities by using the filter menu.

X3 iSeries Error List - <TORASOTM

@m P o v i Information
IID IMwsaqg IS..[L.J Locat JVRF

@ RNF... EMDSR operationismissin... 3...1 RSEL v & Error =
'.'ll RMF...  The name ar indicabor FMF... 3.0 3. RSFl.

4 v [ Severe »
Tasks |iSeries Ta... |iSeries Co... |RemoteS... |iSeries Fie v W Terminating (N

12. Click the arrow in the iSeries Error List title bar.
13. Click Show Severity on the pop-up menu.
14. Clear the severities you don’t want to see in the list (Warning for example).

Fixing COBOL errors

Next you fix the errors in your source.

To fix an error in your source go the error list:
1. Double-click the error LNC1463.

You are automatically brought back into the Editor window to the line where
the error occurred. The error is caused by EMPNO not being uniquely defined.
Go to line 302 where EMPNO is defined. The variable EMPNO should be
EMPNO OF EMPSEL-I.

2. Make the change.
The next error is LNC1326.
3. Double-click LNC1326. Fix it in the editor.
4. PRCD should really be PRCDE.
Make the appropriate change on line 402.
5. Double-click LNC1329.
This error is because the array was declared with 4 elements. Go to line 606.
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6. Change the index of the array from 14 to 4.

The next errors are LNC0407. You can ignore these errors as they are severity
20.

All the severity 30 errors and above are now fixed. You can filter out different
severities by using the filter menu.

. v j Information

IID IMwsaqg IS[ L.J Locat: JERF QR Jing
@ RNF... ENDSR operationismissin... 3.1 RSEL v GDErrnr
:.'ll RNF...  The name arindicator FMF... 3.0 3., RSFLs

v [ Severe
Tasks |iSeries Ta... |iSeries Co... |RemoteS... |iSeries Fie v W Terminating

7. Click the arrow in the iSeries Error List title bar.
8. Click Show Severity on the pop-up menu.
9. Clear the severities you don’t want to see in the list (Warning for example).

Saving the source and verifying source again

Now before you loose any of your changes, it’s a good idea to save them. Make
sure the PAYROLL member is selected. You then verify the source again to make
sure that all the errors are fixed.

You can save the member using one of these ways:
1. Click File > Save from the workbench menu.
2. Click the Save icon in the workbench toolbar.
3. Press Ctrl+S.

Changes are uploaded to the iSeries.
4. Verify your source again; Source > Verify.

*3 iSeries Error List - -iTORnSD?Mﬂ; |

D Message | sev... | Line | Location |
i RMF7089 RPG provides Separate-Indicat... 0 27 | RSELABXXJQRPGL...
1 RNF7031  The name or indicator *INO3is ... D 1 RSELABXA/QRPGL...
i RNF7031  The name or indicator *INO4is ... 0 1 RSELABXY/QRPGL. ..
i RNF7031  The name or indicator *INOS is ... 0 1 RSELABXX/QRPGL...
1 RNF7031  The name or indicator *INO&is ... 1) 1 RSELABXA/QRPGL...
i RNF7031  The name or indicator *INO7 is ... 0 1 RSELABNAQRPGL. ..

iSeries Error List - < TORASD! =N .
D Message [ s... | Line | Location | conmection
| LNCO407 AT END phrase missing from sequential RE,.. 20 184 RSELABXXJQCELL... s400a
LNC 0407 AT END phrase missing from sequential RE,.. 20 299  RSELABSWIQCELL... s400a
LMC 0407 AT END phrase missing from sequentisl RE... 20 348  RSELABxXJQCELL... s400a
LMC 0407 AT END phrase missing from sequential RE,.. 20 399  RSELABYYIQCELL... 54003
LMC 0407 AT END phrase missing from sequential RE,.. 20 448  RSELABXX/QCELL... s400a
LMC0407 AT END phrase missing from sequential RE,.. 20 499  RSELABXXJQCELL... s400a
LMNC 0407 AT END phrase missing from sequential RE,.. 20 548 RSELABRW/QCELL... s400a

o

00000 Q

Remote System Details | Tasks | iSeties Table View |iSeries Commands Log | iSeries Error List |

Everything should be ok. You are ready to compile the program.

Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.

76 Remote System Explorer



1. The tool checks for semantic (compile) errors on your workstation so
that you can guarantee a clean compile on the iSeries.

a. Compile
b. LPEX Editor
c. Program Generator
d. Program Verifier
2. The view identifies each error with an icon that identifies the

severity level of the error, the ID of the error, the message, the severity, the line
in the source member that caused the error, the location of the source member

that produced the error, and the connection name.
a. Remote Systems
b. Outline
c. Navigator
d. iSeries Error List
3. You can sort the entries in the iSeries Error List view by:
a. ID
b. Message
C. Severity
d. Line
e. Location
f. Connection
g. All of the above

4. If you used the local program verifier, then your host compiles should be
successful; no wasted iSeries cycles. (T, F)

More practice

Want more practice? Try this!

Given your experience in this exercise using the Program Verifier and that you

have your own source on your own iSeries system try these new tasks: Check out
Verify again on your source files. Assuming you receive errors in your source (add
some errors into your source if you don’t have any) when you verify your source,

choose insert all error messages into the editor from the Error list. Use the
Development Studio Client for iSeries online help to assist you in these tasks.

Recap

Congratulations! You have completed this module. You should now understand:
¢ The purpose of the Program Verifier

* The purpose of the iSeries Error List

* How to invoke the Program Verifier

* How to view and fix errors using the iSeries Error list

* How to save the fixed source

Now that you know how to verify source, you can move on to compiling the
source. Continue to the next module.
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Chapter 8. Compiling source

In this module, you will learn how to compile source in the Remote Systems LPEX
Editor. The program compiling are the final steps in compiling a program or
module. When errors are found by either, the iSeries Error List appears. The iSeries
Error List is a powerful tool that manages errors found by compile utilities in the
Remote Systems LPEX Editor. You will become familiar with this tool, the various
capabilities of the iSeries Error List and the program that you have created.

In order to compile source, there are several steps you will need to learn about and
follow:

* Submit iSeries commands using the iSeries Table view in Remote System
Explorer

* Insert messages and checking that errors were fixed using the iSeries Error list
* Select compile options and compiling source using the Compile utility
* Explain the generated program called PAYROLL

In order to accomplish these learning objectives, there are several steps that are
involved, including:

Compiling interactively

Specifying compile options

Submitting the iSeries commands in the iSeries Table view
Running commands and programs

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 10 minutes to complete.

Compiling interactively

The remote compile capability is part of the Remote System Explorer. It gives you
a workstation interface to submit requests to iSeries to compile, bind, or build
objects on the host. It allows for easy access to all the compile options available for
all the supported CRTxxx commands.

If you used the local program verifier, then your host compiles should be
successful -- no wasted iSeries cycles. However, if there are errors, the host
compiler will send the error information back to the workstation and they will be
loaded into the iSeries Error List window, which behaves just as it did when you
did a program verify.

The default for compiling programs is to submit the compile to the batch job
queue. Here in this exercise you can run the compile interactive.

Note: Make sure that your user ID has been setup, so that your library has been
added to the library list automatically. You can use the properties for iSeries
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Objects dialog to set connection information such as adding a library to a
library list and changing the current library. You can right-click on iSeries
Objects then click Properties to see this dialog. You will need this setup to
run jobs interactively from your workstation.

&P Propetties for iSeries Objects

~Command Execution
- Environment Variables
- Subsystem

Initial Library List

=lofx|

—Library list
|
Libra Library Position
RSELABXY (CFIRST )

L]

Move Lip

Mewve Dowr

Current library: I"‘USRPRF ZI
Intial command:
< ICHGCURLIB RSELHE’:Xl }
Restore Defauls | Apply |
| d\*s I Cancel I

To change the preferences to run the compile interactive:
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1. Click Window > P

db Preferences

references from the workbench menu.

=10/ x]

[+ Profiling and Logging

[+ RAD
- Re, mple
Remote Systems
™~ ions

-~ Jab Subsystem
- Objects

¢ Templates
- Logging
. Passwords
E| Server
-~ Spell Check
- Symptom Database
[+ Team
[+ UML Wisualization
4

- Command Executi,

[#- LPE¥ Editor Parsers

[#)- Program Yerifiers

;l Command Execution

Command Execution Preferences

Preferences for compiles and user action variables
Obiject library:
IV Replace object

@Urrpib in batch

Preferences for batch compiles, commands, and user action
Job description libraty: I"_LI

E

yske

5

Job description:

1

SBMIOE additional parameters:

Preferences only for compile commands

+| Comoile member tvoes in this order:
» |

mport... | Export.

- o]

Cancel I

In the left pane of

a s~ DN

box.

the Preferences window, expand Remote Systems.

Expand iSeries under Remote Systems.
Click Command Execution under iSeries.

6. Click OK to return to the Remote System Explorer perspective.

In the right pane of the Preferences window, clear the Compile in batch check

Specifying RPG compile optio

ns

You will now use the prompt for the CRTBNDRPG command to specify your
compile parameters. All entry fields pertaining to names are already filled in with
the correct information.

To compile source:
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1. Right-click the PAYROLL member in QRPGLESRC.

ate v X || ]'Welcome |anVROLL ><|
=& @b L . | :ﬂ{ AF Fow 398 Column 9 Insert
—_— — CLOJ01Factor 1+++++++0pcode (E)
I s s c HOVE
& E] QCMDSRC 039700 C END
(2 By QODSRC 1 c ENDSR
= Ely QRPGLESR e o
% Pp"\ GOTO ’ b e e o e o o e o o o e o]
E % QRPGLI ) ACDESE subroutine werifie
&M rRerms Open With *| all wmaintenance selectio:
: Browse With P lerosrmrananrnnnmrnsnenrnrnns
E_‘ =} RSNM3 ALCDESR BEGSER
| '} B MYCON o Rename
-l RSELABXY. = - N o
By QGPL.*ib.g l% Copy Housekeeping, clear disp:
ol WRLABNR Y «f Move |
H 1, " N
E"iﬁ’ User libraties # Delete m action completed with inf
- ;k iSeties Commands
) @ iSeries Jobs Werify
[+]- ‘Eﬁ IF5 Files werify {Prompt) TORASOTM>RSELABXY/QRPGLESRC(PAYROL
P I I Cornplle + il | =
Compile (Prompt)

Remote Systems lTean User Actions

5] Properties = Add To iSeries Praject...
IE = 5 Make Available OFfling T3 Work With Compile: Commands...
5L 2 yame or indicator *INOE is not referen,,, 0
Property l Value Compare With b pame of indicator *INO7 is not referen.,. 0
Attribute SRC 5
Hame PAYROLL IS

2. Click Compile (Prompt) > CRTBNDRPG on the pop-up menu.
The Create Bound RPG Program (CRTBNDRPG) dialog opens.
3. In the Debugging views list, select the *ALL parameter.

dp Create Bound RPG Program (CRTENDRPG}) x|
Program: PAYROLL x|
Library: RSELABXK j
Source File: QRPGLESRC 4
Library: RSELABXYX ~|
Source member: PAYROLL |
Generation severity level: 10
Text ‘description’: *SRCMBRTXT
Default activation group: *YES j
Advanced Parameters
Compiler options: | ,l add
*EVENTF Remowel(E) I
[Move up I
Move down I
Debugging views: AL 4

If you want check out the other parameters available, click Advanced.
4. Click OK when you are done.
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The progress bar on the workbench (bottom right corner) will indicate that the
compile runs then the error list will be shown, with no errors, just information
messages.

If you are not sure that the compile was successful. You can check the iSeries
Commands Log.

s Commands Log g T %
CRTEBNDRPG PGM{RSELABKY/PAYROLL) SRCFILE(RSELABXY/QRPGLESR.C) SRCMBR{PAYROLL) :l
OPTION(*EVENTF) DBGYIEW(*ALL)

Program PAYROLL placed in library RSELABXX, 00 highest severity. Created on 04/08/04 at 11:00:12,
Cause . ... .: Program PAYROLL was successfully created in library RSELAEXX. The highest message _l
severity that resulted was 00, The program creation date and time are 04/05/04 and 11:00:12.

Command |Narmal j | J Prampt | AU |

5. Click the iSeries Commands Log tab at the bottom of the workbench.

This log shows a list of all commands run on the remote system and the
messages returned for each command.

Specifying COBOL compile options

You will now use the prompt for the CRTBNDCBL command to specify your
compile parameters. All entry fields pertaining to names are already filled in with
the correct information.

To compile source:
1. Right-click the PAYROLLC2 member in QCBLLESRC.

 Remote Sy v x || #msTDsp | FravRoLLCZ X |
=E?! @}j = | b4 .3;9’ Row 1 Column 1 Replace
; - 1Bt =2 ————+ F-—
= T Enesr. e f-che | 000001I PROCESS APOST
- [E EVFEVENT . ¥file.pf-d B :
0S¥ MSTDSP. e st 000003 IDENTIFICATION DIVISION
- 6] MSTDSP2. *file. dspf B :
0 B PROMST e, pf-cha 000005 PROGRAN-ID PAYROL
= E] QCELLESRC, *file.pf- —-
000006 AUTHOR. Progra
[y PAYROLLC.chlle
o W—_& T annanT , INSTALLATION. IENM To
o 1o -
T
1 B QLsrC ile. Open with » - :

5 By QCMDSRC.*fil Browse With
=1 [Ely QDDSSRC il
i Ty EMPMST.; T Rename |

By MSTDSP.d B copy
-0y PRIMST.p

0y RermsT p B Move
Iy RSMMST.p $8 Delete - Log
M ORPGLESRC,*
4| Verify
Remote Systems [Team VeriFy (Prompt)
5] Properties E = [0 Compile (Prompt) »
_Property | Vale | User Actions >
Altribute  SRC Add To iSeries Project. .. 5l work With Compile Commands. ..

Hame PAYROLLCZ tzaka fuwailakla OFFine I —i1

2. Click Compile (Prompt) > CRTBNDCBL on the pop-up menu.
The Create Bound COBOL Program (CRTBNDCBL) dialog opens.
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3. In the Debugging views list, select the *ALL parameter.

4P Create Bound COBOL Program (CRTENDCBL) x|
Program: PAYROLLC2 |
Library: RSELABXX R
Source File: [}3 QCBLLESRC
Library: RSELABXY 4|
Source member: PAYROLLC2 =]
Output: #PRINT =]
Generation severity level: 30
Text ‘description’: *SRCMBRTXT

Advanced Parameters

Compiler options: Iﬁ dd |
*EVENTF — |
Mave up |
Move dawn |
Debug view: AL j

If you want check out the other parameters available, click Advanced.
4. Click OK when you are done.
The progress bar on the workbench (bottom right corner) will indicate that the

compile runs then the error list will be shown, with no errors, just information
messages.

If you are not sure that the compile was successful. You can check the iSeries
Commands Log.

s Commands Log

OPTION{*EVENTF) DEGVIEW(*&LL)

Program P&YROLLC2 created in library RSELABXK on 04/08/04 at 11:08:19,

Cause . ....: The program has been compiled and translated successfully and placed in the
indicated library on the stated date and time.

=
Cornmand |Norma| ;I | ;I Prampt .« I F.unI

5. Click the iSeries Commands Log tab at the bottom of the workbench.

This log shows a list of all commands run on the remote system and the
messages returned for each command.

CRTBNDCEL PGM{RSELABXX[PAYROLLCZ) SRCFILE(RSELABRX/QCBLLESRC) SRCMBR(PAYROLLCZ) j

Submitting iSeries commands in the iSeries table view

You can use the iSeries Table view inside the Remote System Explorer to submit
commands to the iSeries. You can run commands in the Commands field beneath
the iSeries Table view, and view messages in the Messages field. After you
populate the table, you can enter a command and select either Prompt to specify
parameters and then Run, or just select Run (which prompts and runs the
command as normal). When you run a command, the Messages drop-down field is
populated with the messages from the command. When you select a message, the
Details button is enabled. When you press this button, the message and its help is
displayed.
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Also note that you can use the iSeries Table view or the Remote Systems view to
run commands and programs. In the iSeries Table view, you can see the properties
of all items at the same time; they are displayed as rows across the table. In the
Remote Systems view, you have greater ease of navigation; you can work from
your Library list in the iSeries Objects subsystem, and you can see the contents of
many items before selecting the one you want to run.

To change the library list:

I, File RSELABXX/QDDSSRELE SEEY G o E v X
Name Type | attribute Text | status | -
05 EMPMST PF SRC oK

B msTDSP DSPF SRC oK

@ prIMST PF SRC oK |
0 REFMST PF SRC oK

[Ny e e it ﬂ
Command |Normal il m j Prompt. .. | Run I
Messages lCurrent library changed to RSELAB10. ﬂ Details. .. I Show Log, .. I
Remote System Details |Tasks liSerias Table View ‘iSeries Commands Log |iSeties Error List

1. Click the iSeries Table View tab from the views at the bottom of the
workbench.
2. In the Command field type, CHGCURLIB RSELAB10 for example.

Note: Use a library that is on your iSeries system.

3. Click Run.
If you haven’t used the iSeries Table view to show iSeries objects in this view

you will get this error message because the table view is not linked to an active

connection.

&b EVFM1025E x|

Q No iSeries connection exists for the view, Specify a connection using the

view's menu,
] Details == |

If you see this message, click OK and complete the next steps 4, 5 and 6.
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4. In the Remote Systems view, right-click QRPGLESRC or QCBLLESRC.

A MSTDSP

£ | B

2

¢=

[ PAYROLLCZ.cll 4 |

Fow 1

- @ PAYROLLD.chlle gggggzi
w1 Ely QCLSRC.*file.pf-src pouoos
= QCMDSRC ¥l pf-s
@ Ely QDDSSRC *file.pf-s 000004
w5 000005
EE' QRPGLI M »
w-F rRerms G0 TO N
E :nf:lzngi G;,% Refresh
@ ), RsELABxx,  Expand
=l QGPLMibg  ColamsE
s Iy WRLABHX.
gk User lbraries & Rename

- & iSeries Commands %] Copy

-y iseries Jobs [ paste
¥ 1FS Files
++ Move
K1 9 Delete
Remote Systems | Team
Show in Tehle

Click Show in Table on the pop-up menu.
The table view is now populated with the member in the selected source file.
Run the CHGCURLIB command again.

The command will run on the iSeries and after completion you will see the
completion message on the bottom of the iSeries Table view.

I File RSELABKX/QRPGLESR: ’*_E@‘*) a0 B v X
Name Type | attribute | Text [ status |
05 pAVROLL RPGLE SRC oK
[ pPAVROLLG RPGLE SRC ok

|

Command INnrmaI

| i
ﬂ Pmmpt...lﬂl
~] Detais... | SshowLeg.. |

Remate System Details | Tasks |is__e_r_i<_a_s Table View iSeries Commands Log |iSeties Error List

j | chgcur[E- rselablo

Messages ICurrent ibrary changed to RSELAB10,

You can also connect to other than iSeries systems with the Remote System
Explorer and Launch commands for these systems as well, for example, your
local system, or LINUX.

Running commands and programs

You can run programs and commands from the Remote Systems view or the
iSeries Table view in three ways:

1.

2.
3.

In the Remote System Explorer communications server job.
This is the one you are using currently.

In a batch job.

In an interactive job (to test 5250 applications).

Using the first option lets you run the program in the same job as the
communications server. With batch and interactive jobs, you cannot monitor the
status as easily, however, you do not tie up your communications server and you
are notified when the program command ends. Batch jobs work as you would
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expect and do not require any initial setup. Interactive programs require a 5250
emulator, so you need to first run a STRRSESVR connectionName command to
associate the emulator with a particular connection in the Remote System Explorer
communications server.

Starting an interactive connection
To start an interactive connection:
1. Start a 5250-emulation session.

2. Sign-on to the iSeries with your User ID and password.

Note: Instead of the Enter key, you may have to use the Ctrl key in your
5250-emulation session.

= I session A - [24 x 80]

File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] (% 22 3 el

MAIMN [ BE Main Menu

(=]

1. Fl3=Information Assistan

L nu
X IGHT IBWM CORP. 1930
A ] il |
| i :Ccnnected to remote server/host boras07m using port 2

3. In the command line, type the command:
STRRSESVR connectionName RMTLOCNAME (*RESOLVE)
4. Press Enter.

The connectionName parameter is the name of your connection defined in the
Remote Systems view. This associates the interactive job with the Remote
System Explorer communications server. The *RESOLVE keyword will get the
IP address of your workstation and with this information the Remote System
Explorer communications server will communicate with the Remote System
Explorer daemon that runs on your workstation.
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Notes:

a. The connection name is case sensitive and must already be defined in the
Remote System Explorer.

= I session A - [24 x 80] .
File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] % 2 3 @

(=]

| i :Ccnnected to remote server/host boras07m using port 2

b. This screen will stay this way. Don’t wait for it to finish. This session is the
interactive session for interactive commands started from the Remote
System Explorer.

Running the payroll program

Now you are ready to run the PAYROLL or PAYROLLC2 program that you just
compiled.

Note: You may need to refresh the Remote Systems view to see the PAYROLL
program or PAYROLLC2 program in the Remote Systems view under the
RSELABXX library.

Return to the workbench.

To run the payroll program:

1. In the Remote Systems view, locate the PAYROLL program or PAYROLLC2
that you created.

2. Right-click the PAYROLL program or PAYROLLC2 program.
3. Click Run > Interactive on the pop-up menu.
4. Switch to your 5250-emulation session.
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10.
11.
12.
13.

You will see the payroll program menu.

e 1 Session A - [24 x 80] ! =10f x|

File Edit Wiew Communication Actions ‘Window Help
] 2 @[ | | & @] @2

1

v | i menected to remote server/host toras pd101 on psprintl:pd101

Type x beside Employee Master Maintenance.

Press Enter.

Type 456 for the Employee Number.

Type A for the Action Code to add the employee 456.
Press Enter.

Type any information you like about the employee.
Press Enter.

Play in the application as much as you like.

Press F3 to end the PAYROLL program.

If you want to release the interactive job, you could right-click on iSeries
Objects and click Release Interactive Job on the pop-up menu. However, you
may not want to release the interactive job if you expect to debug your
program later in this tutorial.

Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.

1.

2.

A compile command can be run on an iSeries server from the Remote System
Explorer, and you can retrieve error feedback from the compile. (T, F)

Each profile in the Remote System Explorer has a set of source member types,
and each source type has a set of compile names associated with them. (T, F)

There are several ways to compile. They are:
. Prompted
. Non-prompted

. Batch
. Remote System Explorer communications server
All of the above

The iSeries Table view displays the same information as the view,
with the ability to sort items and perform numerous actions.

a
b
c. Interactive
d
e
f.

a. Remote Systems
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b. Outline
c. Navigator
d. iSeries Error List
5. From the iSeries Table view you can:
a. List and sort libraries, objects, and members
b. Copy, rename, delete, edit, compile and run any item in the view from the
pop-up menu
c. Transfer files from one system to another
d. All of the above
6. You can run programs and commands from the Remote Systems view or the
iSeries Table view in:
a. A Remote System Explorer communications server job
b. A batch job
C. An interactive job
d. All of the above
7. Interactive programs require a 5250 emulator, so you need to first run a
STRRSESVR connectionName command to associate the emulator with a

particular connection in the Remote System Explorer Communications server.
(T, F)

More practice

Want more practice? Try this!

Given your experience in this exercise using the Compile command, and that you
have your own source on your own iSeries system try these new tasks: Check out
Compile (Prompt) Work with Compile commands. Assuming you receive errors in
your source (add some errors into your source if you don’t have any) when you
compile your source, choose insert all error messages into the editor from the Error
list. Use the Development Studio Client for iSeries online help to assist you in
these tasks.

Recap

Congratulations! You have completed this module. You should now understand:
* The purpose of the iSeries Error List

* The purpose of the iSeries Table view

* How to view and fix errors using the iSeries Error list

¢ How to save the fixed source

* How to run a remote compile from the Remote Systems view

* How to use the iSeries Table view to enter an iSeries command

* How to start an interactive connection to the iSeries

* How to run the program from the Remote Systems view
Now that you know how to compile RPG source from the Remote Systems view,

you can move on to visually working with DDS source to design a screen for the
RPG payroll program using the CODE Designer tool. Continue to the next module.
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Chapter 9. Designing screens

In this module, you will become familiar with the various aspects of the CODE
Designer while modifying a display file to add a screen. You will step through
each part of the CODE Designer tool interface and update some DDS as well. In
the workbench, in the Remote System Explorer perspective you will use the
connection that you used in the module before.

In order to design screens, there are several steps you will need to learn about and
follow:

* Describe the features of the CODE Designer
* Start the CODE Designer

* Open, modify and save a display file

e Add a group

e Add a record

* Add, delete and modify various DDS fields
* Verify DDS

¢ Compile DDS

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Opening a DDS member

* Viewing the DDS tree

* Selecting the DDS object

* Designing your DDS screen

* Creating groups from existing records

* Creating new screens

* Adding fields to the subfile record

* Switching between multiple records

* Adding field error handling

* Accessing field properties

* Adding new keywords

* Verifying your source changes

* Switching between design and editing your screen
* Compiling your source changes and closing CODE Designer

The exercises within this module must be completed in order. Start with the first
exercise when you are ready to begin.

Length of time:
This module will take approximately 30 minutes to complete.
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Opening a DDS member

Using an editor to create and maintain DDS source for your display and printer
files can be a frustrating and difficult task. What would be great is a graphical
design tool that let’s you design your screens and reports visually and then
generate the DDS source for you. Well, that’s exactly what CODE Designer does
for you.

CODE Designer helps the novice DDS programmer create screens, reports and
databases quickly and easily without worrying about the details of the DDS
language, while at the same time letting the expert DDS programmer get access to
all the features and power of the language.

Note: Make sure MSTDSP is closed from a previous LPEX Editor exercise.

To open a DDS file member:
1. Expand the Library List filter if is not already expanded.
2. Expand the QDDSSRC file in library RSELABXX.

M Remote :yste; v X
Do +- [ PRIMST *file.pf-dta |
% QCBLLESRC *file., pF src

IT_'| REFMST pf
lh RSNMST. pf // Remote Systems LPEX Editor
FOwSE »

3 3] QRPGLESRC. il Hr
-y PAYROLL.rp @ EeTaTE
By PAYROLLG .

3. Right-click MSTDSP member.
4. Click Open With > CODE Designer on the pop-up menu.

The member MSTDSP will be downloaded to the workstation and loaded into
CODE Designer.

Viewing the DDS tree

What you are looking at now is basically an explorer view of the DDS. The DDS
Tree view on the left-hand side of the Designer displays the DDS source in its file,
record, field, and keyword hierarchy. It is a familiar and intuitive way to see the
overall structure of the DDS source and to navigate through it quickly. Don’t worry
if you're not a DDS expert, we will explain everything you need to know.

The DDS Tree is located on the left-hand side of the CODE Designer window. This
view presents the loaded DDS source as a tree structure, showing the hierarchy of
files, records, fields, help specifications, keys, and keywords in each selected DDS
object. The DDS Tree shows groups of records, which represent the screens or
reports you are designing, as peers of the file in the tree hierarchy.

In this view, you can create groups, and copy or move keys, keywords, fields, and

records. If any DDS object contains an error, the icon representing it displays a red
X.
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To open selection in the DDS tree to see file-level keywords and the record
SELECT:

1. Expand the <Servername>RSELABXX/QDDSSRC(MSTDSP) folder.
2. Expand the File Keywords folder.

3. Expand the SELECT record.
4. Expand the Record Keywords folder.
5. Expand the EMESS field.

L b CaDd

. =4 SELECT

. - Record Keywords
H E A 'PREOL
. #-A 'Time R, ..System'
- @-0@y *oate
. #-A 'Mainte. ,.ection’
LB rTIvE
. #-A ‘Enter ...intain’
. - EMPAPL
@A 'Employ...enance’
. 3 PRIARL
. #-A Projec...enance’

-] RSMAPL

. [#-A 'Reason...enance’
. B EMESS
| e DSPATR

. @-A F3-End of Job'

| [-43% EMPSEL

a2 FMPMNT _|;I
4 | »

The DDS tree now shows you a summary of the file-level keywords and of the
record SELECT.

Selecting the DDS object

In the upper right-hand side of the Designer is the Workbook with several different
tabbed pages. The Workbook is the area of the CODE Designer where you design
display files or printer files. You can view this notebook on the top right-hand side
of the CODE Designer window. The top page is called Details and it provides a
detailed view of the DDS objects selected by the DDS Tree. You can view this page
in either details mode or list mode by selecting View > List.

In details mode, columns display information about each DDS object. You can use
this mode if you want to know more about each DDS object (record, help
specification, field, keyword, or keys).

In list mode, the DDS objects appear as columns of named icons. You can use this
mode if you want to see more DDS objects within the page.

In the bottom right-hand side of the Designer is the Utility notebook. It lets you
view specific elements of the DDS source such as errors and selected objects. The
notebook contains several views: Selected DDS page, Error List page, Create
keywords page, and Comments page. The Selected DDS page in the notebook
shows the actual DDS source for the currently selected item.

To work with the DDS record SELECT:
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1.

In the DDS tree click the SELECT record.

The Details page lists all the fields in the record SELECT and summarizes some
of their properties. The Selected DDS page shows the DDS for the SELECT
record.

Details | MAIN_MENU | Source | Listing|

Fecord SELECT fields
Field | Posti.. | Len.. | Type | Shift | Usa... | Sample -
A 'PRGOT 2.5 5 Text congt... PRGOT
A Time R.. System’ 2,30 21 Text const... Time Reporting Spste
@“DATE 270 B Date const... MM DDA
A Mainte.._ection’ 33 A Text const... taintenance Selectic
@"TIME 370 6 Time const... HH:MM 55
A Enter ..intair' 614 54 Text const... Enter an ¥ beside the
I EMPAPL 3.25 1 Alphanumenc A - Alphanum... Both B
A Employ.. enance’ 3,28 27 Text const... Employee Master Mai
[ PRJAPL 10,25 1 Alphanumenc A - Alphanum... Both B
A Frojec. enance' 10,28 26 Text const... Project Master Mairte
‘ﬁ RSNAPL 11,25 1 Alphanumeric A - Alphanum... | Both B R h

In the DDS tree click Record keywords immediately below SELECT.

The Details page shows the current record-level keywords. The Selected DDS
page still shows the DDS for the SELECT record.

In the DDS tree click the EMESS field.

The Details page shows its field-level keywords. The Selected DDS page now
shows the DDS for the EMESS field.

Selected DDS | Create kepwords | Web Settings | Comments | Eror lst |

o]

A EMESS 502 0O 21 16 ;I
A& B0 DSPATR(HI)

g _'IJ

Even this relatively small and simple DDS source member demonstrates how
much easier it is to use the Designer to navigate through your DDS source. The
syntax is being interpreted in intuitive graphical ways making it an ideal tool
for learning DDS. But to get orders of magnitude improvement in your
productivity what you really need is to work with your screens and reports in
a WYSIWYG fashion, completely oblivious to the DDS required to make things
appear the way they do. You need the Design Page.

Designing the DDS screen

You will spend most of your time creating, updating, and designing your DDS
screens and reports in the Design page. The Design pages allow you to design
your screens or reports visually using an intuitive graphical user interface. The
Design page shows the DDS source as it would appear on either a screen (for
display files) or a printed page (for printer files). It allows you to design your
application’s screens or reports by laying out records and fields in a graphical user
interface.

On the Design page, you can easily create, edit, resize, and move DDS objects
graphically. Create new records, fields, and constants directly on the Design page
by using the palette push buttons to the left of the Design area or from the pop-up
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menus. The toolbar above the Design area allows quick access to many of the
editing features as well as information about the currently selected object.

Click the MAIN_MENU tab in the workbook.

Detais QAIN_MENDY Source | Listing |
(&) [Eserec M ERR]
Il_?;' lgnore all indicators j :

My SSTen

the 4ppl caton pog want 1o nantam

In order to understand where MAIN_MENU came from, we need to describe the
concept of a group. A group is simply a collection of one or more DDS records that
represent how a screen or report would be assembled at runtime. It allows you at
development time to work with screens or reports as they would appear when
they get assembled by your programs at runtime. To work with groups in CODE
designer you need to tell CODE designer which record formats make up a screen.
In this case we have done this for the screen you see in the design page. We have
created a group MAIN_Menu and CODE designer saved this information in the
DDS source in comment lines. Any groups that you create are persisted as
comment lines in the DDS so you can re-use these groups in subsequent CODE
designer sessions.

The groups you create will appear in the tree view as well as in the workbook as a
Design page tab for each group defined, to allow quick access to each group of
records.

Creating groups from existing records

If you are working with existing DDS, you will want to create groups that will
correspond to how the records are being used. In this example you will create a
group for the next screen, where the user selects which employee in the payroll
database to maintain. The screen is made up of record format EMPSEL.

To create a new group:
1. Scroll to the bottom of the DDS tree and expand the MAIN_MENU group.
The SELECT record appears as the only record in this group.

-8 MAIN_MENU

> EEE

2. Right-click the MAIN-MENU group.
3. Click Insert group on the pop-up menu.
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A Group Properties notebook opens and a blank Design page for the group
SCREENT1 also opens.

_________

Group ISCF!EEN'I

Available Selected
SELECT
EWPHNT
MPMN
=il FRJSEL 33 |
PRJMNT
RSNSEL .
RSNMNT _I

A
A
A I

The Properties notebook lets you view and update the properties of the
currently selected DDS object. You can open this notebook from any view,
pop-up menu, or menu of the CODE Designer. The properties notebook is
modeless. When you change an object’s properties, the selected object changes
immediately.

In the Group Properties notebook, select EMPSEL record from the Available list
and click the > | button.

For simplicity this is the only record you will add for now. The Design page
now shows us what the record EMPSEL looks like.

[ Egfevesee HIERR)

Igncue allindicalors

Al
Ee)
18]




5. In the group field, type EMPL_SELCT over SCREEN1 to rename the group.

g Group properties _ _?I ﬁl
Basics ] Styles ]

Group

Avallable Selected
SELECT

EMPSEL
EMPMNT
PRJSEL

PRIMNT
RSNSEL
RSNMNT

<

RIS

6. Close the Group properties notebook. Click the X in the top right corner of the
Group Properties notebook.

You have finished creating a group. You could now work in the Design page
with the record formats contained in this group. Now you’ll create a new
record format.

It appears that this is one of those unusable applications where you have to
know the employee number ahead of time instead of being able to browse
what is in the database. What we really need is a subfile. But aren’t those
difficult to code, you ask? Not with CODE Designer.

Creating new screens

To create a new record screen on the Design page you need to create a group that
will create an empty page you can work with.

To create a new group:
1. Right-click the new EMPL_SELCT group in the DDS tree.
2. Click Insert group on the pop-up menu.

A Group Properties notebook appears and a blank Design page for the group
SCREENT1 also appears.

Details | MAIN_MENU | EHP_SELCTSource] Listing |
[ =l

[SCREENT
Avalable Selected

SELECT

EMPSEL

EMPMNT

PRJSEL 5 |

PRJMNT

RSNSEL

RSNMNT L’

= 9ReI0DS | web satirs | Cor
o =

A
A

3. Rename the group to EMPL_LIST and close the Group Properties notebook.
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4.

5.

You can create things on the Design page by selecting the appropriate tool from
the palette on the left-hand side and then click on the Design page where you
want it to be created. Right now, most things are disabled in the palette
because there is no record in which to create fields. The only two tools
available are Create standard record and Create subfile record. If you leave
the mouse over a button for a second or two, flyover help will appear
describing the indicated button.

Details | MAIN_MENU | EMP_SELCICEMPL LIST DS ource | Listing |

-

Create subfile record
H

Click the Create subfile record button and then click in the dark gray area.
A subfile and a subfile control record pair are created.

Details| MAIN_MENU | EMP_SELCT EMPL_UIST | Source | Listing |

(&) [EgJrecoro =[]z G ES I =HAk
Ignore all indcators m II_E

_________ d-

Adding fields to the subfile record

Now you add some columns to the subfile using the Design page. The subfile
should be positioned on row eight. You use the cursor to specify the location of the
part you want to put on the screen, in this case your subfile.

To add fields on the subfile:

1.
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Click Create named field button g and then click somewhere on row 8.

Six fields appear in a vertical column. This is because the subfile you created,
currently specified a SFLPAGE (visible list size) of six.

Click the top field and hold the mouse button down and move it to row 8§,
column 5.



Note the current row and column appear just above the field as you move it.

3. Move the cursor over to the right edge of the field. It turns into a
double-headed arrow. Hold down the mouse button and move it to the left.
The size of the field will be reduced. The current size will appear just above the
field. When the size is 3, let go of the mouse.

The toolbar at the top of the Design page is a very convenient place to monitor
and manipulate the currently selected parts.

4. Rename the record from RECORD1 to EMPLSTSFL and the field from FIELD1 to
OPCODE by typing over the text in each list.

- EMPLSTSFL ) v]

| %l lgnore all indicatars

5. Click the Color palette EHIY| button and select pink to change the color of the
field.

To create an additional column:

1. Click the || button to change the usage of the field to input.
Now you will create an additional column in the subfile.
2. Position the cursor at row 8, column 9.

Note: The bottom right of the CODE Designer window shows the current

8.3

cursor position 4

If you can’t see the field with the cursor position on your screen, click the
Maximize button in the top right corner of the screen. You can use the cursor
keys or the mouse to move the cursor.
3. If you are creating a long field with an exact length, the SDA syntax can be
easier. Type:
+0(30)

and then press the back arrow (not Backspace!) to select the text you created.
Notice from the Selected DDS page that you have created a text constant
containing +0(30).

4. Click Convert string to field # button on the toolbar or press F11 to convert
the SDA syntax into a character output field of length 30.

IEMF‘LSTSFL

llgnae all indicators
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10.

11.
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Rename the new field to ENAME using the toolbar. This will show the name of
the employee.

| Detais | MAIN_MENU | EMP_SELCT EMPL_UIST | Source | Listing |

@EMPLSTSFL j = . .

|%llgﬂare all indicators

Position the cursor to 8, 41.
Now you will add a field for the employee’s salary. Type
$666,666.66

and then press the back arrow.

Now wouldn’t it be better if we could just tell the Designer what we wanted
the number to look like and then have Designer generate all the cryptic
EDTCDESs to make it happen?

Press F11 to convert this field into an output numeric field with comma
delimiters, two decimal positions, a currency symbol and no sign. Look at the
Selected DDS page to see what was generated for you. Impressive!

Detais | MAIN_MENU | EMPL_SELCT EMP wice | Listing |

@@EMHSTSFL == «]k & | (zlelB] (=]
Ll larore allindicators ~||e alealy ~ I 2 E *}Ilhi“'r E!IM%”
L . 5 + b-

— _| WmseumSImmeﬂs ] . ||9[I

| EA SALARY 8Y 20 8 41EDTCDE(1 SE S

Rename the field to SALARY and change its color to yellow, using the toolbar.

The subfile seems compacted to the left. It would be better to space it out

evenly. Just select the field and click the space horizontally 4 button on the
far right side of the toolbar. The other alignment buttons will align fields, left,
right, center and top.

@EMPLSTQFL j|;;z':|4|,| i B EREE
Ellgmre allindicators ? g@g@ Yo ,TE

Just below the palette there are three spin buttons. The top one, Subfile size,
specifies the total number of entries in the list that will be filled in by the
application. The second one, Subfile page size, is how many entries appear
on the screen.

In the Subfile size field, type 300.




12. In the Subfile page size field, type 9.

Details | MAIN_MENU | EMPL_SELCT EMPL_LIST |‘3wrc‘e| Listing |

T[S EGS e = ]
@Igmle all indicatons ZI

The Design page is updated accordingly.

Switching between multiple records

Now let’s fix up the Subfile control record. The group you created contains 2
records. You can verify this by looking at the record list in the toolbar:

RECORDICTL

1. Change the current record by selecting RECORDICTL from the record list or
click next record ®| or press Alt+End.

The fields in the subfile still appear so that column heading can be lined up,
but they appear at half-intensity so that they can be distinguished from the
fields of the current record.

2. Rename the record to EMPLSTCTL using the toolbar. Let’s provide a “position to’
entry in the subfile control header.

3. Position the cursor at 4, 9 and type:
Position to:
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Detais WP SELCT EMPL_LIST | Surce | Lxshr-gl
(&) [FenrsTor J;—|¢]p||

hd

4. Now you need an employee name field.

You could create a named field with the right characteristics like you did in the
subfile, or you could create a source reference using the Create source reference

field 2| button in the palette or you could reference the original database field

using one of the Create database reference field B Create database reference

and paste!
5. In the DDS tree expand the EMPMNT record.
6. Click the ENAME field and press Ctrl+C.

(=) ﬂR‘1-5400Fl.)RSEL#EJ’QDDSSRC(MSTDSP):
+- 2= File Keywords
48 SELECT
+| - e
[+-jo= Record Keywords
- A 'PRE0O1
F-A 'Time R...System’
-0y *0aTE
B *TIME
#- A 'Employ...enance
[+ "Mumber'
E, EMPNO

=+ (L, Fia
A Caregory’

-8, Emcar

[+ A 'Department’

-G, EDEPT

[+ 'Location'

=0, ELocy

A 'UsRID'

[+ B EUSRI

#-A 'Mormal,.. hours' —

=B, ENHRS

(The pop-up menu or Edit menu shows the Copy menu item as well).
7. Position the cursor to 4, 23 and press Ctrl+V. Now that was easy!
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8. Rename the field to POS_TO.

Detais | MAIN_MENU | EMP_SELCT EMPWCE' Listing |

(&) [ZjemrsTor o [Pos_T0 J=][&] [0 H (I (=)
@Ignulz all indicators - Fet :

[T o e - E

Adding field error handling

Let’s put in some error handling for the "position to employee name’ field. If the
employee name is not found in the database, the program will turn on indicator
60. An indicator is a two digit variable (01, 02, 03, ... 98, 99) to signal whether or
not certain events have occurred during processing. Using indicators enables
program events to control screen displays. These indicators are set ‘on”” or ‘off” in
one part of the program while their status is referenced in another part of the
program. By setting the indicators ‘on” or “off’, you can associate fields with
indicators to control whether or not a field will appear on the screen.

The screen should turn the field red, reverse image and position the cursor to it.
Now wouldn't it be better if we could work something higher level and easier to
remember than some arbitrary number from 1 to 99.

To set indicators:

1. Click the Changed named indicator sets | button on the Design page toolbar
(or press F7).
The Named indicator sets window opens.

2. In the Settings name field, type: Not Found.

Chapter 9. Designing screens 103



3.

4.
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Click Create.

Named indicator sets x|
Indicators

T 10 20 30 40 50 60 70 80 a0
iR iR mica R iR iR iR mici R mial mie: iR il
o2 220 32 421 62 6210 72 82 92
ek mih =l il mibccl ik el mitcl micch mikcl mikc el ik
T T 14 24 4T 44 G4 G4 74 84 94
o5 250 35 458 55 6510 75 85T 95
o 16 261 36 46 G666 761 686 96
milird mih i mivA mikd pik e miA micrd miked mic A mir
[C o8 181 28T 38 481 B8 GBI 781 881 398
I 0g s 29 e 49T 5a T 63T 79T 83T 99

Checked indicators are: & [ & Off

Settings namé INotFauncI ) Create |

| indi Eename |
Delete
Apply I Camell Help |

Select the check box next to 60 and click OK.

The Not found indicator set is now in effect. The Design area is shown as if
indicator 60 was on and all other indicators were off. The Design page toolbar
shows the current indicator set in the Select named indicator set list on the
bottom left.

T S ﬂ|s§|q|p||ms_ﬂ3 ~[€]
Now select the POS_TO field.

On the toolbar, select the color red and the display attributes reverse image
and position cursor. (The set of toolbar buttons representing the current
display attributes is found just below the color button).

The toolbar should look as follows:

[#]lFosTo =l[&E] 2 H ]
= e [ E e TR

Examine the DDS generated in the Selected DDS page.

Selected DDS IW‘eb Settings | Comments | Errorlist |

& POS_TO R B 4 23
A 60 COLOR(RED)
& REFFLD ( RCEMP/ENAME *LIBL/El
A 90 DSPATR(FR)
& B0 DSPATR(RI)
A 60 DSPATR(PC)
K|

Notice that all the new keywords were created with a condition of 60. (The
DSPATR(PR) was pasted with the field originally).



8. Now let’s try it out! From the Select named indicator sets list, select All
indicators are off.

@@EMPLSTCTL ~E«]>] |PDS T0 JM [0 E - I

Wow! This really works!
9. From the Select named indicator sets list, select Not found.

The field appears red and reverse imaged.

Accessing field properties

Second to the direct manipulation and the toolbar on the Design page, the easiest
and quickest ways of getting access to the properties of a field, record, or entire file
is a Properties notebook.

The Properties notebook lets you view and update the properties of the currently
selected DDS object. You can open this notebook from any view, pop-up menu, or
menu of the CODE Designer.

The Properties notebook is modeless. When you change an object’s properties, the
selected object changes immediately.

You can get to a Properties notebook from the Selected menu, by pressing F4, or
double-click on anything in the DDS tree or the Details page or Design page.

To open the Properties notebook:

1. In the DDS tree, click the record SELECT and press F4 to see the Record
properties.

|*& Record propetties

21|

{ Basics || CA/CF | Styles |
Recaord ISELEET
Type |Standald

Madified IEBF291'92
Mumber of fields I‘H [ Ina window

Description |

As you select different items, the Properties notebook will continuously update
itself to show you the properties of the selected item.

2. Click the *DATE field in the SELECT record. (You may have to move the
Properties notebook out of the way.) This field has a different set of pages
describing its properties.

3. Change the year from 2 to 4 digits. Select the Length of year check box.
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4. Select 4 digits from the list.

Eii Field properties
Basics | Atiibutes | Color | Ediing | Indicators |

Sample I~ Source of date | = |

[MM/DD AR

Pasition
Size  Row  Calumn

24XBU| 2E| ?UE
2?'.><2132| _'EI EE

Description |

Notice how the sample is updated on the Properties notebook.

5. To test the Design page, click the MAIN_MENU tab in the workbook and look
at the upper right corner of the screen. The year now has 4 digits.

6. Click the EMPAPL field in the SELECT record. On the Field properties

notebook click the Basics tab.

On this page you can change the field’s name, usage, length, type, and screen
position. The other pages give you quick access to other properties for this

field.

ggi Field properties £ ﬂﬁl

" EI Altthutas] Color ] Indcalnrs] Stylas]

Field y

[EMPAPL ;| [

Lizage Shift

z]olBlH|rIM] [--sphanmeic =l
Lemgth———— - Posttion
Total Dec Size  Row  Column

! H 8 || 20 [ H[ 265
[~ Continued (CNTFLD) 71 E’EI_EE |_JE

Wwidth

Description |

Adding new keywords

CODE Designer helps you manage the visual aspects of your displays and reports.
But you also need to access the full power of DDS. You need to access keywords.

To add keywords:
1. Click EMPAPL field in the DDS tree.
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2. Press F5 or right-click and click Insert keywords on the pop-up menu.

EI @ ﬂR‘?S‘iDD#)RSELAB,I'QDDSSRl;
[ ertemaciyords

—
w-A PRGOI

5-A 'Time R...Systen’
=-[@4 *oate

1A Mainte, . ection’

() *TIME

Details  MAIN_MENU |

- lgrore all indice

+) - ZEntar  inkain

(o B

A Tey Insert field

. praapL Insert help specification  Alt+H

E ‘A 'Projec.

CIRSNARL ey

#- A 'Reasor

E 1 EMESS Copy Ctrl+C
- 5 A F3Ed  pelete Ctrk+Del
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14 EMPMNT
[ PRISEL Mowe up Ctr+Up
4% PRIMNT Mave down Ctrl+Down
R propenes F4

You see the Details page for the EMPAPL field and the Create keywords tab is
selected in the Ultilities notebook. This page shows you the subset of keywords
that are allowed for the selected file, record or field and it takes into account
the field’s type, usage, shift and what record it is in. It is very powerful to
know exactly what your options are. This information cannot be quickly
ascertained from the Reference manual.
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3.

With the EMPAPL Properties notebook at the Basics page, click the numeric
field [& button to change the field to numeric type.

ggi Field properties & ﬂﬁl
L EI Altthutas] Color ] Indcalnrs] Stylas]
Field y
|EMPAPL ) [ [ (1
Lizage Shift I,
Z]olslulelm] [a-sehanmeic 15 ~]
Al P2 i |
Total Dec Size  Row  Column

[ B H || 2axs0 [ 5[ 226
I~ Contirued ENTFLD) || anaize[ [
=

Wwidth

Description |

Notice that the list of keywords in the Create keywords page has changed.

Click the & button to change the field back to alphanumeric.

Notice that the list of keywords in the Create keywords page has changed.
Click the ALIAS keyword and press F1.

The DDS Reference help for the ALIAS keyword appears.

Tip: CODE Designer has lots of on-line help. Press F1 anywhere you want to
see help for an item, icon or notebook. You will get help relevant to what you
are currently trying to do. From the Help menu you can get quick access to the
DDS Language Reference as well as several other useful sources of information.

Minimize the Help window.

Double-click the INDTXT keyword. (You may have to scroll to the right to find
it).

The keyword is created with default values which can be changed when you
want.

Double-click the INDTXT keyword again.

The keyword is created with the same default values creating a conflict.

Close the Keyword Properties dialog.

Verifying the source changes

You have just added a new record and some new fields to our DDS source.
Everything that the CODE Designer adds to your DDS source is certain to have the
correct syntax. Now you need to make sure that there are no semantic errors. You
just introduced one in the last section by creating two INDTXT keywords
describing the same indicator.

To verify your source:

1.
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Click Tools > Verify file (or click the verify &/ button on the main toolbar) on
the CODE Designer menu.

The DDS source is checked using the same verifier that the CODE Editor or
LPEX Editor uses. A message appears on the status line at the bottom of the
Designer stating that the verify process completed with errors.



2.

In the DDS tree, there is a trail of red x’s leading to the problem.

B"@ <R15400A =RSELABXXQDDSSR
. [# o= File Keywords
| =4 SELECT
o Ea Record Keywords
H EA 'PREOL
. @A TimeR,..System'
- @-[@y *oate
- ®-A Mainte. . .ection’
LB rTIvE
#-Z 'Enter .. inkain’
=
e INDTET
| .Cyg INDTXT
. @A ‘Emplay...enance’
- PRIAFL
. #-A Projec...enance’
3 RSMAPRL
. [#-A 'Reason...enance’
| -3 EMESS

The file icon has a red x, as does the SELECT record, the EMPAPL field and
finally the second INDTXT keyword.

Click the MAIN_MENU tab in the workbook.

The EMPAPL field is highlighted in red.

Click the Listing tab in the workbook.

This page shows you the listing generated by the most recent program verify. A
warning message is buried somewhere in the listing but it’s not easy to find.

If there are problems, they will show up in the Error list page in the Utility
notebook. It behaves exactly like the Error list in the CODE Editor or LPEX
Editor. Click the Error list tab.

Double-click the warning DDS7861 in the Error list. (Press F1 to see detailed
help on the message).

The Source page appears and the cursor is placed exactly where the error is in
the source. The Source page is a tokenized read-only view of the current state
of the DDS source. Read-only? Wouldn't it be great if you could just clear the
error right here. There are some things that are just plain faster in the editor
and many others that are faster in the visual environment. It would be great to
switch between the two modes at the push of a button. Well, let’s just do that.

Switching between designing and editing the screen

To switch between the Design mode and the Edit mode:

1.

Click the Edit DDS source B button or select File > Edit DDS Source from
the Editor menu.

You now have access to the full power of the editor.
Explore the Edit and View menu items.
Press Ctrl-F to open the Find/Replace window.
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4. In the Find field, type INDTXT and click Find.

Editor - Find and Replace . x|

Find INDTXT ﬂ
Replace with |

& Replace this occurrence ¥ Case sensitive
" Replace, then find next [~ Pattern match
¢ Replace all occurrences ¢ Yrap

m Replace Qpiions...l Cancel I Help

5. Press Ctrl-N to find the next occurrence.
6. Delete the second INDTXT line.

File | Edit View Insert Selecred  Tools Help

Undo Chrl+Z e
] as)

Cut Ctrl+x

Copy CtrH+C

Paste Chrl+y

Delete Cirk+Del Eplace Emctiun5+++++++ﬂ
829 dele Sy 6 14'Enter an X beside
830  select 4l Chrl+a you want to maint:
831 Deselect all JPL 1 B 9 25IHDTET(O1 "7?°)
832
038  Find andreplace.., Ctr4F 9 28'Employee Master |
gg; Find next shift+F4  JPL 1h B :g gg.P ot Haster

Find u Cti+U roject Haster M:
a6 P ! PL 10 B 11 25
837 : “1 28'Reason Code HMaste
oy IECNY Ve A | o
= I Locate »  Markcharacter  Alt+B

Set quick mark. ChrHQ Mark rectangle  Al+R

k &

[ o F4 il
Eiro I'nsert prompt ChrH+F4 Move e

Delete Ale+D

Copy alt+C

Compiling your source changes and closing the Designer

Now you will compile the source on the iSeries just as you did in the Remote
Systems LPEX Editor and then close the designer.

To compile your source:

1. Click File > Save from the Designer menu to save your source to the iSeries.

2. Click Tools > Compile from the Designer menu and then click No prompt (or
click the compile #| button on the CODE Designer toolbar).

3. A message indicates when the compile is complete. Click OK in the Message
window. If you run the PAYROLL program, you will see the 4 digit year
change you made to the opening screen of the program.

To close the Designer:
1. Click File > Exit from the Designer menu.
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Checkpoint

Complete the checkpoint below to determine if you are ready to move on to the
next module.

1. There is a graphical design tool that let’s you design your screens and reports

visually and then generate the DDS source for you. This tool is named:
a. Page Designer

b. CODE Designer

C. Screen Design Aid

d. None of the above

2. Match the item with its correct description.

a. Workbook

b. Details page

c. Utility notebook

d. Design page

a. View specific elements of the DDS source such as errors and selected objects
b. Lists the contents of the currently selected item in the DDS tree

c. Contains several different tabbed pages

d. For visually designing screens and reports

. The Utility notebook contains:

Selected DDS page
Error List page

Create keywords page
Comments page

All of the above

® oo o

. On the Design page, you can easily:

a. Create DDS objects
b. Edit DDS objects
C. Resize DDS objects
d. Move DDS objects
e. Create records

f. Create fields

g. Create constants

h. All of the above

. Grouping records together allows you to work on one record while still seeing

the related records in the background. (T, F)

. The Properties notebook is modeless. When you change an object’s properties,

the selected object changes immediately. (T, F)

. The DDS source is checked using the same verifier that the LPEX Editor or

CODE Editor uses. (T, F)

. You can switch between design mode and edit mode in CODE Designer. (T, F)
. You can compile sources on the iSeries just as you can in the LPEX Editor. (T,

F)

More practice

Want more practice? Try this!
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Given your experience in this exercise using the CODE Designer, try creating a
printer report. You can use the physical file specification REFMST in member
QDDSSRC in library RSELABXX. Take time to explore the fields and information
for this physical file. You may want to refer back to this information as you create
your report. When you are familiar with the file REFMST, you can create your
printer file. Use the Development Studio Client for iSeries online help to assist you
in this task.

Recap

Congratulations! You have completed this module. You should now understand:

* The purpose of a workbook, details page, utility notebook, design page,
properties notebook, group and indicator

* How to modify a display file to add a screen
* How to add groups, records and fields

* How to save your DDS source

* How to verify your DDS source changes

* How to compile your DDS source changes

Now that you know how to design screens, you can learn how to debug and test
the payroll application on an iSeries system. Continue with the next module.
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Chapter 10. Debugging a program

In this module, you will review the Debugger features. You then learn how to start

the debugger, set breakpoints, monitor variables, run and step into a program,

view the call stack in the Debug view, remove a breakpoint, add a storage monitor,

and set watch breakpoints and all from the Debug perspective.

In order to debug a program, there are several steps you will need to learn about

and follow:

* Describe some of the features of the Debugger
 Start a Debug session

¢ Add and delete line breakpoints

* Display a variable

¢ Change a variable

* View the call stack

* Run, step and step into a program

* Switch between source and listing view
* Add a storage monitor

* Add a watch breakpoint

In order to accomplish these learning objectives, there are several steps that are

involved, including:

* Debugging iSeries programs from the Debug perspective

* Starting the Integrated Debugger

* Setting breakpoints

* Monitoring variables

* Stepping into a program

* Listing call stack entries

¢ Setting breakpoints in PAYROLLG or PAYROLLD

* Removing a breakpoint in PAYROLLG or PAYROLLD
* Monitoring variables in PAYROLLG or PAYROLLD
* Adding a storage monitor

* Setting watch breakpoints

* Closing the debug session

The exercises within this module must be completed in order. Start with the first

exercise when you are ready to begin.

Length of time:

This module will take approximately 20 minutes to complete.

Introducing the iSeries Integrated Debugger

The Integrated Debugger is a source-level debugger that enables you to debug and
test an application that is running on an iSeries system. It provides a functionally

rich interactive graphical interface that allows you to:

© Copyright IBM Corp. 2001, 2004
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View source code or compiler listings, while the program is running on the
iSeries system.

Set, change, delete, enable and disable line breakpoints in the application
program. You can easily manage all your breakpoints using the Breakpoints
view.

Set watch breakpoints to make the program stop whenever a specified variable
changes.

View the call stack of your program in the Debug view. As you debug, the call
stack gets updated dynamically. You can view the source of any debug program
by clicking on its call stack entry.

Step through your code one line at a time.
Step into or step over program calls and ILE procedure calls.

Display a variable and its value in the Monitors view. The value can easily be
changed to see the effect on the program’s execution.

Locate procedure calls in a large program quickly and easily using the
Modules/Programs view.

Debug multithreaded applications, maintaining separate stacks for each thread
with the ability to enable and disable any individual thread.

Load source from the workstation instead of the iSeries — useful if you don’t
want the source code on a production machine.

Debug client/server and distributed applications.

The Debugger supports RPG/ 400® and ILE RPG, COBOL and ILE COBOL, C, C++
and CL.

In the following exercise you will be given the opportunity to learn about some of
the basic features of the Debugger. For the purpose of this exercise you will debug
an ILE RPG/400 program. Don’t worry if you don’t know RPG.

Starting the integrated debugger
You will be working with the ILE RPG program PAYROLLG.

Note: For RPG programmers: PAYROLLG is the same RPG program as PAYROLL

but without compile errors. You are using it instead of PAYROLL in this
exercise, to accommodate anyone who decided to skip right to this exercise
without completing the editor exercise.

Note: For COBOL programmers: PAYROLLD is the same COBOL program as

PAYROLLC but without compile errors. You are using it instead of
PAYROLLC in this exercise, to accommodate anyone who decided to skip
right to this exercise without completing the editor exercise.

Note: Make sure that your user ID has been setup, so that your library has been

added to the library list automatically. You can use the properties for iSeries
Objects dialog to set connection information such as adding a library to a
library list and changing the current library. You can right-click on iSeries
Objects then click Properties to see this dialog. You will need this setup to
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run jobs interactively from your workstation.

4P Properties for iSeries Dbjects

Command Execution
Environment Yariables

Subsystem

Initial Library List

=0/

—Library list
Librar Library Position
RSELABX (CFIRST )

Move Lip

i

Move Diowrny

Current library: | "USRPRF |
Initial command:
c ICHGCURLIB RSELABRY )
Restore Defaults | Apply I

[ & |

Cancel I

You can start the Debugger in several ways: directly from the pop-up menu of a
program or service program in the Remote Systems view, or from the Launch
Configurations window. Starting directly from the Remote Systems view doesn’t
allow you to specify parameters to be passed to the program. The Launch
Configurations window allows you to modify how the program is invoked and to

specify parameters.

To make the exercise interesting you will use CL program CLR1 to call PAYROLLG
and you will pass one parameter to CLR1 or you will use CL program CLC1 to
call PAYROLLD and you will pass one parameter to CLC1. This means you will
use the Launch Configurations window.

To start the debugger:
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1. In the Remote Systems view expand the Library list filter, if it isn't expanded
already.

4#' Remote System Explorer - WebSphere Devel
Fil= Edit Mavigate Search Project Run window
I-BE & 8] % & - %-

- ughs b

ﬁ Debug...

:I @:, iSeries Objects
[#- _ﬁ) Work with libraties..
. Work with objects...
[ =€r Wark with members. ..
B ﬁ Library list
[+ ‘}'5 QSYS ¥lib.prod-sys
- il Q552 ¥ib.prod-sys
(-l QHLPSYS. *ib.prod-sys
(-l QUSRSYS, *iib.prod-sys
-t RSELABLO.¥lib.test-cur
=1l RSELABRX.Mlib.prod-usr
: El CLCL . *pgm.clle
MR CLR 1. pam.clle
- [£] MYCOMPILE. *pgm. clle

4P Remote System Enplorer - WebSphere Deve
File Edit Nawgate Search Project Run Window

Jl|19‘;§'r E Sl

Debug &s  »

FIEEEEE
[+ $ MNew Connection
E E Local
=48y s400a
=3 ﬁj iSeries Objects
= Waork with libraries...
:"f:'f? ‘Work with objects. ..
= work with members. ..
M Library list
: E.?\ QSYS. *ib.prod-sys
- [l Qsv52.#iib.prod-sys
-l QHLPSYS Mib.prod-sys
-l QUSRSYS. ¥iib.prod-sys
- W* RSELABL0.*ib test-cur
=-lffy RSELABX. *lib, prod-usr
D [=] {0 L_l.*|:||:|r|| [ IIH

G -]

Expand library RSELABXX, if it isn’t expanded already.
Select program CLR1 or CLC1.

Click the arrow beside the DEBUG icon *¥ * on the workbench toolbar.
Select Debug from the list.

The Debug Launch Configurations window opens.



6. Select iSeries: Debug Interactive Application under the Configurations list.

Create, manage, and run configurations

Configurations:

- &3 Attach to a Running Process -
By Debug a Compiled Application

- JKT HTML Seript Application

- E& iSeries; Debug Batch Application

! e Application

% iSeries: Debug Job
iSeries: Debug Mulki-Threaded Application
Java applet

- 3J Java Application

@ Java Application in iSeries Server

i 74 JavabBean

=
. S
| | v

| Debug I Close I

7. Click New.

The right pane of the Debug Launch Configurations window opens.
Nafg: | CLRL )
what To Debug ] Advanced | %5 (4| ¥

Connection: [s400a =] mew...|

—Program or Service Program
Library: | RSELAB

' Program:

fcLri

" Service Program:

V¥ Stepinto
[V Terminate debug session on program completion
@pdabe production files

Apply | Revert |

| Debug I Close I
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Name:QCLCI )

What To Debug I Advanced | 35 commen |

Connection: |5400a =] ew...|

Program or Service Program -

Library: |RSELABXX =] srowse... |

% Program:

[cuet ~]-| erowse...|

" Service Program:

I dJ Browse. .. |

v stepinto

Iv¥ Terminate debug session on program completion
Update production files

fpply I Revert I

In the Name field, type the program name CLR1 or CLC1.
Select the Update production files check box.
10. Click the How To Start tab.

The How To Start page opens.

Mame: | CLR1

What To Debug How To Start I Advanced | 3% Common |

Command to start apﬂica&ip:
CALL PGM{RSELABR®/CLRL) PARM{"HN")

Prompt. ..
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Narmne: |CLC1

what To Debug How To Start Advanced I %5 common I

Command to start application:
CALL PGM{RSELABXX/CLCL)

Prompt...

11. Click Prompt.
The Call Program (CALL) window opens.

P Call Program (CALL) 2 X
Program: CLR1 [ame
Library: RSELABXX j Mame
Parameters: "\;f() Zl
(T |
_I Remove I
Move up |
Mawve down I
I™ | advanced ™ all parameters ™ Keywords
CALL PGMIRSELABXKICLR1) PARM(%x") __:_l
@ I Restore defaults Cancel I
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12.

13.
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&b call Program (CALL) X
Program: CLC1 Mame
Library: RSELABIKX | Hame
Parameters: ;| fidd |
PARM]
e Remove I
Move up |
| Mave down I
[~ advanced I~ all Parameters I~ Keywords
CALL PGM{RSELABXX/CLCT) PARM('MX") LI
OK I Restore defaults Cancel I

In the Parameters field, type 'XX'. Click Add.
The parameter value will appear in the lower list.
Click OK.
The complete start command for the program appears:

Create, manage, and run configurations

Configurations:

Mame: | CLR1

By Debug a Compiled Applice
- JKT HTML Seript Application
i E& iSeries; Debug Batch App
= & iSeries: Debug Interactive
. & cLcl

LB am
8& iSeries: Debug Job
[ 3¢ iSeries: Debug Multi-Thre.
- 3R8 Java Applet
%) Java Application
- @ Java application in iSeries
- ?* Java Bean
o J Uni
7 Remote Java Application

iy
4@ Run-time Workbench

L

New |  Delete |

e E Attach ko a Running Proc & |

- Jl Script Host Application
L R Sowuar _F
»

what To Debug

Command ta start application:

How To Start

Advance_‘JL

~ALL PGM{RSELABKKCLR1) PARM('%2")

Prorank. ..

[~

=
I

Apply

I Rewvert |

l, Close |

—




Create, manage, and run configurations

Configurations: Mame: I CLCL

o E Attach ko a Running Proc & |
By Debug a Compiled Applice

{17 HTML Seript Application What ToDebug ~ HowTostart | Advance 4|+
{5 iSeries; Debug Batch App

=% %"Ehug Intesactive Command to start application:

Bl CALL PGM{RSELABX{CLCT) PARMX') =l

8& iSeries: Debug Job D&
i E;} iSeries; Debug Multi-Thre.
; Java Applet

-2 Java Application

- @ Java application in iSeries
- F JavaBean

b Jy U

- 'i-" Remote Java Application
@ Run-time Workbench ﬂ

- Jl Script Host Application
- - [
‘ " Cowirar LH Brormnk. ..

Mew | Delete |

Anply | Revert |

G|

14. Click Debug.
The Debug perspective opens.
If not, you may see this error message:

&b EVFC50011 x|

@ Mo interactive job associated with this connection. Associate an interactive

job with this connection ko continue,
1 Cancel I <« Details I

A request to run an interactive command or program was received for the RSE d
connection s400a, but no interactive job is currently associated with this
connection. To associake an interactive job with this connection:
1. Start the iSeries communications daemon if it is not already running.
Sehect the pull down menu fram the Remote Systems view and select iSeries -
Skart Daemon
2. Open a 5250 emulator,
3. Runthe CL command STRRSESYR MAME(s400a)
4. This will associate the interactive job with this connection, causing this

The Remote System Explorer communications server has been shut down in
the meantime. Go to your 5250 emulator and restart the Remote System
Explorer communications server following the instructions in the message.
You don’t have to cancel the message. It will be removed as soon as the
connection between the Remote System Explorer communications server and
the interactive session has been established. Now the Debug perspective is
loaded in the workbench.

Now that the program is active on the iSeries and stopped at the first
executable statement, the debugger displays the source.
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Setting breakpoints

You can only set breakpoints at executable lines. All executables lines are displayed

in blue. The easiest way to set a breakpoint is to right-click on the line in the
Source view.

To set a breakpoint:

&b Debug - CLR1.CLLE - WebSphere Development Studio Client Advanced Edition for - |I:I|5]
File Edit Mavigate Search Project Profile Run  Window Help
|-HR&||6|3- % -%- % -||® 9| e~ -
|6 | mm»|A
g #5: Debug ¥ X || 0= Variables ) | v X
RN BRI | @ %LOCALVARS = FOR RPG, COBOL OR CL USE THE "N
’E . =@y Thread:1 (stopped) -
=— CLR1 : CLRI : CLRY 1
_CL_PEP:CLR1:CLR1
QCMDERC ¢+ QUMDERC : QCMDEXC < | LI
pxeribeCommand | ORSFMATH : RSP
1 I rl » 4 i »
DebugJSefvers variableslsredq:u. l[ﬁxpres..' |Reqisters | Storage | 4 P

FECLRILCUE X I

3= Outline X
Row 1 Column 1 Replace Erows #noutling is not available,
H 3 1-———4 —2———— R . TR S TR
= 1 PGM  PARM{fnum) ﬂ
2 DCL VAR {&num] TYPE(*ch
3 dcl &name *char 10
4

del &likb *char 10 -
4| | 3

g v x

TI Pr oot I B |J
—

Console | Tasks |iSeries Commands Log
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-#’ Debug - WebSphere Development Studio Client Advanced Edition for iSeries
Fil= Edit Mavigate Search Project Profle Run  Window Help

| -H8 2 || 8] %% % -%-

% -||® 2]l e-9-

|a6 | mm»|A

_CL_PEP : CLC1:CLCL

q]E

g %5 Debug ¥ X || s Variables ) | X
Mo razie cllple |- & *%LOCALYARS = FOR RPG, COBOL OR CL LISE THE "N
’E =@y Thread:1 (stopped) -

== -2 CLCL: CLCL : CLCY |

QCMDERC : QUMDERC : QCMDEXC

exeribeCammand ORQF[VIATN : RQﬂ:I
>

4] |

4

o

o

Debug J Setvers

variable:slsredq:u. |Expres... |Registers Storage | 4 P

FECLCLLCUE X l

4= Outline b4

Row 1 Column 1

[

— ———

Replace

An outline is not available.

DCL
dcl
decl

4

PGH

e e ] Fmmm = G

VAR({&num] TYPE { *chi
&name *char 10
&likb *char 10

| o

Jow %
T‘ | Tl Drrﬁnr I B |J
Console | Tasks |iSeries Commands Log ‘
1. Scroll to line 11 then right-click anywhere on line 11.
UWelome | #/MSTDSP | ZPAYROLL X |
Row 11 Column 32 Replace Browse
- 1 - 2 3-g--+ 4 . 5 . & .
5 DCL VAR (| &count) TYPE(*LDEC) LENMN(S 0)
] CHGVAR VAR &MAME) VALUE('Claus Weiss')
7 LOOP: chowar var [ Ecount) walue (fcount+1)
8 if (&count *ltc 100) thenigoto loop)
9 CHGVAR VAR SMAME) WVALUE('Claus')
chovar wvar (&lib) walue |'RIELAB' *CAT &
CATT B rpawic1in/PI¥YROLLG)

1z

Add B ik
Add Watch Breakpoint. ..

& Console [Process: 148172/RICHIEYU)Q

Run To Location

Monitar Expression
Monitor Storage

4

Change Text File. ..
Switch Yiew

Console ] Tasks |iSeries Commands Log

2. Click Add breakpoint on the pop-up menu.

A dot with a checkmark in the prefix area indicates that a breakpoint has been
set for that line. The prefix area is the small grey margin to the left of the

source lines.
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Now you add a conditional breakpoint in the loop when it loops the 99th time.

Owekome | Zwsose [ Zpamon. [T x |
Fow & Column 31 Replace Erowse
' ' 2 ' -+ '] ' 5 ' 6—-
s LCL VAR (&count) TYFE(*DEC) LEN(E
5 CHGVAR VAR [ENANME) VALUE ('Claus Weis
7 LOOP : chorrar varlgoount) wvalue{&count+1)
- e it (ccoffint Tl 1:%[;:_"’_1@:1(:_:@
] THGWAH VER & ALUE ['Claus')
10 cherear var (&lik) walue ('RSELLE' *Ch
¥ ] 11 CALL PGM(&1ikb/FPAYROLLG)
12

To add a conditional breakpoint:

1. Scroll to line 8 then right-click on line 8.

2. Click Add breakpoint on the pop-up menu.
3. Click the Breakpoints tab.

The Breakpoints view opens:

Breakpoints :
A Line [CLR1.CLLE:11]
W B ine [CLR1.CLLE:S

= PN Y x

=%| Go to File

&dd Breakpoint  »

Select &ll
Il Ereble
[5 Disable

Yatiables _ =3 Remave

rage Storage M... |Manitars |Mnd|.les | Display

4. In the Breakpoints view right-click the breakpoint for line 8.
5. Click Edit Breakpoint on the pop-up menu.
The Edit a Line Breakpoint window opens.

124 Remote System Explorer



6. Under Views, click the *LISTING radio button.

&P Edit a Line Breakpoint

Required information

Sets a breakpoint to stop execution at a specific source line

Program

I *PGM RSELABXY/CLR1
Module

| CLRL

~Views

" *SOURCE
# * ISTING %
" *STATEMENT

Source{optional):

I CLRL.LISTING

Line:

—

= Back Mext >

&P Edit a Line Breakpoint

Required information

Sets a breakpoint to stop execution at a specific source line

Program

I *PGM RSELABXY/CLCL
Module

L

ICLC].
Yiews
T *SOURCE
# * ISTING
" *STATEMENT [%

Source{optional):

I CLCL.LISTING

« Back

Mext > || Finsh |

Cancel
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7. Click Next.

&P Edit a Line Breakpoint

Optional parameters

Make the breakpoint conditional upon the Following parameters

|Every S I

—Frequenc
To: IW
Every: Il—

Thread:

Expression: |

You only want to stop in the loop when it executes for the 99th time or more.
You can do that by setting the From field of the Frequency group to 99.

Under Frequency, in the From field, type 99.
Click Finish.

Monitoring variables

You can monitor variables in the Monitors view. Now you will monitor the
variable &count.

To monitor a variable:

1. In the Source view, double-click the variable &COUNT.
Dwekcome | Zmsose | Zpamon R X
Fow 8 Columrm 34 Replace Brouse
; 1 ; 2 ; 3-—+ 4 ; 5 ; &
4 del £lib *char 10
5 DCL VAR (&zount) TYPE (*DEC) LEN(S O
6 CHGVAR VAR (§NAME) WALUE ('Claus Ueiss'
7 LOOP: chovar var [ &count) wvalue( eécount+1)
3 5] if | ®ir 100 rhanicnts 1oop)
a CHGVLR EClE. "Claus')
10 cherrar Edit Braakpoint... RSELAE' #*CAT
= 11 CALL Remove Breakpoint )
Disable Breakpoint
Add Watch Breakpaint. .. pr——

B Console [Process: 148172{RICHIEYU/QPADEDL

4

Run To Location

Manitar E 0
Monitor Storage

Change Text File...
Switch View

Console |Tasks |ISeries Commands Log
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54002 |

Row & Column 34 Replace

; 1 ; — 3-—M 4 4 !

» 8 if | T+ 10N +han e
9 CHGVAR  Edb.
10 ChOVAr ey Breakpoint. ..
» 11 CALL . Braakpoint
| Disable Breakpoint
add Watch Breakpoint. ..

TR iseries Commands Log Run To Location

an-r-l | F— Ea il

Console | Tasks |iSeries Commands Log

2. Right-click &COUNT.

Change Text File...
Swikch YView »

3. Click Monitor Expression on the pop-up menu.
The Monitors view opens.

Debug w x || & Monitors o8| L BS x
0= [ @ o | 9 &COUNT = 00000,
= |

e s
2| %

Debug IServers

P .
Expres... |Registers |Storage lSturag..(IMcmkms‘Ddludules | Display L
—

Welcome | Zmsose | ZpavRolL W X | 0.8 X
Fow & Column 34 Feplace =) o
t L i —=3 ---I+---—q---—+—-——5——- A outline is
6 CHGVAR VAR EMAME) V&LUE;I riok
7 LOOP: chorar wvar [ &count) walue available.
» 5 if } *1t 100) then(got—J
=] CHGVAR VAR ( ENAME) WVALUE
10 chovar wvar (&£lib) wvalue('w
| | »
%Dsbug w X || B ponitors P
(T RN (e - o TS <@ BCOUNT = 00000,
; -

=1-@y; Thread:1 (stopped)

= CLC1:CLCL:ClCt

-

_CL_PEP: CLC1: CLCI
QCMDEXC : QCMDEXC : QCMDEXC

Rer tﬁrinman-l + ORSFMATH : R‘iF_l]ﬂ
»

e

Debuq]Servers Storage | Storag... |Monitor
BEE x|
Fow 8 Colurm 34 Replace Erow:

; 1 ; 2 ; 3---J+ 4 } 5

> 8 if (m *lt 100) then(goto |

9 CHGVAR VAR [ &NALME) WVALUE 't

10 chovar war {£lib) walue ('R

> 11 CALL

PGMi&lilh/PAYROLLD) w
| »

The variable appears in the Monitors view. Its current value is zero.
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Tip: If you quickly want to see the value of a variable without adding it to the
Monitor, leaving the mouse pointer on a variable for a second or so will
display its value in a pop-up window.

Now that some breakpoints are set, you can start to run the application.

%Debug v X
)0 WA= R A e L%

CLR1: CLR1 : CLRY =
_CL_PEP:CLR1 : CLR1
QUMDEXC : QCMDEXC : QCMDEXC J
executeCommand : QRSEMAIN : RSEMA
main : QRSEMAIN : RSEMAIN

C nen !IORQFMQTN + RSFMATM _Iﬂ
4

‘ﬁv Debug * x

J? DW= 23| %
% 1@ Thread: 1 (stopped) d
Resume| .= cicr ;e act =

_CL_PEP: CLCT ¢ CLCT
QCMDEXC : QCMDEXC : QCMDEXC

[ i = axen tﬁtinn‘rna‘rl : ORSFMATN : nqjﬂ
4 »

4. Click the Resume “* icon from the Debug toolbar.

<

Debug |Servers

The program starts running and stops at the breakpoint at line 8. (Be patient,
the Debugger has to stop 98 times but because of the condition continues to
run until the 99th time.) Notice in the Monitors view, that &count now has the
value 99.

5. Click the Resume icon again.

The program stops at the breakpoint at line 8 again and &count now has the
value 100.

6. Click the Resume icon once more so that the program runs to the breakpoint at
line 11.

Stepping into a program

The Debugger allows you to step over a program call or step into it. When you
step over a program call, the called program runs and the Debugger stops at the
next executable statement in the calling program. You are going to step into (Step
into) the Payroll program.

To step into a program:
1. Click the Step into icon on the Debug toolbar.

: v X

SEOEINER

o 00 W &
= % CLR1 [iSeries: Debug Interactive Application] =
E @ State: <stopped:> Connection: iSeries (RORASD
. @y Thread:1 (stopped)

=R ClR1:CLRI:CLRI

_CL_PEP:CLR1:CLRL

OCMDFXC : OCMOFXC ornémncr _Iﬂ
»

«

Debug |Servers
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- X

TR R EEINR
=-%§ CLC1 [iSeries: Debug Ippicati:ln] -
=& State: <stopped: . iSeries (ROS40(-——

=@y, Thread:1 {stopped)

H = 1 PFP:CIC1 : 010
| | M

The source of PAYROLLG is displayed if you stepped into RPG or PAYROLLD
if you stepped into COBOL. Depending on the option you used to compile the
program (*SRCDBG or *LSTDBG for RPG or COBOL, or *SOURCE, *LIST, or
*ALL for ILE RPG or ILE COBOL), this window displays either the Source or
Listing View.

Right-click anywhere in the Source view.

CiWelkome | #MSTDSP | ZPAYROLL x| |lo.e x
Fow 1 Column 1 REeplace Erg
I + 1 + 2 + 3 + 4 + 5-——1 B outing is |
»I Edit.. l*tt*i*tﬂwﬂ nat
available.

Add Breakpoint rting mas
Add Watch B“Bﬂ'ﬂﬂi‘t. " v descrik

Faares i AEETERN NI
{I Fun To Location 5

Monitor Expression
Manitor Storage

[, I S VR

Console [Process: 148172/RICHII

Change Text File. ..
ik, _h IIII' =

i >
P Show *STATEMENT IJ
Console |Tasks |1Series Commands Log

Row 150 Column 1 Eeplace Bro-
H + 1 pmmmml e ——— - —— 4 t S===
» 150 PROCEDURE DIVISICN. -
151 -

152 Edit...
153 &dd Breakpoink R
ll— Add Watch Breakpoint... LI—

Run To Location

E'g iSeries Commands Lo
Monitor Expression

s400a |
Monitor Storage

emmmand Tmmemat . Change Text File...

Console | Tasks | iSeries C

4 v show *SOURCE

Show E;ATEMENT
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3. Click Switch view > Show *LISTING on the pop-up menu.

Owekcone x| Zmsose | Zeavron [T x
Row 50 Column 19 Replace Browse
-——IZ————+————3————+————4————+————5————+————E————+————'?————+————B—-
489=1 i EMPAPL
sS0=I A 2 2 FRJAPL
51=1 A 3 3 ESMAFL
52=IEMPSEL
53=1 S 1 & OEMPNO
1 ]
Eow 320 Column 1 Eeplace Brows
B+ 1 ' 2 ' 3 ' 4 ' 5
» 380 z01 DoD1s0 PEOCEDURE DIVISION. ﬂ
391 000151 iy
392 000152 OO0O0-MAIN.
393 000153 -
| | »

Page down in the source and take a look at the expanded file descriptions.

You don’t have any /Copy member in your PAYROLL program but these
would also be shown in a Listing view. Switch back to the Source view.

Right-click anywhere in the Source view.
Click Switch view > Show *SOURCE on the pop-up menu.

Listing call stack

entries

The Debug view in the upper left pane, lists all call stack entries. It contains a tree
view for each thread. The thread can be expanded to show every program,
module, procedure and method that is on the stack at the current execution point.
If you double click on a stack entry you will display the corresponding source if it
is available. Otherwise the message No Debug data available appears in the Source
view.

In the Debug view, expand the stack entry of Thread1 if it is not expanded already.

B 2|23 gl % v x

FF CLRI [iSeries: Debug Interactive Application]
EI&' State: <stopped> Connection: iSeries (RORASO7M:5024)

@ > 0
E.

=@y Thread:1 (stopped)
o= PAYROLLG : PAYROLLG @ PAYROLLG

_QRMP_PEP_PAYROLLG : PAYROLLG : PAYROLLG
CLR1 : CLR1: CLR1
_CL_PEP: CLRL: CLRL
QCMDERC : QCMDERC : QCMDEXC
executeCommand ; QRSEMAIN : RSEMAIN
main : QRSEMAIN : RSEMAIN
_C_pep : QRSEMAIN : RSEMAIN
it UICHD : QUICMD
QUIMGFLW : QUIMGFLYWY @ QUIMGFLW
QUIMNDRY : QUIMNDRY @ QUIMMNDRY
i QUICMENU : QUICMENU @ QUICMENU

e QUMD QCMD @ QCMD
= Bk Process: 145172/RICHIEYIU/QPADEYODO? Program: CLR1

Debug ‘Servers
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: w0
= CLC1 [iSeries: Debug Interactive Application]

F dﬁ State: <stopped:> Connection: iSeries (ROS4004:5029)
LR % Thread 1 (stupped)

_Glin_pep : PAYROLLD : PAYROLLD
CLC1: CLCT : CLCL

_CL_PEP: CLCI:CLCH
QUMDEXC @ QIMDEXC | QCMDEXC
executeCommand : QR{{MAIN : RSEMAIN
main : QRSEMAIN : RSEMAIN

_C_pep : QRSEMAIN : RSEMAIN
QUOCMD : QUOCMD : QUIOCMD
QUOCPP : QUOCPP @ QUOCPP
QUICMD : QUICMD : QUICMD
QUIMGFLW : QUIMGFLW : QUIMGFLW
QUIMNDRY : QUIMNDRY : QUIMNDRY
QUICMENL : QUICMERU : QUICMENU
QCMD : QCMD : QCMD

The stack entry allows you to work with and switch between different programs
and/or ILE modules.

Setting breakpoints in PAYROLLG or PAYROLLD

Now you add some breakpoints in PAYROLLG or PAYROLLD.

To add breakpoints:

1.
2.
3.

Select PAYROLLG or PAYROLLD in Threadl.

Scroll to line 57 in PAYROLLG or 201 in PAYROLLD.
Double-click the prefix area of line 57 or double-click the prefix area of line 201.

A breakpoint icon is added to the prefix area of this line to indicate that a
breakpoint is set.

Repeat the above step for line 58 in PAYROLLG or 206 in PAYROLLD.

C\Welkome | ZMSTDSP | ZPAYROLL x|
Row 54 Column 1 Replace Erowse
- — 1 ' 2 ' 3 ' 4 ' 5 ' 6—-
54 C EVAL *INed = *OFF :l
55 C EVAL EMESS = *BLANK
/ 56 C EVAL EMPAPL = *BLANK—I
¥ ] 57 c EVAL PRJAPL = *BLANK
L@ a8 C EVAL RENAPL = *BLANK
59 c*
al C* Write the 3IELECT format to display. If &
61 cw
62 c*
63 C Dou not FIN6O
64 cC EXFMT SELECT
65 C TINKEC IFEQ '
v
«| » |

5. Repeat the above step for line 87 in PAYROLLG or 218 in PAYROLLD.
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To view all breakpoints, select the Breakpoints tab from the top left pane.

% Breakpoints = o 5P D | Ji iy - o x
A Line [CLR1,CLLE:11]

/@ Line [CLR1.CLLE:&]

A Line [PAYROLLG.RPGLE:S7]

A Line [PAYROLLG.RPGLE:SE]

/@ Line [PAYROLLG.RPGLE:57]

P ——
Varlable&_ﬁv_redq:. :‘&xpres... |Registers | Starage | Storag... |Monitc 4 P

= &

NI v x

A Line [CLC1,CLLE:&]

A Line [PAYROLLD, CELLE:201]
A Line [PAYROLLD, CELLE :206]
/A Line [PAYROLLD, CBLLE:218]

P cam—
Variahles(Bredq:.) |Expres‘.. |Registers |Storage | 4 b

This view shows all breakpoints currently set in your Debug session. This is a
convenient place to work with breakpoints. You can remove, disable/enable,
add, or edit a breakpoint. These tasks are available from the pop-up menu
when you right mouse click in the view area. Double-click any entry to show
the source where the breakpoint is set.

Removing a breakpoint in PAYROLLG or PAYROLLD

It is also easy to remove breakpoints from the Source view.

To remove a breakpoint:

1. Scroll to line 58 and then right-click line 58 in PAYROLLG or 206 in
PAYROLLD.

2. Click Remove Breakpoint on the pop-up menu.

welcome | Zmsose | Zpavrowl x
Row 58 Column 3 Replace Erowse
. 1 ' 2 ' 3 ' 4 ' 5 ' -
54 C EVAL TINED = *OFF  af
55 C EVAL EMESS = *BLANK
56 C EVAL ENMPAPL = *BLANK—
¥ ] 57 c EVAL PRJAPL = *BLANK
|» ca o EVAL RSNAPL = *BLANK
ECry
Edit Ereakpoirt. .. te the SELECT format to display. If &
R point l
ol :
E:;::fr:?c'"t " DOU not *IN6O
e E CE s e EXFHT SELECT
Run To Location TNKC IFEQ ' =
4 Monitor Expression | i
Monitor Storage
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Row 206 Column 1

| — 1 : )
205
2 2Nk
Edit...
Edit Breakpoint. ..

L1 WI
Disdege Breakpoint

0% iseric  Add Watch Breakpoint...

54002 | Run To Location

Monitor Expression
Monitor Storage:

Change Text File...
Switch Wiew »

The icon is removed from the prefix area indicating that no breakpoint is set on
that line.

Now you are ready to run the PAYROLLG program or PAYROLLD program.

. Click the Resume “® icon from the Debug toolbar.

. The RPG program PAYROLLG starts running and runs to the breakpoint at line
57. The COBOL program PAYROLLD waits for 5250 input.

. Click the Resume icon again for PAYROLLG.
The program waits for input from the 5250-emulation session.

e 1 Session A - [24 x 80] =10f x|

File Edit Wiew Communication Actions |nl:I.c_|.w Help
] 2 @[ | | & @] @2

RGO 1 1 S <
electi 15:

1a1

v | i menected to remote serverfhost toras pd101 on psprintl:pd101

. Type an X beside the Project Master Maintenance option.

. Press Enter in the emulation session.

The program runs to the breakpoint at line 87 for PAYROLLG or 201 for
PAYROLLD.

Monitoring variables in PAYROLLG or PAYROLLD
Now lets monitor variables and change them in PAYROLLG or PAYROLLD.

To monitor variables:
1. In the source view, double-click the variable EMPAPL on line 88 in PAYROLLG

or 201 in PAYROLLD.
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2.
3.

134 Remote System Explorer

Right-click the variable.
Click Monitor Expression on the pop-up menu.

x| || B2 outine

' Browse n outline is ©
.+....4....+....5....+.._.5__
SELECT -
when - @
EESR EMPTAG  Edit...
when pryapr  AddBreakpoint
EXSR PRITAC  AddWatch Breakpoint...
Run To Location
when RSNAPL
EXSR EIoMWRE  Monitor Expression
ENDSL Monitor Storage
arm
if ® TEC Change Text File...
. Swiitch View ’

Row Z01 Column 36 REeplace Bra
} 1 } ———2————+————3————+=———4————+————5——-
199
z0o IF IND-OFF ( IND-ERROR)
» 201 IF (EE g
z02 INI
4| Edit Breakpoirt...
Remave Breakpoint
= Disable Breakpoint
T iseries Commands Log Add Wakch Breakpairt...
s400a |

Run To Location

L’nﬂ\mnnd | PP vl |

Console | Tasks | iSeries Commands Log |

Change Text File. ..
Switch View »

Click the Monitors tab in the upper right pane.

The variable appears in the Monitors view. Its value is blank because you did
not select the Employee Master Maintenance option.

In the same way add the variables PRJAPL on line 91 and RSCDE on line 113
to the monitor for PAYROLLG or line 206 for variable PRJAPL and line 244 for
variable RSNAPL for PAYROLLD.

Variable PRJAPL equals X" because you did select the Project Master
Maintenance option.

In the Monitors view, double-click the variable RSCDE for RPG or RSNAPL for
COBOL.

The value changes into an entry field.



7. In the value field, type in the new value X for the variable.

B onikors
ol BaZOUNT = 00100,
-9 EMPAPL =
2 PRIAPL =%

=8 HBS x

Breakp... |Expres.. |Registers Storage |Storaqd... |Munitors]Mnd.|Ie4 »

B =8 5| Ba x
(3 BCOUNT = 00100,

(3 EMPAPL =

) PRIAPL=X

Expres... |Redisters |Storage |Storag.., IMonitors |I 4

8. Press Enter.
The variable is successfully changed.

Adding a storage monitor

Adding a storage monitor for a variable allows you to view the storage starting
with the address where the variable is located. The storage is displayed in
hexadecimal and text format.

To add a storage monitor:

1. In the Source view, double-click the variable ERR in line 33 for PAYROLLG or
IND-ERROR in line 219 for PAYROLLD.

2. Right-click and select Monitor Storage on the pop-up menu.

Owelcome | Zmstose | Zeavmow. RS X |
Row 33 Column 21 Replace Brouse
B T . P T T - T -
Z5 F* - RENMET - reason code mastcer f:l
26 F‘K‘XTtTK‘XT‘}:TKTTtT'XW‘.\"?:T'KT:I‘X'KT:I‘X'KT:Z‘Xﬁ“&'a".’.‘xﬁ“ra".’._l
27 FMSTDSP CF E WORKSTN
28 FEMPMET UF 4 E K DISK
29 FPRINST UF A E K DISK
30 FRENMST UF 4 E K DISK
31 D*
32 I* Compile time array containing error descr
33 ) ERCEE & 50 DIN{10)
34 p Er Edt. 50
35 Er Add Breskpoint
36 C‘R‘X: A e e e e e o e
Add Watch Breakpoint... =
‘I Bun To Location I—I d
Monitor Expression
Console [Process: 145172/R puwmsremrs LR1]
Ll Change Text File...
Switch Yiew »

Console lTasks |iSeries Commancseoe
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A new page is added to the Storage view. The tab shows the name of the
variable.

ERR : Thread 1 ]

Address

C540D5D6E

E77F4040

D6D5CS540
CFF2DF2 60500544 E2C5D3C5
CFF2DF260900B45 - - DSE3C5D5
CFF2DF260900B46 (& Copy Yiew to Clipboard C1D7D7D3
CFF2DF260900B47 o C3E3C5C4
CFF2DF2 60900848, S It View C1D5C3C5
CFF2DF260300B430 40404040 40404040 42040C1C3 E3CSD6DS
CFF2ZDF260900B4A0 40C3D6C4 C540D5D6  E340C5DE  E4C1D340

CFFZDF260900B4EB0 E3D6407F C1l7FebB40 7FC37F40 DeDS407F
CFFZDF260500B4C0 C47r4040 40404040 40C1C4C4 40DSCSDS
CFFZDF260900B4D0O E4CS5EZES CS5C440CZ E4E340D9 (CSC3D6DO
CFFZ2DF260900B4EQ C440C1D3 DSC5C1C4 EB40C5E7 C9EZE3E2

-
IND-ERROR : Thread 1 |

Address o - 3 4 - 7 8 - B

CEADOZFBzZDO0Z2ZCC 4B0000S0 Q0000000 00000000
CEADDZFB2D0O0Z2DC 00000000 00000001  FOOOOOOO

CEL00ZF82DO0Z2ZEC 00000000 OO07FFOFL  FOFLFOF1
CEADD2F82D0O022FC 00000000 4040FOF0 40204040
= D0z 4p Monitor Expression 1203040
CELONZFB2DO02E 404040
C64002F8zD0o0z: = Remove Storage Monitor 404040
CEADOD2F82D002: | o8 0 Iquququ

CoAOOZFBZDO0OZZ Content S 404040
CELO0D2F82D0023 000000
C64002F82D0027 [ Copy View to Clipboard 404040
CeA0OZFE82D0O0ZE apﬂnt iew 404040

CEADOZFBED0O0Z3TC  F0H090F0  sos03090 - 30404040

3. Use the scroll bar on the right of the Storage view to scroll down.
You can see the current content of the memory.
4. Right-click in the view area.

5. Click Reset Table to Monitored Address on the pop-up menu to return to the
starting address.

6. Right-click the view area.

7. Click Remove Storage Monitor on the pop-up menu to remove the storage
monitor.

Setting watch breakpoints

A watch breakpoint provides a notification to the user when a variable changes. It
will suspend the execution of the program until an action is taken.

To set a watch breakpoint:
1. Click somewhere in the Source view and press Ctrl+L.

A Line number field is added to the bottom of the source area. In this field
type 116 to go to that line in PAYROLLG or 118 to go to that line in

136 Remote System Explorer



PAYROLLD.

welcome | Zmsose | Zpavrowl x
Row 56 Column 1 Replace Erowse
. P D Y DI T T PO Y -
53 C dou * TNKC N
54 C EVAL #*INeD = *QFF
55 C EVAL EMESS = *BLANK—)
568 c EVAL EMPAPL = *BLANK
5 ] a7 C EVAL PRJALPL = FELANK
58 C EVAL RENAPL = *ELANK
58 cw
&0 C* TWrice the SELECT format to display. If &
61 c*
62 c*
63 cC DoU not *INGO =
«| | L|J
Line number: ftiel 2

O x |
Row 201 Colummn 18 Replace Erow:
" 1 g---2 ' 3 ' 4 ' 5
- 2%. IF (EMPAPL OF SELECT-I = 'X:l
202 INITIALIZE EMPSEL-OQ —

L d

«| | »

Line number: | 118]

Double-click variable *IN60 in PAYROLLG or IND-TABLE in PAYROLLD to
highlight it.

Right-click and click Add Watch Breakpoint on the pop-up menu.

The Add a Watch Breakpoint window opens. The Expression field is pre-filled
with the highlighted variable *IN60 or IND-TABLE. By default the Number of

bytes to watch field is set to zero, which means the variable will be watched in
its defined length.

&P Add a Watch Breakpoint x|

Required information
Sets a breakpoint to stop execution when data changes at a specific address ﬁ

Address or expression: | INE0
Mumber of bytes to watch: [0 =1

< Batk Mext » || Fish | Cancel
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4B Add a Watch Breakpoint EE X|

Required information
Sets a breakpaint to stop execution when data changes at a specific address ﬁ

Address or expression: | iNIZfTABLE

Mumber of bytes to watch: |U ﬂ

4. Click Finish.
The watch breakpoint is now set.
5. Click the Resume icon on the Debug toolbar.

The application waits for input from the 5250-emulation session.

e 1 Session A - [24 x 80] =10f x|

File Edit Wiew Communication Actions ‘Window Help

B B 2% BlE 8] (%) 2 3| @

i1 i=ten

v | i :Cc-nnected to remote server/host toras pd101 on psprintl:pd101

6. In the 5250 emulation session, type 123 for Project Code and D (for delete) in
the Action Code field.

7. Press Enter. A message is displayed indicating that the variable *IN60 or
IND-TABLE has changed.

#Dehugger [ T - x|

i VYariable *IN60 has changed in program PAYROLLG, module PAYROLLG, which
\\I) is running in job QPADEYODOT/RICHIEYL [148172,

&P Debugger Message x|

/"= Yariable IND-TABLE has changed in program PAYROLLD, module PAYROLLD,
\\I) which is running in job QPADEYODOF/STECKHAM (173708,

8. Click OK. The program stops at line 465 in PAYROLLG or 407 for PAYROLLD.
This line is located immediately after the statement which caused the variable
*IN60 or IND-TABLE to change.

138 Remote System Explorer



Closing the debug session

To close the debugger:
1. Click the Resume icon on the Debug toolbar.
The application waits for input from the 5250-emulation session.
2. Switch to the 5250 emulation session.
3. Press F3 to end the job.
A message Program terminated appears:

-ﬁa Debugger Message > ll

@ Pragram terminated.

4. Click OK.

File Edt Source

S - H

Debug |Server

5. Right-click the Debug icon on the left task bar of the workbench.
6. Click Close on the pop-up menu.

Checkpoint
Complete the checkpoint below to determine if you are ready to move on to the
next module.
1. You can start the debugger:
a. From the Remote Systems view
b. Launch Configurations window
c. Both
2. You can only set breakpoints at executable lines. (T, F)
3. The easiest way to set a breakpoint is to:
a. Right-click on the line
b. Right-click after the line.
c. Right-click before the line
d. All of the above
4. You can change variables and indicators in the:

a. Remote Systems view
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Debug view

Monitors view

Storage view

. All of the above

5. The debugger allows you to:

® a0 o

a. Step over a program call
b. Step into a program call C
c. Both

6. The Debug view lists all call stack entries. It contains a tree view for each
thread. (T, F)

7. You can perform which actions on breakpoints:

a. Delete
b. Add
c. Disable
d. Enable
e. Edit

f. All of the above

8. Adding a storage monitor for a variable allows you to view the storage starting
with the address where the variable is located. (T, F) 9.

9. The Storage monitor supports these display formats:
a. Hexadecimal and character

Character only

Decimal

All of the above

. Aand B

10. A breakpoint provides a notification to a user when a variable
changes. It will suspend the execution of the program until an action is taken.

a. Watch

® 20 o

b. Support
C. Java Exception
d. Type

More practice

Want more practice? Try this!

Given your experience in working with the debugger features, in your own source,
try setting, changing, deleting, enabling, disabling line breakpoints, setting watch
breakpoints, displaying and changing variables and viewing the call stack as you
debug your program. Use the Development Studio Client online help to assist you
in these tasks.

Recap

Congratulations! You have completed this module. You should now understand:

* The purpose of the Debug view, the Monitors view, the Storage Monitor, the Call
Stack and the roles of different types of breakpoints

e The actions you can perform on breakpoints
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How to start the debugger

How to set breakpoints

How to monitor variables

How to run and step into a program

How to view the call stack in the Debug view
How to remove a breakpoint

How to add a storage monitor

How to set watch breakpoints
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Chapter 11. Exploring Remote System Explorer

In this module, you will use the Remote System Explorer perspective to work with
the iSeries objects that you used in the previous module. You will learn how easy
it is to define filters, perform actions and define your own actions. In short, you'll
see how Remote System Explorer can organize and integrate your work and make
that work easier.

In order to explore the Remote System Explorer, there are several steps you will
need to learn about and follow:

Describe Remote System Explorer, filters, user actions and running commands
Open Remote System Explorer

Create filters (library, object)

Change the library filter

Create a user-defined action

View properties

No gk~ wdhPE

Run commands from iSeries Table view

In order to accomplish these learning objectives, there are several steps that are
involved, including:

* Introducing the Remote System Explorer
¢ Creating a library filter

* Creating an object filter

* Creating a user action

* Running commands from the Remote System Explorer
The exercise within this module must be completed in order. Start with the first
exercise when you ready to begin.

Length of time:
This module will take approximately 15 minutes to complete.

Introducing the Remote System Explorer

Most of the function of the CODE Project Organizer has been replaced by
WebSphere Studio function with the exception of accessing ADM parts. The
Remote System Explorer is replacing PDM (Program Development Manager) on
the workstation. It currently doesn’t have all the function of PDM but will be a full
replacement for PDM.

Remote System Explorer allows you to:

1. Simplify your work by giving you quick access to lists of iSeries libraries,
objects, members, IFS files, UNIX files, and local files.

2. Use the context-sensitive pop-up menus on these lists to perform actions such
as start the Remote Systems LPEX Editor, CODE Designer, or Integrated
Debugger or other common iSeries actions.

3. Use the Work with User Actions option to create and manage your own
user-defined actions and have them appear in the pop-up menus.
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4. Use the command support to increase your productivity by allowing you to
enter and repeat iSeries or local commands without switching to an emulator
session.

Creating a library filter

In the Remote System Explorer perspective, you now want to work with specific
iSeries objects.

In the previous modules you have worked with the Library list. Now you will
create your own library filter. Library filters list a set of libraries from your iSeries
system in the Remote Systems view. But first let’s understand what filters are all
about.

As a user, you want a flexible user interface that allows for integration between
systems. As a developer, you often need to create libraries, source files, and source
members. The Remote Systems view exposes subsystems, filters, and items
specified by each filter. This view lets you organize your filtered information in an
easy-to-understand tree view. You can create filters for collections of libraries,
objects, and source members.

The Remote System Explorer provides iSeries native file system (QSYS) support.
The iSeries native file system lets you query what objects are on your iSeries host
and perform actions against those objects. Filters allow you to easily organize
elements within your system. Use the filter function to list iSeries native file
system objects (such as libraries, objects, or members). An initial library list filter
also displays by default. It shows the initial libraries defined in your user profile
on the iSeries host. You can manipulate this list to add or move libraries within the
list.

@Remute System Explorer - PAYROLL - W

File Edit Sgurce Compile Mavigate Search

s g—
FIECEEEECIE T
[# =5\; Mew Connection -
#-B Local
= ﬂ 5400a
- iSeries Obie
f
[+ 5 Work with objects. ..
= :."=:$- ‘Warlk with members, ..
EI---'ﬁ'» Library list

To create a library filter:

1. In the Remote Systems view expand the connection that connects to your
iSeries system if its not already expanded.

2. Expand iSeries Objects if its not already expanded.

3. Expand Work with libraries. (You can also right-click iSeries Objects and click
New > Library Filter) on the pop-up menu.

Expanding Work with libraries corresponds to the WRKLIBPDM command,
plus creates and expands the filter in the Remote Systems view.
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The Create a new iSeries library filter page opens:

X
Library Filter p
o ' i
Create a new iSeries library filker
=i
Library: |RSE* =] J Browse. ..
< Back Next > Foeh | cancel |

You are going to create a filter to specify the libraries you want to work with,
so they will show in iSeries Objects. You want to create a filter that shows all
libraries on the iSeries with the name RSExxxxxx and VARxxxxxxx, xxx being
any character.

Note: You may need to select different libraries that appear on your system if
libraries with the above names do not exist.

You specify the first filter string that selects the libraries starting with Remote
System Explorer.

Type RSEx into the Library field, using the * wild card character.
Click Next.
The Name the new filter page opens:

x|

Library Filter

Mame the new filker %D
=

Filters are saved for easy re-use, Specify & unique name For this fileer, This name will
appeat in the Remote Systems view, and will be expandable.

Filter name: | all RSE and VAR libraries

I3

<Back | Next> [[ Finih | cancel |

In the Filter name field, type al1 RSE and VAR Tibraries.

You give your filters a name because the Remote System Explorer saves them
for future use, in opposition to PDM, which does not save filters.

Click Finish.

Chapter 11. Exploring Remote System Explorer 145



Back in the Remote Systems view under iSeries Objects you will see the new
filter expanded, listing all RSE* libraries.

Now you need to add the VAR libraries.

To change the library filter:
1. Right-click the filter all RSE and VAR libraries and click Change.

=5\;s§§ G @ |
! Work with members. . ﬁ
Library list
'}\ QSYS . ¥ib.prod-sys
-y Qsvs2.*lib.prod-sys
-l QHLPSYS. *¥lib.prod-s
-l QUSRSYS.Hib.prod-s
~if, RSELABY, *iib, prod-u
'}‘ QGPL.*ib.prod-usr —
-y WRLABX *lib.prod-u

H%i%lwmm'ﬂ'ﬂwnﬁiij}i '

E Liser libraries
(S8 2! RSE and VAR [T N
=i, RSELAB.*lb.
Go Into
-y RSELABMIS! & To N

=i, RSELABOLD.
-l RSELABORIC E38) Open in Mew Window
|— Wb RSELABTEST
71 Show in Table

41

Remote Systems | Team

@ Refresh
5] Propetties ’E }:'9 E Expand
Property |'¥'§ue | Collapse
Mame  alRSE and V... # Change...
Mumb... 27 £ o

The Change Library Filter window opens:

&P Cchange Library Filter x|
Filter name: all RSE and VAR libraries
Parent filter pool: Msteckh7tp Filter Pool
Filter strings:
New filter string Selected filker string:
RSE*
Library: IW\R"‘ vI J Browse.. ., |
s
Test Apply I Revert I

ok | cancel |

| 2|

2. Select New filter string from the Filter strings list.
In the Library field, type VARx.
4. Click Create.
The VAR* filter string is added to the list.
5. Click OK.

w
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You are now back in the Remote Systems view.

EL Remate S * X

P oo om | HF

-

-l RSELAB1L.*lb.prod |
&I, RSESERVER. *lib.proc

- Jff, RSETEST *Mib,prod
G-I, RSEWLLKAN. *iib. tes!
-, RSE100.*ib.prad

-, RSE1000,%ib,prod

& Jff, RSE10000,*lb,prod
i, RSES000,Mib,prod
-, YARLABK. *lib.prod

-, YARLABOZ. *lib,test
-, YARLABO3, *lib.test
@i, YARLABO4.*lib.test
-, YARLABOS. *lib.test
-l mRLﬂ-BﬂE-.’*ib.test’ A

-, YARLABOD, *ib.prod
=il ¥ARLABO1.*fib.test j

Remote Systems | Team

You will see the list expanded to include your filter. Now you can work with
the libraries directly and can drill down to the object you want to work with
directly.

Creating an object filter

Now create an object filter. Object filters list a set of objects from your iSeries host
in the Remote Systems view.

To create an object filter:

1. In the Remote Systems view, expand your connection and then expand iSeries

Objects if not already expanded.

= iSeries Objects

= M Library list
- m-ghp User libraries

Bi}:ii a

4|'

G 3% Work with libraries. .,
T 5 Work with objects

. [#-57 Work with members...

il RSE and VAR ibraries
=i, RSELAB.*ib.prod
-, RSELABMIST. *Mibpra
& Jffy RSELABOLD, *lb,proc
- Jff, RSELABORIG, *lb,prc
- Jff, RSELABTEST. *ib.pro
-l RSELHBK."‘Ib.nri\:db hd

= =
=& £§3 & or (£ | ){ .=r'¢'

- 2N New Connection -
B Local

=iy s400a

Expand Work with objects. You can also right-click iSeries Objects and click
New > Object filter on the pop-up menu.

Note: Expanding Work with objects corresponds to the WRKOBJPDM
command. This will show the New Object Filter window.

The Create a new iSeries object filter page opens:
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Now create a filter to show all your source files in your RSELABXX library.

Object Filter

Create a new iSeries object filker

HE

Library: (D) =~ Browse... |
Object: | * ;’ ;l Browse... |
bctipe: [ 2 _Coomed |

Object attribute: |"‘ L’ J Browse, ..
More Types>>
If wou want to subset by more
< Back Next > Foeh | cancel

3. In the Library field, type RSELABXX.
4. Click Browse beside the Object type field.
The Select Object Type window opens:

db Select Object Type

Select an object type:

*EDTD ]
*EXITRG
*ECT

*FLR
*ENTTBL
FENTSRC
*FORMDF
*ETR
*G55
HMGCLG
*IPXD
*JOBD
*JOBQ
*JOBSCD
*IRN
FIRNRCY
*LIB
*LIND
HLOCALE
*MEDDFN
FMEMU

*MODD

&l I F LI
[ o« | concel [

[ 2|

5. Select *File under the Select an object type list.
6. Click OK.
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The Create a new iSeries object filter page displays with the object type

updated.
Xl
Object Filter .
) N =i
Create a new iSeries object filker :D
=i

Library: [ReELABNX =~ Browse... |

Object: [* =1 Browse... |

Object type: | *FILE =~ Browse... |

Object attribute: | * Rl Browse... |
|

More Types==

3

« Back Mext > Firrish I Cancel I

7. Click Browse beside the Object Attribute field.
The Select Object Attribute window opens.

8. Select PF-SRC under the Select an object attribute list.
9. Click OK.

4P select Object Attribute 7 x|

Select an object attribute:

BSCF38
CMMF3E
DDMF
DFU
DFUEXC
DFUNOTERC
DKTF
DSPF
DSPF38
ICFF

LF

LF38
MXDF35
PF-DTA

PRTF
PRTF3S
SAVF
TAPF

l |
10. Click Next.
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The Name the new filter page opens:

Object Filter

Mame the new filker %D
=

Filters are saved for easy re-use, Specify a unique name For this filer, This name will
appeat in the Remote Systems view, and will be expandable,

Filter nam‘:- !My source files )

_l——
< Back I Mext = [] Cancel I

~——

11. In the Filter name field, type My source files.
12. Click Finish.

Note: You give your filters a name because the Remote System Explorer saves
them for future use, in opposition to PDM, which does not save filters.

The new object filter displays in the Remote Systems view under iSeries
Objects:

, v x
=& Sé"? b & | b} ,::;?
| B 5P Workwith objects... |
v Filter created succes:
-3 Work with members. ..
- Library list [\'ﬁ\
] iﬁp User libraries
G @ all RSE and VAR libraries

; COMPARE *file, pf-sn
& [Ely QCBLLESRC, *file. pf -
- [Ey QCLSRC. *file.pf-src
- [Ey QCMDSRC.*file, pf-sr
E @] QDODSSRC, *file.pf-sr¢
#-Eh QRPGLESRC *file pf-
s - E) QRPGLESRCP. *file, pi—
-k iseries Commands

- BB iSeries johs Jﬂ
4 »

Remote Systems | Team

Now you know how to create filters and tailor your development
environment. Filters can also be specified for non iSeries servers and your
local system.

Now you can work with the objects you have in your Remote Systems view
like you worked in PDM with libraries, objects, or members.

Let’s assume you want to edit the member PAYROLL in the source file
QRPGLESRC or PAYROLLC in QCBLLESRC using this object filter.

To edit a member:
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1. Expand QRPGLESRC or QCBLLESRC.
2. Right-click member PAYROLL or PAYROLLC.

3. Click Open With > Remote Systems LPEX Editor on the pop-up menu.

This will download the source member and open the editor with this member.
After you have edited the member you could save it and then compile it from
the Remote Systems view by using the pop-up menu options on this member.

You can also create your own actions in addition to the default actions.

4. Close PAYROLL or PAYROLLC.

Creating a user action

In PDM you can create user actions in addition to the pre-supplied system actions.
In Remote System Explorer you can do the same. So what are actions? Actions are
host commands that you define on the Work With User Actions window, and will
run against iSeries libraries, objects, jobs, and members. They can also be defined
for folders and files in any remote UNIX, Windows, Linux, Local, or IFS system.

To open the Work with User Actions wizard:

1. Expand your iSeries connection and expand iSeries Objects if not already

expanded.

:H&@

| ® &

o

_mmmpmgﬁwﬁ

‘Work, wi
Wark wi
v Work wi
Library |

[0 -

-l
-y, Qsv
-l QHL

-l

QS¥S.Mib.prod-sys
52 ¥ib.prad-sys
PSYS, *Ilb prod-s+

D i User libraries
- @i &l RSE and VAR
F My source files (§3 Refresh

th libraries. .. ;l
th objects...
th members...
isk

e New
E-i}.\u QEPLAMER  gaTe

Expand To

EIEE

I Parent profile I Remate sys..

Mame  RSELABXX

(- ik iSeries Commands Expand
(-8 iSeries Jobs Collapse
% IFS Files
1| i Rename
Rermate Systems ]Team % Copy
™ Paste
[=] Properties | 53
Delete
Property | Value | b
Aktrib... PROD-USR Add Library List Entry...

FP Remove From Library List

Jser defined actions For the seler 1 10vE Lip It Library List

MSTECKHZTP  Lacal
MSTECKHZTP  iSeries

Tasks |iSeries Table View |iSeties Cor

JL Move Down In Library Lisk
& Move Wikhin Library List...

Show in Table
Change...

Save(B)...

2. Expand the Library list filter if not already expanded.
3. Right-click RSELABXX.

4. Click User Actions > Work with User Actions on the pop-up menu.
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5.

6.

7.
8.
9.

152 Remote System Explorer

The Work with User Actions window opens:

&b work Jith User Actions
\

Parent profile: ||

B New
ﬁ Object action
L {5\ Member action

In the right pane of the Work with User Actions window, expand New in the
list, if it is not expanded already,
Click Object action.

You want to create a user action that copies a source file with data to a new
source file called QJUNKSRC in the same library.

& work with User Actions

Parent profile: |MSTECKH7TP

=] l;_& Mew

A Action name:
E Object action

Copy source file ——‘\
opy source file with d

. [5* Member action Cormment:
Cormand: |Norrna| cornmand j
| ——
RTDUPOE] af
Insert variable... I Edit... Browse. ., I

C_prompt...) |

[ Prompt first [:i“\, [ Refresh after ¥ Show action
[ Single selection only [ Irwvoke once

Resource types For which this action will appear

Defined Types Selected Types
Add==
MD
FILE ==Hemove
FILE_DATA :
FILE_DSPF Ed...

FILE_MERS
FILE_PRTF

[

ALL: *

Create I

Rewvert I

Close: |

In the Action field, type Copy source file for the user action name.
In the Comment field, type Copy source files with data.
In the Command field, type CRTDUPOBJ for the command to execute.



10. Click Prompt to open the command prompter for this command.

cﬁ: Create Duplicate Object (CRTDUPOED) K _)_(_j
e
From object: BN \ j Mame, generic*
From library: Bl } j Tame

Object type: aT Iy :j [ add I
Remove |
Move up |

Maove dawn |
To library: M ;i Mame
New object: QINKSRC Y =] Name
Duplicate data: *ES Li
I | advanced ¥ Al Parameters ™ Keywords
CRTDUPOE] OBJ{&N) FROMLIB(AL) OBITYPE(RT) NEWOBI(QIUNKSRC) ;I
DATA{*YES)

oK I Restore defaults | Cancel I

This is the command you will be running:
CRTDUPOBJ OBJ(&N) FROMLIB(&L) OBJTYPE(&T) NEWOBJ(QJUNKSRC) DATA(*YES)

To specify user action parameters:

1.

In the From Object field, type &N to indicate to use the name of the selected
object in the Remote Systems view.

In the From Library field, type &L to pick up the library name form the selected
object.

In the Object Type field, type &T to pick up the object type from the selected
object.

In the New Object field, type QJUNKSRC.

Select All parameters check box to see the additional Duplicate data parameter.
Now the Duplicate data parameter is also shown on the prompt window.
Select *YES from the Duplicate data list.

Click OK.

You return to the Work with User Actions window.

Now you want to refresh the Remote Systems view after the action has been
run.
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8. Select the Refresh after check box.

&b work with User Actions x|
Parent profile: |MSTECKH7TP =]
-G

= E'} NF‘_'-W Ackion name: I Copy source file
E Object action
i, [& Member action Comment: I Copy source file with data
Cormand: |Norrna| cornmand j

CRTDUPOBI OBI(&M) FROMLIE(&L) OBITVPE(ET) HEV « |

. _—

Insert variable... I Edit... I Browse. .. I
Prompt... |

I™" Prompt First d ¥ Show action
[ single selection onl R Invoke once

_|Show action only if a single object is s
Resource types For whi

Defined Types Selected Types
[FILE PRIF | FILE_SRC
= = <HRemove
Edit...

FILE_SRC: *FILE:PF*-SRC

Create I Rewerkt I

Close: |

Click Insert variable to see a list of valid replacement variables with the
explanation of what they do.

This user action is only valid for Source physical files. You need to specify this
restriction so this user action will only show in pop-up menus when you
right-click on a source physical file.

To specify this restriction:
1. Under the Defined Types list, select FILE_SRC.
2. Click Add beside the Defined Types list.

FILE_SRC is now one of the selected types. Actually since you only selected
this one it is the only one.

3. Click Create then Close.

Now, only when you right-click on a source file, will this user action appear on
the pop-up menu selected. For any other object type it will not appear. Back in
the workbench and the Remote System Explorer perspective, give it a try.

Note: Remember to close the PAYROLL or PAYROLLC member if you opened
it earlier.

To try your filter:
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1. Locate your filter My Source files.

\emote Systems et
B Local E&? Refresh
= & s400a Expand
:I ﬁf:, iSeries Objects Callapse

B~ _ﬁD “Work with librarie:
D Work with objects Eiﬂ Rename
[E28 ;? Work with membe &

EI i Library st . Copy
M- il Qsvs.Hib.pro (3 Paste
=l QSYSZHbpr e Move
(-l QHLPSYS. *ib,

@ il QUsrsYs »ip % Delete

Ml RSELABEXMIE  ohow in Table
# il QGPL.*ib.pro

-, WFLABRR b
D B User libraries ;:::(g;)(a)m
all RSE and YAR It
iy iP‘) an I Restore...

=] % My source files
(Ely compare.*fi

Cache File Descriptions

- [Ey QCMDSRC.#Fi

=Eh QCBLLESRC.®  add To iSeries Project...
@ B QasRCHfle. oo available Offine

= Eh QDDSSRC il Properties(F)

M remate Sys . Coflapse
-8 Local o Rename
El- s400a

Y o

i;b ieries Objects
Lome =€» wiork with librarie: [ Paste

i, QUSRSYS.*ib
w i, RELABRx At 22veBhe
& W, QGPL.#ib.pro  REStOre..
-, WFLABX. *iib

- _'ﬁ{» Work with objects & Move
-5 Work with membe
=i Library list 8 Delete
. B ﬂ QSYS.7ID.pra  opoy in Table
[+, Qs¥s2.%ib.pr .
Bl QHLPSYS."ib Cache File Descriptions
Change(E)...

L ﬁ—‘v User libraries
®- i?=v all RSE and VAR Il

#dd To iSeries Project. ..
Make Available Offline

5% Wark with User Actions...

=g My source files

8 E[j COMPARE *fi Propertm(F)

Expand the filter, if it is not already expanded.
Right-click the QRPGLESRC or QCBLLESRC file.
Click User Actions > Copy source file on the pop-up menu.

The file gets duplicated and the list gets refreshed. Your new source file will
show in the list. You can check the messages of the CL commands you are
running in the Remote System Explorer job by looking at the Commands log in
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the right hand side bottom pane of the workbench.

1 objects duplicated. :I |
Cause . . ... &llthe objects with supported object types

specified on the Create Duplicate Object (CRTDUPCE) command

were duplicated. See low level messages to determine if any

objects were not duplicated. =1l

Command |Nc|rrna| j |

Remoke System Details | Tasks |iSeries Table Yiew |iSeries Commands Log |

Now you want to delete the source file QJUNKSRC that you just created.
Right-click QJUNKSRC.

Click Delete on the pop-up menu.

The Delete Confirmation dialog opens.

Click Delete.

Running commands from the Remote System Explorer

The Command entry is part of the Remote Systems view.

To run a command:

1.

2.
3.

Check if you have an iSeries Table View tab in the bottom right pane where
your command log appeared in the previous exercise.

If you have it click on it.

If you don’t have it:

a. In the Remote Systems view, right-click My source files filter
b. Click Show in table on the pop-up menu.

Now in the iSeries Table view you can run commands on the iSeries server that
the table is connected to. You can run commands in the Commands field
beneath the iSeries Table view, and view messages in the Messages field. After
you populate the table, you can enter a command and select either Prompt to
specify parameters and then Run, or just select Run (which prompts and runs
the command as normal). When you run a command, the Messages drop-down
field is populated with the messages from the command. When you select a
message, the Details button is enabled. When you press this button, the
message and its help is displayed.

Type an iSeries command, for example ?ADDLIBLE.

I Filker ™My source files' '_ C ’-1%_?; {L,‘h oo m o X
| Name Type | Attribute [ Text -
Ej QDDS5RC *FILE PF-SRC

% QRPGLESRC *FILE PF-5RC

E)QrPGLESRCP *FILE PF-SRC

|

Command |Mormal

|—I:I<I

j Brompt... | Run
Messages [ j Details, . | Show Log... |
Remiote System Details |Tasks liSeries Table View |iSeries Commands Log |iSeries Error List

The question mark is there to display a prompt screen.
Instead of specifying a question mark you could use the Prompt push button.

5. Click Run.

156 Remote System Explorer



The Command Prompt window for the ADDLIBLE command opens.

If you receive a connection message instead then you need to populate the
table view with source members. In the Remote Systems view, right-click
QRPGLESRC or QCBLLESRC and click Show in Table from the pop-up menu.
Click Run again.

6. In the Library field, type RSELABOO and click OK.

&b Add Library List Entry (ADDLIBLE) - x|

- Name
Library list position:
List position: *FIRST |
Reference library: Marme
T advanced I~ Al Parameters I~ Keywords
ADDLIBLE LIB(RSELABOO) Al
| oK I Restore defaults | Cancel I

That will add this library to the library list of your Remote System Explorer job
on the iSeries server.

Note: You may need to add a different library if the library RSELABOO does
not exist on your iSeries system.

The messages field will confirm the successful completion of this command. To

get to the command history, similar to F9 on the 5250 screen, select the

appropriate value from the Command list.

F‘g\ Filker My source Files® C ’-1%_?; {L,‘h oo BT X
| Name Type | Attribute [ Text -
Ej QDOSSRC *FILE PF-SRC
% QRPGLESRC *FILE PF-5RC
Eh QreéLESRCP *FILE PF-SRC

I:I<I

| |

Command Ir\lormal

o

ﬂ 2r3n'||:|:..| LI

j Details... | Show Log... |
TSeries Table View | iSeries Commands Log |iSeries Error List

Remate System Details | Tas]

You could also use the iSeries Commands subsystem in the Remote Systems
view underneath the iSeries Objects subsystem and run predefined commands
or define your own commands.

More practice

Given your own libraries on your iSeries system, create a member filter and a job
filter. Then move libraries up, down and within your library list. Finally create a
filter pool. Use the Development Studio Client for iSeries online help to assist you
in these tasks.
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Recap

Congratulations! You have completed this module. You should now understand:
* The concepts of

* How to use the Remote System Explorer perspective to work with the iSeries
objects that you used in the previous modules.

* How easy it is to perform actions and define your own actions

* How Remote System Explorer can organize and integrate your work and make
that work easier

See how easy it is to be more productive building new or traditional iSeries
applications. The Remote System Explorer gives you PDM-like access to OS/400%
resources. The PDM like table view meant you could right-click on objects to
perform actions that are the same as PDM’s and use a command line at the bottom
of the table just like PDM. There were also user-defined actions that supported all
PDM substitution variables and of course the editing, verifying, compiling, running
and debugging tasks which were tightly integrated with the Remote System
Explorer.

You have been introduced to a highly integrated and productive environment,
offering a consistent experience for all development work from RPG to Java. This
new generation of tools offered rich support for exploring the file system,
compiling, building, editing, running and debugging. The new tools allowed you
to leverage the classic tools for extremely rich editing and DDS design support.
The Remote System Explorer tools offered a superset of functions over the classic,
and feature frozen ADTS tools. It offered significant productivity and usability
gains, support for disconnected and team development and a common harness for
the tight integration of IBM and partner-supplied tools for server application
development. Using these new generation tools also implicitly increases your skills
and will make the transition into new programming models easier, such as the
IBM WebFacing Tool, Web, Web Services, Java and XML.

Step aside ADTS the traditional method for developing and maintaining
server-side iSeries applications. Here comes Development Studio Client which
includes new highly integrated and highly extendible tools for iSeries RPG,
COBOL, C, C++, CL and DDS development. These new tools offered you a
development experience that is consistent with the experience for developing Java,
Web, Web Services, and XML applications, lowering the learning curve for all and
making your transition to these e-business application programming models that
much easier.
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Chapter 12. Module checkpoint answers

1 2 3 4 5 6 7 8
1b 1d 1c 1d 1d 1b 1c la
2¢g 2e 2a 2T 2d 2d 2T 2e
3g 3b 3f 3a 3g 3ac, bb, [3a 3a
ca, dd,
ef, fe, gg
4e 4aa, bd, |4c 4T 4T 4e 4c 4T
cb, dc

5e 5e 5T 5d 5T 5T 5¢ 5f
6a 6e 6¢ 6T 6h 6T 6T
7T 7e 7b 7f 7T 7f 7T
8a 8c 8c 8a 8T 8T
9T 9T 9c 9d 9T 9e
10e 10c 10a 10d 10T 10a
11b 11b 11d 11d 11T
12f 12T 12c 12T
13e 13d 13T
14T 14d
15T 15e
16T 16d

17d

18b

19c¢

20T

21T

© Copyright IBM Corp. 2001, 2004

159



160 Remote System Explorer



Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2004. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

IBM

iSeries
0S/400
RPG/400
VisualAge
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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